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● Safety Precautions ● 
(Please read the precautions carefully before carrying out practical training.) 

 
Read the relevant manuals and pay careful attention to safety when designing the system. 
When carrying out practical work, pay sufficient attention to the following points and handle the device 
properly. 

 
 

[Practical training precautions] 

WARNING 

● To avoid electric shock, do not touch the terminal while the power is on. 
 

● When opening a safety cover, make sure that the power supply is disconnected or ensure 
sufficient safety before carrying out the work. 

 

CAUTION 

● Follow the instructor's instructions to carry out practical training. 
 

● Do not remove the training machine module or change the wiring without prior consent.  
Doing so may cause failure, malfunction, injury, or fire. 
 

● Turn the power supply OFF before removing or installing a module.  
Removing or installing while the power is ON may cause module failure or electric shock. 
 

● If the training machine emits an abnormal odor or an abnormal sound, press the "Power switch" or 
"Emergency switch" to stop the device. 
 

● When an error occurs, contact the instructor immediately. 
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● Safety Precautions  

(Q Series Programmable Controllers) ● 
(Please read the precautions carefully before use.) 

 
When using a Q series programmable controller, please read the Q Series Programmable Controller 
Manual carefully and pay sufficient attention to safety and handle the device properly. 
In this manual, the safety precaution levels are classified under "WARNING" and "CAUTION". 
 
 

Incorrect handling may cause hazardous conditions, resulting in death or 
severe injury. 
 
Incorrect handling may cause hazardous conditions, resulting in medium 
or slight injury, or may cause only material damage. 

 
 
Note that the  CAUTION level may lead to a serious consequence according to conditions. 

Please follow the instructions of both levels because they are important to personnel safety. 
 

[Design precautions] 

WARNING 

● Configure a safety circuit outside the programmable controller so that the entire system can 
operate safely even when an external power supply error or a programmable controller failure 
occurs. Failure to do so may cause an incorrect output or malfunction, resulting in accidents. 
(1)  Configure safety circuits such as an emergency stop circuit, protection circuit, interlock circuit for 

opposite operations such as forward/reverse rotations or interlock circuit for machine damage 
protection such as upper/lower limits for positioning outside the programmable controller. 

(2)  When the programmable controller detects the following error status, it will stop operations and 
turn OFF all outputs in the case of (a).  
In the case of (b), it will hold or turn OFF all outputs according to the parameter setting.  
Note that the AnS series module will turn off the output in either case (a) or (b). 

 

  Q series modules AnS series modules 

 (a)  When overcurrent protection or 
overvoltage protection of the power 
supply module works 

Output OFF Output OFF 

 (b)  When the programmable controller 
CPU detects a watchdog timer error 
and the like in the self-diagnostics 
function 

All outputs will be 
retained or OFF, 

depending on parameter 
setting 

Output OFF 

 
When an error occurs at the I/O control part where the programmable controller CPU cannot 
detect, all outputs can be turned ON. Configure a fail-safe circuit or some mechanism outside the 
programmable controller so that the machine operates safely in such a case. For a fail-safe circuit 
example, refer to "Safety Design Using a Fail-safe Circuit" on this manual. 

(3)  Outputs may remain ON or OFF due to a failure of an output module relay or transistor. Configure 
an external circuit for monitoring output signals that may lead to a serious accident. 

 

CAUTION

WARNING
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[Design precautions] 

WARNING 

● Configure a safety circuit such as a fuse outside the output module because smoke or fire may 
result if a load current exceeding the rated current or an overcurrent caused by load short flows 
continuously for a long time. 

 
● Configure a circuit so that an external power supply will be turned on after the start-up of the 

programmable controller. 
If the external power supply is turned on first, an incorrect output or malfunction may occur, 
resulting in accidents. 

 
● For the operating status of each station during data link communication error, refer to each data 

link manual.  
Failure to do so may cause an incorrect output or malfunction, resulting in accidents. 

 
● When controlling (changing data) the running programmable controller from a peripheral 

connected to the CPU module or from a personal computer connected to an intelligent function 
module or special function module, configure an interlock circuit in the sequence program to 
ensure that the entire system will always operate safely. 
For other operations (program modification, operating status change (status control)) to the 
running programmable controller, read relevant manuals carefully and ensure the safety before 
operation. 
Ensure the safety especially when controlling the remote programmable controller from eternal 
devices because trouble occurred on the programmable controller side may not be responded 
immediately due to data communication error. 
Along with configuring an interlock circuit in a sequence program, determine the system’s 
corrective actions to be taken between external devices and the programmable controller CPU in 
case of a data communication error. 

 

CAUTION 

● Do not bundle or adjacently place the control line or a communication cable with the main circuit 
or a power cable.  
Keep a distance of approximately 100 mm or more between them. 
Failure to do so may cause malfunction due to noise. 

 
● When a device such as a lamp load, heater, or solenoid valve is controlled through an output 

module, a large current (approximately 10 times greater than normal) may flow when the output is 
turned OFF → ON. Take measures such as replacing the module with one having a sufficient 
rated current. 
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[Installation precautions] 

CAUTION 

● Use the programmable controller in an environment that meets the general specifications 
described in this manual. 
Failure to do so may cause electric shock, fire, malfunction, or damage to or deterioration of the 
product. 

 

● While pressing down the module mounting lever in the lower part of the module, insert the module 
fixing projections into the fixing holes on the base unit completely. Mount the module as above 
with the module fixing holes as a support. 
Incorrect mounting may cause malfunction, failure or drop of the module. 
When using the programmable controller in an environment of frequent vibrations, fix the module 
with a screw. 
Tighten the screws within the specified torque range.  
A screw that has been tightened too loosely may cause a drop, short-circuit, or malfunction.  
A screw that has been tightened too tightly may cause a drop, short-circuit, or malfunction due to 
the screw or module breakage. 

 
● When using an extension cable, connect it to the extension cable connector of the base unit 

securely.  
Check it after mounting.  
Poor connection may cause incorrect input or output. 

 
● When using a memory card, insert it securely, pressing it to the memory card mounting slot.  

Check it after mounting.  
Poor connection may cause malfunction. 

 
● Switch off all phases of the external power supply used in the system before mounting or 

removing a module. Failure to do so may damage the product.  
A module can be replaced online (while power is on) on any MELSECNET/H remote I/O station or 
in the system where a CPU module supporting online module change is used.  
Note that there are restrictions on the modules that can be replaced online (while power is on), 
and each module has its predetermined replacement procedure.  
For details, refer to the section of online module change in this manual or the manuals of modules 
that support online module change. 
 

● Do not directly touch any conductive part of the module. 
Doing so can cause malfunction or failure of the module. 

 

[Wiring precautions] 

WARNING 

● Be sure to switch off all phases of the external power supply used by the system before wiring 
work.  
Failure to do so may cause electric shock or damage the product. 

 
● When turning on the power and operating the module after wiring is completed, always attach the 

enclosed terminal cover. 
The absence of the terminal cover may cause electric shock. 
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[Wiring precautions] 

CAUTION 

● Ensure to ground the FG and LG terminals of the programmable controller with the ground 
resistance of 100Ω or less for the exclusive use.  
Failure to do so may cause electric shock or malfunction. 

 
● Before wiring the module, confirm the rated voltage and terminal layout of the product to wire 

correctly. 
Connection to a power supply with different ratings or incorrect wiring may cause fire or failure. 

 
● Crimp or solder external connectors correctly using tools specified by the manufacturer. 

Incomplete connection may cause short-circuit, fire, or malfunction. 
 
● Tighten the terminal screws within the specified torque range. 

A terminal screw that has been tightened too loosely may cause short-circuit, fire, or malfunction. 
A terminal screw that has been tightened too tightly may cause a drop, short-circuit, or malfunction 
due to the screw or module breakage. 

 
● Be careful to prevent foreign matter such as sawdust or wiring chips from entering the module. 

Failure to do so may cause fire, failure, or malfunction. 
 
● The top surface of the module is covered with protective film to prevent foreign matter such as 

wiring chips from entering the module when wiring. 
Do not remove this film during wiring. 
Before operating the system, be sure to remove this film to dissipate heat. 

 

[Startup and maintenance precautions] 

WARNING 

● Do not touch any terminal while power is on. 
Doing so may cause an electric shock. 

 
● Connect the battery correctly. 

Do not charge, disassemble, heat, short-circuit, or solder the battery, or throw it into the fire. 
Mishandling the battery may cause heat, burst, or ignition, resulting in injury or fire. 

 
● Switch off all phases of the external power supply used in the system before cleaning the module 

or retightening the terminal screws or module fixing screws. 
Failure to do so may cause electric shock. 
A terminal screw that has been tightened too loosely may cause a short circuit or malfunction. 
A terminal screw that has been tightened too tightly may cause a drop, short-circuit, or malfunction 
due to the screw or module breakage. 
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[Startup and maintenance precautions] 

CAUTION 

● When performing online operations (especially when performing program modification, forced 
output, and operating status change) for the running CPU from the peripheral device, read the 
manual carefully and ensure the safety before operation.  
Improper operation may cause machine damage or accident. 

 
● Do not disassemble or modify the modules.  

Doing so may cause failure, malfunction, injury, or a fire. 
 

● Use any wireless communication device such as a cellular phone or PHS (Personal Handy-phone 
System) more than 25 cm away in all directions from the programmable controller. 
Failure to do so may cause malfunction. 

 
● Switch off all phases of the external power supply used in the system before mounting or 

removing a module. Failure to do so may cause a failure or malfunction of the module. 
A module can be replaced online (while power is on) on any MELSECNET/H remote I/O station or 
in the system where a CPU module supporting online module change is used.  
Note that there are restrictions on the modules that can be replaced online (while power is on), 
and each module has its predetermined replacement procedure.  
For details, refer to the section of online module change in this manual or the manuals of modules 
that support online module change. 

 
● After the first use of the product, do not mount/remove the modules to/from the base unit more 

than 50 times. (JIS-B3502 compliant) 
Exceeding the limit of 50 times may cause malfunction. 
 

● Do not drop or apply shock to the battery to be installed in the module. 
Doing so may damage the battery, causing the battery fluid to leak inside the battery. 
If the battery is dropped or any shock is applied to it, dispose of it without using. 

 
● Before handling the module, touch a conducting object such as a grounded metal to discharge the 

static electricity from the human body. 
Failure to do so may cause module failure or malfunction. 

 
 

[Disposal precautions] 

CAUTION 

● Dispose of this product as industrial waste. 
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[Transportation precautions] 

CAUTION 

● When transporting lithium batteries, follow the transportation regulations. 
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● Safety Precautions (GX Works2) ● 
(Please read the precautions carefully before use.) 

 
When using the integrated FA software (GX Works2 Version 1), please read carefully the GX Works2 
operating manual and related manuals referenced in this manual. Pay sufficient attention to safety and 
handle the software properly. 
In this manual, the safety precaution levels are classified under "WARNING" and "CAUTION". 
 
 

Incorrect handling may cause hazardous conditions, resulting in death 
or severe injury. 
 
Incorrect handling may cause hazardous conditions, resulting in 
medium or slight injury, or may cause only material damage. 

 
 
Note that the  CAUTION level may lead to a serious consequence according to conditions. 

Please follow the instructions of both levels because they are important to personnel safety. 
 

[Design precautions] 

WARNING 

● When data change, program change, or status control is performed from a personal computer to 
a running programmable controller, configure an interlock circuit outside the programmable 
controller system to ensure that the entire system will always operate safely.  
Furthermore, for the online operations performed from a personal computer to a programmable 
controller CPU, predetermine the system’s corrective actions in case of a communication error 
caused by poor cable connection, etc. 

 

[Startup and maintenance precautions] 

CAUTION 

● When performing online operations (program change while a programmable controller CPU is 
running, forced input/output operation, operating status changes such as RUN-STOP, and remote 
control operation) for the running programmable controller CPU from a personal computer, read 
the manual carefully and ensure sufficient safety before operation. When changing a program 
while a programmable controller CPU is running (online program change), a problem such as 
program corruption may occur depending on operating conditions. Fully understand the 
precautions described in Section 12.9 of the GX Works2 Version 1 Operating Manual (Common) 
(refer to Appendix 1 of this school text) before use. 

● Refer to the manual of each module before performing online module change because only 
limited modules allow online module change. 

 
 

CAUTION 

WARNING 
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Revisions 
* The text number is given on the bottom left of the back cover. 

Print date *Text number Revision 

Mar., 2014 SH(NA)-081374ENG-A First edition 

   

 

This manual guarantees no industrial rights or implementation of any rights of any other kind, nor does it grant any 
licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial rights which may 
occur as a result of using the contents noted in this manual. 

 © 2014 MITSUBISHI ELECTRIC CORPORATION 
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Introduction 
 

This text is intended to give necessary background information and how to use a peripheral personal computer 
(GX Works2) for maintenance of the MELSEC-Q series. 

 
<The following are related materials> 

Manual name 
Manual number
(Model code) 

QCPU User's Manual (Hardware Design, Maintenance and Inspection) 
Description of specifications such as the CPU module, power supply module, base unit, 

extension cable, and memory card is provided. 

SH-080483ENG

(13JR73) 

GX Works2 Version 1 Operating Manual (Common) 
Description of common functions between simple project and structured project such as system 

configuration of GX Works2, parameter setting, operation methods for online functions is 

provided. 

SH-080779ENG

(13JU63) 

GX Works2 Version 1 Operating Manual (Simple Project) 
Description of operation methods such as program creation and monitoring in a GX Works2 

simple project is provided. 

SH-080780ENG

(13JU64) 
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Chapter 1: Importance of Production Maintenance 

If a production system stops because of failure or power failure, a loss proportional to 
the stop time occurs. 
Therefore, it is required to design an equipment system to prevent [stop because of 
failure] or [stop because of power failure] from occurring. 
The important issue is how the production system can quickly be restored if the system 
stops by any chance. Therefore, the maintenance staff group is assigned to each 
factory for improving availabilities of the production systems. 
 

1.1 Importance of Maintenance 

In recent production systems, a lot more machinery equipment adopts the mechatronics 
technology and systems are becoming more complex and significantly sophisticated. Also, 
using black box systems for equipment is becoming increasingly common. For these 
reasons, the maintenance quality is relatively decreasing, making improvement in system 
availability difficult. 
Therefore, [highly reliable products] and [increased level of maintenance technology] are 
strongly required. 

 

Standard production system

Mechatronics of machinery
and equipment

Black boxing of the equipment

Highly reliable product application

Complicated and highly-developed
production system

Decrease in relative
maintenance level

Increasing the level of
maintenance technology

Realization of highly reliable
production system
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1.2 Maintenance System 

In order to achieve a highly reliable production system, it is important to have an 
established maintenance system in place.  
The following shows an outline of a maintenance system. 
 

When developing new machinery, give due consideration to
maintenance measures at the designing stage.

Preventive maintenance of the machinery is carried out if the
machinery is prone to financial losses or serious disasters due to
failures or accidents, and if it is beneficial to carry out preventive
maintenance of such machinery. Also perform maintenance actions
for predictable failures and accidents before such incidents occur.

Production
maintenance

Maintenance
measure

design

Preventive
maintenance

Daily maintenance
and inspection

Perform daily inspection to detect any dangerous
conditions that may cause breakdown of the
production system due to failure or any detrimental
decrease in performance.

Periodic maintenance
and inspection

Perform regular inspection to detect any dangerous
conditions that may cause breakdown of the
production system due to failure or any detrimental
decrease in performance.

Corrective
maintenance

Corrective maintenance is carried out when it is easier to
repair equipment after it has broken down (such as digital
displays, CRTs, all types of lamps) due to accidents.

Maintenance for
improvement

This maintenance is carried out to minimize degradation of
installed machinery and to simplify the inspection process.

Monitor the status to detect any dangerous
conditions that may cause breakdown of the
production system due to failure or any detrimental
decrease in performance.

Condition-based
maintenance
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1.3 Maintenance Plan 

In production systems, the recovery time can be long, and improvements in system 
availability cannot be expected if repairs are considered only after a failure occurs.  
Therefore, a maintenance plan is developed from when a production system is 
implemented, and efficient maintenance is conducted.  
In order to quickly restore the system after a failure occurs, it is necessary to systematically 
execute the contents of the following table. 

 
Table1-1: Maintenance Plan of the Programmable Controller System 

Plan item Description 
Knowledge of 
the 
programmable 
controller 

 Fundamental knowledge of principle, function, performance, 
etc. of the programmable controller 

 Characteristics of the programmable controller (difference 
from a calculator, relay, etc.) 

 Position of the programmable controller (sequence control, 
and control function of data collection and distribution) 

 Introductory state of the programmable controller (usage in 
your own department etc.) 

 Description of the type of machine installed (introduced) 
(model, function, performance, characteristics, etc. of the 
programmable controller used) 

Maintenance 
scope and 
technology 

 Knowledge about maintenance related to the programmable 
controller (characteristics of the programmable controller 
from a maintenance perspective, and maintenance items of 
the programmable controller) 

 Precautions for maintenance of the programmable 
controller (handling method, key points of maintenance, 
etc.) 

Maintenance 
training 

Training  Functions related to maintenance of the programmable 
controller (self-diagnostics function, RAS function, etc.) 

 Functions related to maintenance of peripherals 
(troubleshooting function, etc.) 

 Practical training of troubleshooting (operation of 
peripherals, replacement of hardware, etc.) 

Maintenance 
timing 

Specify the target type, etc., of preventive maintenance and corrective 
maintenance, and determine the implementation timing. 

Maintenance 
equipment 

Preparation of spare parts, components, measuring instruments, 
measurement equipment, etc. for maintenance 

Maintenance 
procedure 

Prepare the manuals, etc., and clearly define the implementation method and 
a description. 

Maintenance 
staff 

Determine the staff procurement, positions, assigned areas, etc. 

Maintenance 
method 

improvement 
Study to improve the maintenance methods, etc. 

After-sales 
service 

 Service base (location, address, person in charge, etc.) 
 Service range (target model, handling range, etc.) 
 Service time (start/end time, turnaround time, emergencies, 

etc.) 
 Service period (free service period, handling at the time of 

paid service, etc.) 
 Spare parts supply period (repair after discontinuing 

production, supply period, etc.) 
 Measures against discontinuance of production (contents of 

discontinuance declaration, repair period, etc.) 
 Time required for repair (standard delivery, short term/long 

term deliveries, etc.) 

Understanding 
a service and 

support 
system of 

the 
programmable 

controller 

Technical 
support 

 Support base (location, address, person in charge, etc.) 
 Support range (target model, hardware/software, and 

system) 
 Support method (telephone, FAX, visit, school, and actual 

machine operation) 
 Manual (manual effective for maintenance) 
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1.4 Management of Maintenance Documents 

In order to quickly restore after the failure, it is necessary to organize and manage the 
documents as shown in the following table. 
 

Table 1-2: Maintenance-related Documents to Manage 
Document 

classification 
Name of document Description 

System and control 
specifications documents

Documents describing the functions and operations of a target 
system and control 
(sequence and timing of operation, operation condition, 
operation procedure, and interlock condition) 

Network connection 
diagram 

Documents illustrating how modules are connected with 
communication cables 

Electrical wiring diagrams Schematic diagrams 
(power supply circuit, motor circuit, control circuit, operating 
circuit, display circuit, etc.) 
Connection diagrams among equipment and panels (cable 
layout diagram, ground wire layout diagram) 

Equipment layout 
diagrams 

Layout diagrams for electrical equipment in the panel, terminal 
block wiring number layout drawings, connection assignment 
tables for connector pins 
(For identifying models and wiring numbers for each 
equipment) 

List of hardware used Lists of electrical equipment used in the system 
(model name and specifications of all the electrical equipment 
constituting the programmable controller system, such as 
modules, peripheral equipment, electrical components in the 
control panel, I/O equipment, and software packages) 

Programmable controller 
program 

Control programs for the programmable controller (ladder 
diagrams and lists) 

Assignment lists of 
input/output, etc. 

Assignment lists of external I/O signals and internal devices 
(signal names corresponding to respective device numbers, 
signal descriptions, and setting values) 

Program descriptions 
(specifications) 

Program configurations, process descriptions, and function 
descriptions 
(explanations for operations in programs that are difficult to 
understand, etc.) 

System- 
specific 
documents 

Instruction manuals of 
controlled systems 
 Maintenance and 

inspection instructions

For handling (operation), maintenance, and inspection of the 
controlled systems 

Catalogs of hardware 
used 

Identifies configuration, manufacturer of the equipment model
General 
documents 

Instruction manuals and 
technical documents of 
hardware used 

For troubleshooting of hardware and software 

 
1.5 Maintenance Record 

After recovery following a failure, it is necessary to manage the maintenance record as 
follows for future reference. 

 
Table 1-3: Maintenance Record to Manage 

Record item Description 
Occurrence status of error and failure Name of device/equipment, phenomenon, and environment 
System stop time Time of occurrence and stop time 
Impact due to occurrence Amount of loss, time loss, and other impact 
Cause Method of cause investigation and cause including 

presumption 
Recovery method Recovery method such as replacement and repair 
Measures against re-occurrence Defensive measures against the re-occurrence of the similar 

failure and lessons learned 
Failure record Record of failure cause, measures, etc. 
Name of a person in charge  
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1.6 Tendency of Failure Cause 

The following graphs show the ratios of the failed parts and the failure causes of 
programmable controller troubles.  
[Based on the research by the Japan Electrical Manufacturers' Association (JEMA)] 
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Figure 1-1: Failed Part of the Programmable Controller (Multiple Answers) 
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Figure 1-2: Failure Cause of the Programmable Controller (Multiple Answers) 
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1.7 Failure Modes 

In general, failure modes of a complicated system can be classified into three levels 
recognized as Figure 1-3: initial failure, random failure, and wear-out failure. An initial 
failure is considered a failure that is removed during the manufacturing process or 
through inspection by the manufacturer. A random failure is an unexpected failure, 
which cannot be anticipated and can occur anytime before the wear-out progresses 
during the life of the equipment. It is difficult to take technical measures against 
random failures, and at this point, only the measures based on statistical handling can 
be implemented. 
A wear-out failure occurs near the end of the usable life as a result of deterioration or 
abrasion and increases rapidly with the time. Replacement years mentioned here 
indicate a point "tb" in Figure 1-3, at which point a specified part is replaced with a new 
one in order to achieve appropriate preventive maintenance. 
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Figure 1-3: Bath-tub Curve 
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Chapter 2: Understanding Programmable Controller System 

A programmable controller system consists of a base unit, power supply module, CPU 
module, input module, output module, and special function module. 

 
2.1 System Configuration of Training Machine 

Q61P QX
42

QY
42P

Q64
AD

Q62
DAN

X0

X3F

Y40

Y7F

1 9 4 2 4 1 3 6 MELSEC-Q

D/A OUTPUTA/D INPUT

X3F X30 X2F X20

Y6F Y60 Y5F Y50 Y4F Y40
Y70

Y78

X0

X8

Y71

Y79

X1

X9

Y72

Y7A

X2

XA

Y73

Y7B

X3

XB

Y74

Y7C

X4

XC

Y75

Y7D

X5

XD

Y76

Y7E

X6

XE

Y77

Y7F

X7

XF

ON

OFF

ON

OFF

QCPU

CPU module Output module

Power supply
module

Input module
Base unit Q38DB

Empty

(64
points)

(64
points)

(16
points)

(16
points)

USB cable

Peripheral device
I/O panel

 

Table 2-1: System Configuration of the Training Machine 

 
 
 



 

2 - 2 

 

2.2 I/O Number Assignment 

This section describes I/O number assignment which is necessary for data 
communication with an I/O module or an intelligent function module in QCPU. 
 
An I/O number is intended to input data from an input module or to output data to an 
output module in a sequence program. 
The I/O number is represented in three-digit hexadecimal. 
The I/O numbers of I/O modules all of which have 16 points are shown in Figure 2-2. 
 

～

0 0 0X

0 0 FX

～

0 1 0X

0 1 FX

0 2 0X

0 2 FX

～

0 3 0Y

0 3 FY

～

0 4 0Y

0 4 FY

～
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Input 16
points

Input 16
points

Input 16
points

Output 16
points

Output 16
points

 

Figure 2-2: Concept of I/O numbers 

 
2.2.1 Concept of I/O Number Assignment 

I/O number assignment is carried out as shown below when the power turns on or 
when the CPU module is reset.  
Specify I/O numbers that are assigned according to the following items in a sequence 
program. 
(1)  The I/O number of Slot 0 of the main base unit (located at the right side of the 

CPU module) is zero, and numbers are assigned rightward sequentially.  

If it is an input module, the number will be "X    ", and if it is an output 

module, the number will be "Y    ". 

0 2 3 4 5 6 71

X000

X00F
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16
points

16
points

16
points

Slot number

Direction of assignment
(Assigned rightward from Slot 0)

Input (X) and output (Y) are
sequentially assigned  
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(2)  If an extension base unit is connected, the number starts from the next number of 

the assignment of the main base unit.  

A base number (one to seven) is assigned to the extension base unit according to 

the connection order of extension cables. 

Assignment when an extension base unit is used 
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*  The I/O number assignment is carried out sequentially, in the order of (1) → (2) →

(3) → (4) → (5) → (6).  
In this I/O number assignment example, each module has 16 points. 

 
(3)  One module occupies I/O numbers equal to its number of I/O points.  

For example, if an input module that has 32 points is mounted to Slot 0 of the 

main base unit, 32 points of I/O numbers, which are X00 to X1F, are occupied. 
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(4)  To an empty slot, to which neither an I/O module nor an intelligent function 

module is mounted, number of points specified in the PLC System Settings in 

PLC parameters are assigned. (The default is 16 points.) 

(
)

(
)

0 2 3 41

X000

X01F

X020

X03F
050

05F

040

04F

X060

X06F

Po
we

r s
up

ply
 m

od
ule

In
pu

t

In
pu

t

In
pu

t

C
P

U

32
points

32
points

16
points

E
m

pt
y

E
m

pt
y

Slots to which no I/O module and
intelligent function module are mounted

To each empty slot, 16 points are assigned  



 

2 - 4 

 

2.2.2 I/O Assignment Using GX Works2 

In QCPU, the I/O module or the intelligent function module can be controlled without 
I/O assignment using GX Works2. 
I/O assignment using GX Works2 is effective in the following cases. 

 
(1)  Purpose of I/O assignment using GX Works2 

(a)  Reservation for replacement to a module other than 16-point modules 

In case replacement of a current module with another that has different points 

is planned, reservation in advance eliminates the need of future I/O number 

change. 
 

(b)  Prevention of I/O number change due to module replacement 

In case failure occurs in an I/O module or an intelligent function module other 

than 16 points and the module is removed, change of I/O numbers can be 

avoided. 
 

(c)  Change to I/O numbers specified by a program 

In case a designed program uses different I/O numbers from the ones an 

actual system uses, the I/O numbers of each module of the base unit can be 

changed to the numbers specified by the program. 
 

(d)  Detailed settings for an I/O module and an intelligent function module 

Selecting "Type" in I/O assignment displays detailed settings below. 

 Input response time setting for an input module and an interrupt module 

(I/O response time) 

 Error time output mode setting for an output module and an intelligent 

function module 

 Switch setting for an intelligent function module 

 Operation setting for QCPU 

(during hardware error of the intelligent function module) 
 

POINT  

(1) I/O assignment is necessary for input module response time change and 
intelligent function module switch setting.  
I/O assignment, input module response time setting, intelligent function module 
switch setting, and output mode upon error require the programmable 
controller's power turned OFF and ON (ON → OFF → ON) or resetting QCPU.

(2) If a failure of an I/O module other than 16 points occurs without I/O assignment 
using GX Works2, the I/O numbers of the following modules may change. This 
can cause malfunction. I/O assignment using GX Works2 is recommended 
therefore. 
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(2)  Concept of I/O assignment using GX Works2 

(a)  I/O assignment per slot 
"Type" (module type), "Number of points" (number of I/O points), and "Start 
XY" (start I/O number) can be set individually for each slot of the base unit. 
For example, if the number of I/O points of a specified slot is changed, the 
number of points alone can be set. 
Items that are not specified depend on a mounted status of the base unit. 
I/O assignment can be performed from the I/O assignment setting of the PLC 
parameter. 

 
(1) (2) (4) (5)(3)

 
 

1)  Slot 
Displays a slot number as well as how many extensions and slots exist in 
the base unit before a specified slot. 
If the basic setting does not provide the number of slots in the base unit, 
"*" is displayed as the number of extensions in the base unit, and a serial 
number from the 0th slot of the main base unit is displayed as the number 
of slots. 

2)  Type (used by QCPU) 
Select the type of a mounted module from the following items. 
 Empty (empty slot) 
 Input (input module) 
 High-speed input (high-speed input module) 
 Output (output module) 
 I/O combined (I/O combined module) 
 Intelligent (intelligent function module, or special function module 

compatible with AnS) 
 Interrupt (interrupt module) 
 Slots without any type specified will be the type of an implemented 

module. 
3)  Model name 

Set the model name of a mounted module using up to 16 single-byte 
characters. 
QCPU does not use the specified model name. (This is regarded as a user's 
memo.) 
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4)  Points 

When changing the number of I/O points for each slot, select the number 
of points from below. 
 

• 0 points 
• 48 points 
• 256 points 

• 16 points 
• 64 points 
• 512 points 

• 32 points 
• 128 points 
• 1024 points 

 

Slots without any number of points specified will have the number of 
points for an implemented module. 

5)  Start XY 
 When changing I/O numbers for each slot, set a new start I/O number.  

To slots without any start XY specified, I/O numbers that start from a 
specified slot will be assigned sequentially. 

 Set I/O numbers for each slot so that the numbers will not overlap with 
ones assigned by QCPU.  
A duplicated I/O number causes an error (SP.UNIT LAY ERR.). 

 Assigning I/O numbers for each module in advance prevents the I/O 
numbers of other modules from being changed during module 
replacement. 

 
(b)  Status of slots to which I/O assignment has done 

Slots to which I/O assignment has done reflect assigned I/O numbers, regardless 
of module implementation. 
1)  When the number of points smaller than the implemented points of an I/O 

module is set, the available points of the implemented I/O module 
decrease.  
For example, when a slot implemented with a 32-point input module is 
configured as a 16-point input module using I/O assignment, the latter 16 
points out of the 32 points become unavailable. 

2)  When the number of points smaller than the implemented points of an 
intelligent function module is set, "SP.UNIT LAY ERR." occurs.  
(If number of points larger than the point of the module is set, no error is 
displayed.) 

3)  When the number of points larger than the implemented points of an I/O 
module is set, points that exceed the available points are regarded as 
dummy. 

4)  Use an identical type as an implemented module for I/O assignment.  
In I/O assignment, if a type is different from an implemented module type, it does 
not operate properly. For an intelligent function module, number of I/O points 
must be identical too. (If the number of I/O points is not identical, no error is 
displayed.) 

 
Implemented module I/O assignment setting Result 

Input module Output/Empty Empty 
Output module Input/Empty Empty 
Input module/output module Intelligent Error (SP.UNIT LAY ERR.) 

Empty Empty 
Intelligent function module 

Input/Output Error (SP.UNIT LAY ERR.) 
Empty slot Intelligent No error 

 
5)  When I/O assignment is done, the last I/O number must be within FFFH. If 

the last I/O number exceeds FFFH, an error (SP.UNIT LAY ERR.) occurs. 
(In the system monitor of GX Works2, "***" is displayed as an I/O 
address.) 

(c)  To a slot to which I/O assignment using GX Works2 has not done, the 
number of points identical to an implemented module is assigned. 

(d)  It is recommended to attach a seal or something that has description of I/O 
assignment settings to each module for easy recognition from outside, in 
order not to mount a wrong module during maintenance. 
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(3)  Example of I/O assignment using GX Works2 

Consider an example in which I/O assignment is done for the following purposes. 
 
(a)  Because no 16-point input module is available at hand, a 32-point input 

module must be used. 
 
(b)  Because delivery of a 32-point output module is behind schedule, an empty 

slot for 32 points must be temporarily reserved. 
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Chapter 3: Learning Personal Computer (GX Works2) Operation 

3.1 Creation of New Project Using GX Works2 

(1) Click!

(3) Select!

(2) Select!

(5) Click!

(4) Select!

 

(1)  Click the [Start] button. 
 
(2)  Select the [All programs] menu. 
 
(3)  Select the [MELSOFT application] menu. 
 
(4)  Select the [GX Works2] menu. 
 
(5)  Click the [GX Works2] menu. 

(6) GX Works2 starts.

 

(To the next page) 

(6)  GX Works2 starts. 
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(From the previous page) 

 

 

 

(7)  Click  on the toolbar or click the [Project] 

→ [New] menu ( Ctrl + N ). 

 

 

(8)  Click the [Project Type] list button. 
 
(9)  Click to select "Simple project" from the 

displayed list box. 

 

(To the next page) 

(10) Click the [Series] list button. 
 
(11) Select "QCPU (Q mode)" from the displayed 

list box. 
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(From the previous page) 

 

 

 

(12) Click the [Type] list button. 
 
(13) Select "Q06UDH" from the displayed list box.

 
 

 

(14) Click the [Language] list button. 
 
(15) Select "Ladder" from the displayed list box. 
 
(16) Click the  OK  button. 

(17) A new project opens. 

 



 

3 - 4 

 

REFERENCE  
In GX Works2, shortcut key assignment can be changed using the [Tool] → 
[Key Customize] menu. 

 

 
 

Item Description 
Shortcut Key - 

Category Select a classification from a list of groups categorized by each window. 
Command Select a function name whose shortcut key is to be changed. 
Current key Shortcut keys currently assigned to a selected command are displayed. 

Press the keys to assign  
Specify a shortcut key to be newly assigned. It can be specified by 
pressing keys of the keyboard. 
Example)  

 

Currently assignment 
The name of a menu assigned to a selected shortcut key is displayed. 
If the selected shortcut key has already been assigned to another function, 
the name of the function is displayed. 

Template 

Select a shortcut key template from the list box. 
 Default settings 

Changes to the initial status. 
 GPPA type setting 

Collectively changes key assignment to the one same as GPPA during 
creation of a ladder diagram. 
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3.2 Programming in Ladder Mode 

This section describes practical training for an operation to create and execute a 
sequence program. 

 
(1) Function key operation during ladder mode 

 
Operation Key combination Operation Key combination 

Write Mode F2  
Rising Pulse Branch 

( ) 
Alt + F7  

Read Mode Shift+ F2  Statement Display Ctrl + F7  

Start Monitoring F3  
Rising Pulse Close 

Branch ( ) 
Shift+ Alt + F7  

Monitor (write mode) Shift+ F3  Find Contact or Coil Ctrl + Alt + F7  

Stop Monitoring Alt + F3  
Application Instruction 

( ) 
F8  

Conversion F4  Falling Pulse ( ) Shift+ F8  

Conversion + Online 
Program Change 

Shift+ F4  
Falling Pulse Branch 

( ) Alt + F8  

Conversion (All 
Program) 

Shift+ Alt + F4  Note Ctrl + F8  

Normally Open 
Contact ( ) 

F5  
Falling Pulse Close 

Branch ( ) 
Shift+ Alt + F8  

Normally open contact 
OR ( ) 

Shift+ F5  Horizontal Line ( ) F9  

Operation result rising 
pulse conversion ( ) 

Alt + F5  Vertical Line ( ) Shift+ F9  

Comment Ctrl + F5  Delete Line ( ) Alt + F9  

Operation result fall 
pulse conversion ( ) 

Ctrl + Alt + F5  
Delete Horizontal Line 

( ) Ctrl + F9  

Rising Pulse Close 
( ) 

Shift+ Alt + F5  Edit Line ( ) F10  

Normally Closed 
Contact ( ) 

F6  Delete Vertical Line ( ) Ctrl + F10  

Normally closed 
contact OR ( ) 

Shift+ F6  
Operation Result 
Inversion ( ) Ctrl + Alt + F10

Falling Pulse Close 
( ) 

Shift+ Alt + F6  Insert Row Shift+ Ins  

Device Display 
Ctrl  + Alt  + 

F6  
Insert Column Ctrl + Ins  

Coil ( ) F7  Delete Row Shift+ Del  

Rising Pulse ( ) Shift+ F7  Delete Column Ctrl + Del  
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1)  Change to Write Mode using the function key F2 .  

(Mode switching can be done using F2  (Write), Shift + F2  (Read), or 

F3  (Monitor).) 

 
2)  There are three operations for conversion after writing a ladder: 

 F4  ( ) ......................................Converts a program currently editing. 

 Ctrl  + Alt  + F4 ( ) ........Converts all programs currently editing. 

 Shift + F4 ................................Converts an edited program and writes to a 
programmable controller CPU in a RUN 
state. 

 
3) Follow the steps below to write instructions using function keys. 

 
a.  Operation for inputting contacts 

Using the keyboard, press the F5  key then input "X1".  

Press the  key or the  OK  button to write to the editing screen. 
 

 
 

b.  Operation for inputting application instruction 
Using the keyboard, press the F8  key then input "MOV K1 D0". 

 

 
 

REFERENCE  

The following procedures can also be used for writing instructions: 
 By the tool button 

Click  then input "MOV K1 D0" using the keyboard. 

 
 By the menu bar 

Select the [Edit] → [Ladder Symbol] → [Application Instruction] menu then input "MOV K1 D0" using 
the keyboard. 

 

Press the  key or clicking the  OK  button to write to the editing 
screen. 
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Project name QHOZEN
(2) Sequence programming in ladder mode 
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0

3
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35

45

50

Y74

END

X2 X2SM411
Y70

K200

K4Y40T1BCD
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Y71

Y72

Y73
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K1000

K4Y60C0BCD

C0RST

X0

SM400
T1K100>

T1K100<= T1K150>=

T1K150<

M100

X1

10

 

Use the function keys F5  to F10  for typing. 
 

1) F6  X  2   F5  S  M  4  1  1   
( ) ( ) 
F7  Y  7  0   

( )  
2) F5  X  2   F7  T  1   K  2  0  0   

( ) ( ) (Space) 
→  ↑  Shift+ F9   ↓  F8  B  C  D   T   

                  ( ) ( ) (Space) 
1   K  4  Y  4  0   

 (Space) 
 

3) Press the function key F4  ( ). 
 

Key input F5  Shift  + F5  F6 Shift  + F6  F7 F8 F9  Shift  + F9  

Ladder 
symbol        
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3.3 Parameter Setting for Multiple CPU (Not Required for Single CPU Configuration) 

Two CPUs have been installed in a Q series training machine configured for multiple CPU 
compatibility. 
Parameter setting is required for operation with multiple CPU, although this configuration is 
not used in this text. 

 

 

 

(1)  In GX Works2, double-click "PLC parameter" 
in the project list. 

 

(2)  The Q parameter setting dialog box appears. 
Click the "Multiple CPU setting" tab. 

 

(3)  Set "No. of PLC" to "2". 
 
(4)  Click the  End  button. 
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3.4 Storing and Managing Programs 

Parameters and sequence programs can be stored as a file with a project name. 
 

(1)  Select  on the toolbar or select the 

[Project] → [Save] menu ( Ctrl  + S ). 
 
If a project has already been saved, 
save operation is completed here. 

①　Click!  

 

 

(Only when saving a project for the first time) 

 

 

(2)  Select a storage location for the project. 
 
(3)  Set a project name. 
 
(4)  Set a title if needed. 
 
(5)  When the setting for each item is completed, 

click the  Save  button. 
 

(6) Click!

 

(6)  Click the  Yes  button.  
This completes save operation. 

 

REFERENCE  

 Characters such as "%", "'", "*", "/", ":", "<", ">", "?", "\", and "|" are not available. (":" and "\" are available 
only when specifying a drive) 
Do not use "." (period) at the end of a project name. 

 Specify a storage folder path and a project name within 200 single-byte characters (100 double-byte 
characters) in total. 

 Specify a title within 128 single-byte characters (64 double-byte characters). 
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3.5 Writing Data to Programmable Controller CPU 

In this section, a sequence program created in Section 3.2 will be written to the 
programmable controller CPU. 
Connect the personal computer and the programmable controller CPU with a USB 
cable. 
 
(1) Write to QCPU No. 1 

 

(2)　Set to "STOP"!

 

 

1) Set the "RUN/STOP/RESET" switch 
to "STOP" in No. 1 and No. 2 QCPU. 

 

 

 

 

2)  Click the "Connection destination" view in the 
view selection area of the navigation window.

 

 

 

(To the next page) 

3)  The connection destination view appears. 
Double-click the current connection 
"Connection1". 



 

3 - 11 

 

 

 

4)  The personal computer side I/F is set to 
"USB" by default.  
If other means are used in order to connect 
to the programmable controller CPU, 
double-click an icon that represents each 
connection type to change the setting.  
In addition, check the connection destination 
setting screen to make sure that the target 
system is set to "No. 1". 

 
5)  When the setting is completed, click the  

 OK  button. 

6)  The memory of the No.1 QCPU must be 
formatted.  
Select the [Online] → [Operate on the PLC 
Memory] → [Format the PLC Memory] menu. 

7)  Select either one in "Format type" by 
clicking.  
In this training, select "Do not create a user 
setting system area". 

 

 

 

8)  Click the  Execute  button.  
The memory of the programmable controller 
CPU is formatted. 

 

 

 

9)  Click the  Yes  button. 

 

(10) Click!

 

 

(To the next page) 

10)  Click the [Online] → [Write to PLC] menu. 
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(From the previous page) 

 

 

 

 

 

11) The online operation dialog box appears. 
 

12) Click the "Parameter + Program" button. 
 

13) Click the  Execute  button. 

 

 

14)  When the write to QCPU No. 1 is 
completed, a dialog box on the left appears. 
Click the  Close  button. 
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(2)  Write to QCPU No. 2 (not required for single CPU configuration) 

Just like No. 1, data such as parameters must be written to QCPU No. 2. 

 
 

 

1)  Set the target system to "No. 2" in the 
connection destination setting screen. 

 

 

 

2)  Just like QCPU No. 1, complete Step 6) to 
13) described in (1) of this section for 
QCPU No. 2. 

 
 Formatting CPU program memory 
 Writing CPU parameters and programs 

 
3)  When the write to QCPU No. 2 is 

completed, a dialog box on the left 
appears. Click the  Close  button. 

 
(To the next page) 

4)  In the connection destination setting 
screen, click "1" in [Multiple CPU Setting] 
to select it. 

 
5)  Click the  OK  button. 
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6)  Push down the "RUN/STOP/RESET" switch 

to the "RESET" position once (for about one 
second) in QCPU No. 1.  
 
The "ERR." LED flashes several (three to 
four) times. (Reset is accepted and in 
progress) 
Turning off the "ERR." LED means reset 
operation is completed. 

 
7)  Return the RUN/STOP/RESET switch to the 

"STOP" position. 
 

REFERENCE  

(From the previous page) 

 

(6)　Perform "RESET"!

 

Reset the programmable controller CPU after a 
new parameter or a program is written.  
Error and device descriptions before writing 
must be initialized. 
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3.6 Monitoring Operation in Ladder Mode 

In this section, operation of the CPU executing the program written to the 
programmable controller CPU in Section 3.5 will be monitored using ladder monitor 
operation.  

 Set the "RUN/STOP/RESET" switch of the CPU to 
"RUN". 
 

(1) Click!

 

 

1)  Click  (monitoring mode) on the toolbar. 
 

 

 

2)  The monitor status dialog box appears, and the
ladder monitor is executed. 

(a)  Connection status 
Connection status to the programmable
controller CPU and simulation function is
displayed. 

(b)  RUN/STOP state 
Operating status of the programmable
controller CPU, triggered by the key
switches of the programmable controller
CPU or a remote operation using GX
Works2, is displayed. 

(c)  ERR status (PLC diagnostics) 
Error status of the programmable controller
CPU is displayed.  
The PLC diagnostics screen (*1) appears
by clicking the icon. 

(d)  USER status (PLC diagnostics) 
User error status of the programmable
controller CPU is displayed.  
The PLC diagnostics screen (*1) appears
by clicking the icon. 

(e)  Scan time 
Maximum scan time of the monitoring
programmable controller CPU is displayed. 
In Q series, it is displayed in unit of 0.1 ms.

*1:  For PLC diagnostics, refer to Section 6.2. 
The ON and OFF status of the ladder is as
follows. 
OFF

ON  
*2:  The displayed maximum scan time can be

different from an actual value.  
(When online program change was carried out,
for example, a displayed value becomes larger
than an actual scan time.)  
The actual scan time can be checked using the
program monitor list function (refer to the next
page). 
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 Training machine operation 

1) Turn ON the X2 switch then monitor T1. 
2) Check that the timer T1 is reset when the X0 switch turns ON. 
 

REFERENCE  

 Program monitor list 
A program monitor list can be used with the following steps. 
1) Click the [Online] → [Monitor] → [Program Monitor List] menu. 
2) The program monitor list appears. Check the actual scan time. 

 
(a)  Execution state for each program 

Displays execution state for each program. 
 Program : Displays a program name. 
 Execution : Displays a program type. 
 Scan time : Displays an actual scan time (current value).  

When a program is in a stop (standby) state, 
0.000 ms is displayed as a scan time. 

 Number of executions : Displays the number of executions, which is 
zero when measurement starts. (It returns to 0 
when it reaches 65536.) The number of 
executions is retained after a program stops. 
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3.7 Entry Ladder Monitor Operation 

Multiple relevant ladder blocks can be monitored together by registering a ladder block. 
Horizontally tiling ladder monitor screens allows monitoring another ladder while 
monitoring the registered ladder all the time. 
In this section, a ladder block is registered from the program written to the 
programmable controller CPU in Section 3.5 for monitoring. 

 

 

 

(1)  Select [Online] → [Monitor] → [Entry Ladder 
Monitor]. 

 

 

(2)  The Entry Ladder Monitor screen is 
displayed. 

 

 

 

(To the next page) 

(3)  Click the [Window] → [Tile Horizontally] 
menu. 
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(From the previous page) 

 

 

 

(4)  Select a ladder block in the ladder program 
and select [Edit] → [Copy]. 

 
(5)  Select [Edit] → [Paste] on the Entry Ladder 

Monitor screen.  
The copied ladder block is pasted. 

 Set the "RUN/STOP/RESET" switch of the CPU to 
"RUN". 

 

(6) Click!  

 

(6)  Select  on the toolbar or the [Online] → 
[Monitor] → [Monitoring Mode] menu.  
Monitoring of the registered ladder block is 
started. 

 

(7)  The entry ladder screen switches to the 
monitoring mode. 

 

 

 

(8)  Turn ON/OFF X2.  
Change of the current value of the timer can 
be monitored. 

 

(9)  After clicking the title bar on the monitor 
screen, scroll the ladder monitor so that 
monitoring any step is possible while 
monitoring on the entry ladder monitor screen 
at the same time. 

 

REFERENCE  

The following functions can be executed on the entry ladder screen. 
1. Deletion of ladders in increments of ladder blocks 4. Device test 
2. Device search, instruction search, and character string search 5. Zoom in and out on screen 
3. Displaying comments, statements and notes 6. Drag and drop on the entry data monitor 
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3.8 Device Batch Monitor Operation 

Monitor device statuses of the program written to the programmable controller CPU in 
Section 3.5.  
There are two types of device monitors: "Device/Buffer Memory Batch Monitor" and 
"Watch Window". In this section, perform "Device/Buffer Memory Batch monitor", 
which is monitoring of a specified one type of device. 
 

 Set the "RUN/STOP/RESET" switch of the CPU to 
"RUN". 

 

 

(1)  Select the [Online] → [Monitor] → 
[Device/Buffer Memory Batch] menu. 

 

 

(2)  Click the Reference button and select the TC 
setting value reference. 

 

 

(3)  Select "MAIN" and click the  OK  button. 

 

 
(To the next page) 

(4)  Input "C0" in Device on the device/buffer 
memory batch monitor dialog box and press 

 key. 
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(From the previous page) 

 

 

 

(4)  Monitoring of the specified device is started.  
(C0 and subsequent devices are displayed) 

 
(5)  Perform device batch monitoring of T0 in the 

same way. (T0 and subsequent devices are 
displayed) 

(6)  When the screen is tiled horizontally with the 
ladder monitor screen, device statuses can 
be checked both on the ladder display and in 
the list, which facilitates monitoring.  
Click the [Window] → [Tile Horizontally] 
menu. 

 
REMARKS  

 

Device test operation can forcibly change 
device statuses while monitoring devices by 
the device/buffer memory batch monitor. 
For device test operation, refer to Section 
3.10. 
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3.9 Entry Data Monitor Operation (Watch Window) 

Devices which are not monitored on the ladder monitor screen cannot be directly 
monitored. 
Monitor them by either "Device/Buffer Memory Batch Monitor" or "Watch Window". 
In this section, perform monitoring by "Watch Window", which is for a device registered 
by the user. 
 

 Set the "RUN/STOP/RESET" switch of the CPU to 
"RUN". 

 

 

(1)  Click the [Display] → [Docking Window] → 
[Watch (1) To (4)] menu.  
 
*  In this training, select (1). 

 

 

(2)  The watch 1 window is displayed. Select the 
row to be edited, click the Device/Label field, 
and input "Y70". 

 

 

(3)  The input device/label will be registered. 
 

(4)  Click the [Online] → [Watch] → [Start 
Watching] menu.  
 
The current value of the registered 
device/label is displayed on the window. 

 

REMARKS 

Device test operation can forcibly change device statuses while monitoring 

devices by Device/buffer memory batch monitor. 

For device test operation, refer to Section 3.10. 



 

3 - 22 

 
3.10 Device Test Operation 

Debug operation can forcibly turn ON/OFF bit devices (X, Y, M, L, B, and F) or forcibly 
change the current values of word devices (D, W, T, C, etc.). 
There are two methods of operations. One is double-clicking a device during ladder 
monitor and the other is using the device test dialog box. 
In this section, perform a device test of the program written to the programmable controller 
CPU in Section 3.5.  

 Set the "RUN/STOP/RESET" switch of the CPU to 
"RUN". 

 

Click!

 

 
Click  (monitoring mode) on the toolbar. 

 
(1)  Operation by double-clicking a device during ladder monitor. 

  Turning ON/OFF internal relay M100 or input X1.  

Shift + double-click!

 

Select M100 on the ladder monitor and 
double-click it with Shift pressed.  

(Alternatively, Shift+  keys) 
Select X1 on the ladder monitor and 
double-click it with Shift  pressed in the 
same way.  
(Alternatively, Shift+  keys) 

 
  Setting the current value of C0 to 990.  

(1) double-click!Shift +

 

 

1)  Select C0 on the ladder monitor and 
double-click it with Shift  pressed. 

(Alternatively,  key) 

 

2)  Select "Word [Signed]" from the "Data Type" 
list box. 

 
3)  Input "990" in the "Value" list box. 

9  9  0  
 
4)  After finishing the setting, click the Setting 

button to change the current value of C0 to 
990. 
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(2)  Operation on the Modify Value dialog box 

First, follow the procedure below to display the Modify Value dialog box. 
 

 

 

1)  Click the [Debug] → [Modify Value] menu. 

 

2)  The Modify Value dialog box is displayed. 

 
  Turning ON/OFF output Y75, internal relay M100, or input X1. 

 

 
 

1)  Specify the bit device to be turn ON/OFF in 
"Device/Label". (in the case of M100) 

 
M  1  0  0  

 
2)  Turn ON/OFF the specified bit device using 

the following buttons. 
 ON  : Forcibly turns ON the specified bit 

device. 
 OFF  : Forcibly turns OFF the specified 

bit device. 
 Switch ON/OFF  : Forcibly inverses 

ON/OFF status of the 
specified bit device. 
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  Setting the current value of Timer T1 to 100. 
 

 

1)  Specify the word device (T1) whose value is 
going to be changed in the "Device/Label" 
list. 

T  1  
 

2)  Select "Word [Signed]" from the "Data Type" 
list box. 
 

3)  Input "100" in the "Value". 
1  0  0  

 
4)  Click the  Set  button. 

 

POINT  

When the programmable controller CPU is in the RUN status, if a coil whose 
input signal of output condition is OFF is forcibly turned ON, the output of the coil 
turns ON only for a moment because priority is given to the execution of the 
program. 
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3.11 Online Program Change 

Change a program when the programmable controller CPU is in the RUN status. 
There are two types of methods for online program change as follows. 
 
 Online change (ladder mode) : Writes only the changed part of the program 
 Online change (files) : Writes programs and files such as device 

comments together. 

 

WARNING ● When data change, program change, or status control is performed from a 
personal computer to a running programmable controller, configure an 
interlock circuit outside the programmable controller system to ensure that 
the entire system will always operate safely. 
Furthermore, for the online operations performed from a personal computer 
to a programmable controller CPU, predetermine the system’s corrective 
actions in case of a communication error caused by poor cable connection, 
etc. 

 

CAUTION ● When performing online operations (program change while a programmable 
controller CPU is running, forced input/output operation, operating status 
changes such as RUN-STOP, and remote control operation) for the running 
programmable controller CPU from a personal computer, read the manual 
carefully and ensure sufficient safety before operation. 
When changing a program while a programmable controller CPU is RUN 
(online program change), a problem such as program corruption may occur 
depending on operating conditions. Fully understand the precautions 
described in this section before use. 

 

POINT  

Precautions for online program change 
 Parameters and programs on the CPU memory before change and ones on 

GX Works2 must match. 
 Up to 512 program steps can be written at a time in online program change. 
 For details of online program change, refer to Appendix 1. 

 

In this section, perform online change (ladder mode). 
Change the setting value of Timer T1 to 100 seconds as follows. 

 
 Set the "RUN/STOP" switch of the CPU to "RUN". 

(1) Click!  

 

(To the next page) 

 
(1)  Click  (monitor write mode) on the 

toolbar. 
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(From the previous page) 

 

 

 

 

(2)  Click the  OK  button. 

(3)　 Double-click!

 

 

(3)  Select T0 on the ladder monitor and 
double-click it. 

 

 

(4)  Change "K200" to "K1000". 

(5)　 Click!

 

 

(5)  After the change, click the 
[Conversion/Compilation] → [Conversion + 
Online Program Change] menu.  
(If "Change the optional online change setting 
to "Execute online change by Conversion 
(+Compilation)" is checked in step 2, online 
program change can be executed by the 
normal conversion process ([Conversion] → 
[Conversion] menu/Function key  F4 ).) 

 

 

(6)  A "Caution" message is displayed. Check 
and understand the description and click the 
 Yes  button. 

(7)  The message "Online program change is 
completed" is displayed. Click the  OK  
button. 

 

CAUTION  

If the program on the programmable controller CPU and that on GX Works2 
before modification do not match, online program change cannot be executed. 
When it is uncertain that they match, conduct verification, make modifications on 
GX Works2, and then perform online program change. 
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 Training machine operation 

When turning ON X2, T1 is increased to 1000. 

Digital HMI (Human Machine Interface)

0 0 0 0 0 0 0 0 MELSEC-Q

D/A OUTPUTA/D I NPUT

X3F X30 X2F X20

Y6F Y60 Y5F Y50 Y4F Y40

 
 

POINT  

Precautions for using rise, fall, or SCJ instruction 
(1) Fall instruction 

Even if the execution condition for a fall instruction in an online changed 
ladder *1 is not satisfied (in continuity state), the fall instruction is 
executed. 
For fall instructions, refer to the programming manual of QCPU. The 
following are examples of the instructions. 
Fall instruction: PLF, LDF, ANDF, ORF, MEF, FCALLP, EFCALLP, and 

XCALL 

ON/OFF status of contact 
(Continuity state at online change) 

Rise instruction Fall instruction 

OFF Not executed Executed 
ON Not executed Not executed 

*1:  When a new ladder block is inserted without changing existing 
programs, the added program is written together with the next ladder 
block to the programmable controller CPU. (If the next ladder block 
does not exist, the previous ladder block is written together.)  
Thus online program change may not be completed at a time 
depending on the number of program steps of the added program and 
the previous or next one. In this case, reduce the number of steps 
written at a time and perform online program change in several times. 

<Example> 

Programs added by pasting
and inserting a row

Programs on the left is also
written to the programmable
controller

 

(2) Rise instruction 
When writing is completed, even if the execution condition for a start-up 
execution instruction (PLS instruction / P instruction) is ON, the start-up 
execution instruction is not executed. 
When the execution condition turns OFF → ON again, the start-up 
execution instruction is executed. 

(3) SCJ instruction 
When writing is completed, if the execution condition for SCJ instruction is 
ON, the instruction executes a jump to the specified pointer without 
waiting for 1 scan. 
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3.12 PLC Verify Operation 

Compare and verify programs, parameters, device comments on the programmable 
controller CPU with data on GX Works2. 

 

(1)　 Click!

 

 

(1)  Click the [Online] → [Verify with PLC] menu. 

 

 

(2)  The Online Data Operation dialog box is 
displayed. Click Parameter + Program. 

 
(3)  Click the  Execute  button. 

 

 

(4)  The verification result is displayed.  
 
To check details of data, double-click the 
corresponding row. 

 

(5)  The detailed result is displayed. 

 



 

3 - 29 

 

3.13 Read from PLC Operation 

Read programs, parameters, device comments on the programmable controller CPU. 
 

(1)　 Click!

 

 

(1)  Click  on the toolbar or the [Online] → 
[Read from PLC] menu. 

 

 

(2)  Click to select the program and the parameter to 
be read on the "CPU module" tab.  
Alternatively, click "Parameter + Program".  
 
Also, select "Program/Device Memory" in 
"Target Memory". 

 
(3)  After finishing all selections, click  Execute . 
 

 

 

(4)  When the project is already under editing, a 
dialog box asks whether to save changes. 
Click  Yes . 

 

(5)  The dialog box showing the read progress is 
displayed. 

 
(6)  When the read is completed, the message 

"Completed" is displayed. Click the  
 Close  button. 
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3.14 Termination Operation of GX Works2 

 

(1)　 Click!

 

 

(1)  Click the [Project] → [Exit] menu. 

 
 
 

(If the ladder is not converted.) 

 
 
 
 

(If the project is not saved.) 

 

(2)  A confirmation dialog box is displayed. Click 
the  Yes  button.  
GX Works2 is terminated. 

 
 
 
 
 
The dialog box on the left will appear depending 
on the status of the project. 
 
 Yes ·················Exits GX Works2 without 

conversion. 
 No ··················Does not exit GX Works2. 
 
 
 
 Yes ·················Exits GX Works2 

after saving the project. 
 No ··················Exits GX Works2 

without saving the project. 
 Cancel ·············Does not exit GX Works2. 

 



 

3 - 31 

 
3.15 New Read from PLC Operation 

Newly read programs, parameters, device comments on the programmable controller 
CPU. 

 

(1) Click!

(3) Select!

(2) Select!

(5) Click!

(4) Select!

 

(1)  Click the [Start] button. 
 
(2)  Select the [All programs] menu. 
 
(3)  Select the [MELSOFT application] menu. 
 
(4)  Select the [GX Works2] menu. 
 
(5)  Click the [GX Works2] menu. 
 

Creating a shortcut of GX Works2 on the 
desktop will facilitate starting up GX 
Works2. 
 

(6) GX Works2 starts.

 

(6)  GX Works2 starts. 

(7)　Click!

 

 

(7)  Click the [Online] → [Read from PLC] menu. 

 

 

(To the next page) 

(8)  Select "QCPU (Q mode)" from the "PLC" list 
box. 

 
(9)  Click the  OK  button. 
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(From the previous page) 

 

 

 

 

(10) Check that settings in Transfer Setup are 
as follows. 

 
Personal computer side I/F : Serial (USB) 
PLC side I/F : CPU module 

QCPU (Q mode) 
Other Station Setting : No Specification 
 

(11) Click the  OK  button. 
 

 
 

 

(12) Click to select the program and the parameter to 
be read on the "CPU module" tab.  
Alternatively, click "Parameter + Program". 

 
(13) Click the  Execute  button. 

 

 

(To the next page) 

(14) The dialog box showing the read progress is 
displayed. 

 
(15) When the read is completed, the message 

"Completed" is displayed. Click the  
 Close  button. 
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(From the previous page) 

 

 

 

(16) Click the data read from "No Execution Type" 
in the project list to display the sequence 
program. 
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Chapter 4 Designing Maintenance Measures 

It is necessary to consider the maintenance in the design stages in order to achieve a 
design that is less susceptible to failure or accidents and is easily maintainable. 
 

4.1 Preliminary Actions to Implement Maintenance Measures 

(1) Adopt products with fewer failures 
To put it simply, products with high reliability should be used, but the following 
points should also be considered. 
1) Is the manufacturer reliable? 
2) Is it accredited by various national and international standards? 
3) Is the design simple? 
4) Does the product have good performance with low failure rate? 
5) Is the industry reputation good? 

 
(2) System design with good serviceability 

The following points may be considered to design a system that can be easily 
maintained. 
1) Adopt a programmable controller for which the parts and products are easily 

available. 
2) Adopt a programmable controller having high serviceability with 

self-diagnostics function, etc. 
3) Adopt a programmable controller in which the programs can be easily read, 

changed and stored. 
4) Design the system so as to automatically display the defects. 
5) Carry out the design in a space in which maintenance, inspection and repair 

work can be easily carried out. 
6) Design the system such that the parts replacement, product replacement, 

wiring change etc. can be carried out easily. 
 

(3) Copying sequence programs into ROM 
Running a sequence program stored in program memory is convenient and 
facilitates program changes. However, lightning surge noise, power supply failure, 
or others can cause loss of the program. 
To prevent the trouble, store them in standard ROM or a memory card (ATA/Flash 
ROM), which ensures safety. 
 

(4)  Backup of sequence programs 
Be sure to make backups of sequence programs in hard disk drives or CD-ROMs 
so that they can be easily written when the programmable controller fails and 
needs restoration.  
Describe the day, month and year and details of changes as a comment on a 
backup file. 
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4.2 Using Programmable Controller with High Serviceability 

MELSEC-Q has an excellent RAS function and self-diagnostics function. 
 

4.2.1 RAS Function 

RAS function is a generic term for the function improving [product reliability], 
[equipment availability] and [serviceability]. 

 
Table 4-1 RAS Function 

Name Meaning RAS function (other than self-diagnostics function) of 
programmable controller 

R Reliability Reliability of the 
hardware or 
system that relates 
to failures 

Because the required quality is realized during the 
design, production and quality assurance phases, 
the product is highly reliable and has a low failure 
rate 

A Availability Effectiveness or 
availability as 
equipment 

 A module can be replaced in a single operation 
 I/O module working during the power-on 
 Sampling trace function 
 Latch function 

S Serviceability Ease of service 
Function improving 
the availability of 
equipment 

 Remote PAUSE function 
 Multiple-user debug function 
 Monitor function by peripherals 

 
RAS concepts 

If the equipment fails for the first time in five years, R (reliability) can be deemed as 
high. 
On the other hand, if there is no spare part or it takes long because of a lack of 
experience in recovery, S (serviceability) is deemed as low, thus resulting in A 
(availability) being poor. 
Additionally, if the equipment sometimes fails, but can be recovered in a short time, R 
(Reliability) may be low, but S (serviceability) is high, causing A (availability) to be 
excellent. RAS function requires the three functions to be high in a balanced manner. 
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4.2.2 Self-Diagnostics Function 

(1)  Self-Detecting the Error Definition of the Programmable Controller 
Function that enables the programmable controller CPU to automatically detect an 
error occurring in the programmable controller and to turn on the predefined bit 
device (bit signal) or to store an error number in the word device (word signal). 

 
Table 4-2 Self-diagnostics Function 

Processing 
function 

Sample error items that can occur 

Displays the 
diagnostics result 
by turning ON or 
OFF bit signals  
 
Special relay 
(SM0 to SM1199) 

 Self-diagnostic error (indicates the total number of self-diagnostic errors)
 Operation error (indicates that an operation error occurred) 
 Battery voltage drop (warns that the battery for backing up the memory 

has low capacity now) 
 AC down detection (instantaneous power failure or voltage drop within 

the specified instantaneous power failure time) 
 I/O module verification error 

(The mounting status of the I/O module differs from that which was 
registered during the power-on) 

 Watchdog timer error 
(Program scan does not complete within the specified time, causing the 
operation to hang up) 

 Fuse blown detection (detects a fuse blown in the I/O module) 
Displays a code 
number for the 
diagnostics result 
using a numerical 
value (word data) 
 
Special register 
(SD0 to SD1431) 

 Fuse blown (I/O number of the output module where the fuse was blown)
 I/O module verification error 

(I/O number of a module whose the state differs from the mounted state 
when the power supply was turned on) 

 Number of AC power supply failures (number of instantaneous power 
failures or voltage drops of AC power supply) 

 Self-diagnostic error (number of the error when the self-diagnostics 
detects an error) 

 Error step (step number of a program that generated an operation error)

 
1) When a trouble occurs in the programmable controller, trouble contents can 

determined by using a peripheral to read the contents of the self diagnostics result. 
Take corrective actions according to the contents to shorten the recovery time. 

2) In the event an operation unexpectedly stops, etc., the power failure or voltage 
drop of AC power supply can be determined to be a cause if AC down detection is 
turned on. 

3) When contacting the manufacturer, informing them of the self diagnostics result 
(error number) would let them locate the cause faster. 
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(2) To display the list of error codes in GX Works2 
 

(1) Click!
 

 

1)  Select the [Help] → [GX Works2 Help] menu.

 

 

2)  The GX Works2 help is displayed. 
 
3)  Select "CPU Error Help" and choose your 

programmable controller CPU from the Help 
menu.  
In this case, double-click "Q series PLC (Q 
Mode)". 

 

 

4)  The error code list of the chosen 
programmable controller CPU is displayed.  
Double-click the error code whose description 
you want to check.  
In this case, double-click and select [Error 
Code 1000 to 1610] → [Error Code 1000 to 
1035] → [Error Code 1001 MAIN CPU 
DOWN]. 

 

5)  The system displays the details such as the 
cause and corrective action of the selected 
error code. 
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(3)  What are special relays and special registers? 
These are the devices whose applications are fixed in the programmable 
controller. 
They are used for error detection, CPU module operating status and special 
functions. 
(They can be applied or not depending on the CPU type.) 

 
[Sequence program of the application example] 

SM52

SM1

SM56

SM400

SM412

(Battery low) (1 second clock)

(Self-diagnostic error)

(Operation error)

(Always ON)

(Always ON)

Error
detection

Clock
function

K4Y40SD0BCD

K4Y50SD1010BCD

Y77 lamp flashing due
to CPU battery low

Outputs self-diagnosis error
code to the digital HMI
(Human Machine Interface)

Outputs the step number of
application instruction
operation error to the digital
HMI (Human Machine Interface)

Y77

X7
H0210

H4020

Clock data set request

X7

SM400

Clock data read request

Displays year (in 2-digit)
and month
Displays day and hour

Displays minute and second

Day 2 , Hour 10

Minute 40, Second 20

 

 

REMARKS  

 If the annunciator of the device for failure detection is turned ON, an error code 
"9000" is stored in SD0.  
Use a peripheral to read the error individual information and check the program 
of the numerical value (annunciator number). 

 The error diagnostics information is stored in the following devices: 
SD0 : Stores the diagnosed error code using a BIN code. 
SD1 to SD3 : Stores the date and time when the SD0 data was updated. 
SD4 : Stores the category codes that determine the description of the 

error information stored in the common information (SD5 to 
SD15) and the individual information (SD16 to SD26). 

SD5 to SD15 : Stores the following common information (either of the following 
"1)" to "5)") corresponding to the error code (SD0): 
1) Module number 4) Program error location 
2) File name/drive name 5) Cause of switching 
3) Time (setting value) 

SD16 to SD26 : Stores the following individual information (either of the 
following "1)" to "6)") corresponding to the error individual 
information (SD0): 
1) File name/drive name 4) Parameter number 
2) Time 5) Annunciator number/CHK 

(actual measurement value)   instruction failure number 
3) Program error location 6) Intelligent function module 

  parameter error 
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(4)  To display the list of special relays and special registers in GX Works2 

 

(1) Click!
 

 

1)  Select the [Help] → [GX Works2 Help] menu.

 

 

2)  The GX Works2 help is displayed. 
 
3)  Select "Special Relay/Register Help" and 

choose your programmable controller CPU 
from the Help menu.  
In this case, double-click and select the "Q 
series PLC (Q Mode)" menu. 

 

 

4)  The system displays the error code list of the 
special relays and special registers for the 
chosen programmable controller CPU.  
Double-click and select the device whose 
description required you want to check.  
In this case, double-click and select the 
[Special Relay (diagnostics information) 
[Number SM0 to SM165]] → [Number SM0 to 
16] → [Number SM0 Diagnostic errors]. 

 

5)  The system displays the detail of the selected 
special relay device. 
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4.3 Safety Design Using a Fail-safe Circuit 

WARNING 
● Configure a safety circuit outside the programmable controller so 

that the entire system can operate safely even when an external 
power supply error or a programmable controller failure occurs. 
Failure to do so may cause an incorrect output or malfunction, 
resulting in accidents. 
(1)  Configure safety circuits such as an emergency stop circuit, 

protection circuit, interlock circuit for opposite operations such 
as forward/reverse rotations or interlock circuit for machine 
damage protection such as upper/lower limits for positioning 
outside the programmable controller. 

(2)  When the programmable controller detects the following error 
status, it will stop operations and turn OFF all outputs in the 
case of (a).  
In the case of (b), it will hold or turn OFF all outputs according 
to the parameter setting. Note that the AnS series module will 
turn OFF the output in either case (a) or (b). 

 

 Q series modules AnS series modules 

(a) When overcurrent protection or 
overvoltage protection of the 
power supply module works 

Output OFF Output OFF 

(b) When the programmable controller 
CPU detects a watchdog timer 
error and the like in the 
self-diagnostics function  

All outputs will be 
retained or OFF, 

depending on 
parameter setting 

Output OFF 

 
When an error occurs at the I/O control part where the 
programmable controller CPU cannot detect, all outputs can 
be turned ON. Configure a fail-safe circuit or some 
mechanism outside the programmable controller so that the 
machine operates safely in such a case. 

(3)  Outputs may remain ON or OFF due to a failure of an output 
module relay or transistor. Configure an external circuit for 
monitoring output signals that may lead to a serious accident. 

●  Configure a safety circuit such as a fuse outside the output 
module because smoke or fire may result if a load current 
exceeding the rated current or an overcurrent caused by load 
short flows continuously for a long time. 

●  Configure a circuit so that an external power supply will be turned 
on after the start-up of the programmable controller. If the external 
power supply is turned on first, an incorrect output or malfunction 
may occur, resulting in accidents. 

●  For the operating status of each station during data link 
communication error, refer to each data link manual. Failure to do 
so may cause an incorrect output or malfunction, resulting in 
accidents. 
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WARNING 
● When controlling (changing data) the running programmable 

controller from a peripheral connected to the CPU module or from 
a personal computer connected to an intelligent function module, 
configure an interlock circuit in the sequence program to ensure 
that the entire system will always operate safely.  
For other operations (program modification, operating status 
change (status control)) to the running programmable controller, 
read relevant manuals carefully and ensure the safety before 
operation.  
Ensure the safety especially when controlling the remote 
programmable controller from eternal devices because trouble 
occurred on the programmable controller side may not be 
responded immediately due to data communication error.  
Along with configuring an interlock circuit in a sequence program, 
determine the system’s corrective actions to be taken between 
external devices and the programmable controller CPU in case of 
a data communication error. 

 

CAUTION 
● Do not bundle or adjacently place the control line or a 

communication cable with the main circuit or a power cable.  
Keep a distance of approximately 100 mm or more between them. 
Failure to do so may cause malfunction due to noise. 

●  When a device such as a lamp load, heater, or solenoid valve is 
controlled through an output module, a large current 
(approximately 10 times greater than normal) may flow when the 
output is turned OFF → ON. Take measures such as replacing the 
module with one having a sufficient current rating. 

 

Incorrect process outputs may occur temporarily due to a delay time and difference in 
rise time between the power supply to the programmable controller and the external 
power supply to the process (especially in DC) when the programmable controller is 
turned ON → OFF. 
For example, if the power supply to the programmable controller is turned on after the 
external power supply to the DC output module process is turned on, the DC output 
module may output instantaneously by mistake when the programmable controller is 
turned on. Therefore, it is necessary to configure a circuit so that the power is supplied 
to the programmable controller first. 
In addition, faulty operations may occur at the time of external power supply failure or 
programmable controller failure. 
Configure safety circuits (emergency stop circuit, protection circuit, interlock circuit, etc.) 
that may lead to machine damage or accidents due to faulty operations outside the 
programmable controller to prevent faulty operations from causing the entire system to 
operate faulty or from the fail safe aspect. 
The following page shows a system design circuit example based on points above. 
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(1)  System design circuit example (when the contact of the power supply moduleERR 

is not used) 

Start up SW

Stop SWMC

RA1
MC

RA2
RA2

XM

L
Ym

Yn

Output module

Output module

MC2

MC1

MC1

RA1

M10

Program

CPU module

NO

Transformer

Fuse

Transformer

Fuse

Power supply

Power supply

Transformer

Fuse

DC power
supply

Fuse

MC2

MC MC

Emergency stop or
stop at upper limit

Interlock circuit

Power-off output
equipment when stops

Emergency stop or
stop at upper limit

Power-off output
equipment when stops

Ym
SM52

SM52

SM403
SM403

TM
XM

MC1 NO M10
TM

MC1

MC2

Output module

MC

MC2

MC1

Output module

L

RA1

Ym

Yn

Input module

Start up SW

Stop SWMC

RA1
MC

Program

Alarm output
(Lamp or buzzer)

ON during RUN due
to SM403

Start/stop circuit

DC current
establishment
signal input

ON during RUN
due to SM403

Alarm output
(Lamp or buzzer)

A voltage relay is
recommended.

The time until DC
input signal is
established shall
be set to TM.

For AC/DCFor AC

CPU module

Ym

Yn

( -)( +)

MC

Yn

Can be started by
turning ON RA1, which
is the RUN output of
the programmable
controller

Configure an external
interlock circuit in a part
where opposite actions
such as forward/reverse
rotation is performed or
where damage or an
accident may occur.

Start up the power supply in the following procedure: 
 

 

For AC 
 
[1]  Turn "ON" the power. 
[2]  "RUN" CPU. 
[3]  Turn "ON" the start-up SW. 
[4]  Turn "ON" the electromagnetic contactor (MC) to drive the 

output equipment with a program. 

For AC/DC 
 
[1]  Turn "ON" the power. 
[2]  "RUN" CPU. 
[3]  Turn "ON" RA2 after the DC power supply on. 
[4]  Turn "ON" the timer (TM) after the DC power supply is 

completely on. (The setting value of the TM shall be 
the time between turning "ON" RA2 and the full 
establishment of the DC voltage. Configure the setting 
value to 0.5 second.) 

[5]  Turn "ON" the start-up SW. 
[6]  Turn "ON" the electromagnetic contactor (MC) to drive 

the output equipment with a program. (If a voltage relay 
is used for RA2, the timer (TM) in the program is not 
required.) 
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(2)  System design circuit example (when the contact of the power supply moduleERR 

is used) 

Start up
SW

Stop SWMC

RA1
MC

RA2
RA2

XM

L
Ym

Output module

Output module

MC2

MC1

MC1

RA3

M10
Program

CPU module

NO

Transformer

Fuse

Transformer

Fuse

Power supply

DC power
supply

Fuse

MC2

MC MC
Interlock circuit

Emergency stop or
stop at upper limit

Power-off output
equipment when the
ERR contact OFF

Ym
SM52

TM
XM

MC1 NO M10
TM

Start/stop circuit
Can be started by
turning ON RA1, which
is the RUN output of the
programmable
controller

DC current
establishment

OFF when a stop error
occurs due to ERR

Alarm output
(Lamp or buzzer)

A voltage relay is
recommended.

The time until DC input
signal is established
shall be set to TM.

For AC/DC

( -)( +)

ERR
Power supply module

Yn
SM403

RA3

RA1
Yn

Configure an external
interlock circuit in a
part where opposite
actions such as
forward/reverse
rotation is performed
or where damage or
an accident may occur.

 

Start up the power supply in the following procedure: 
 

For AC/DC 
 

[1]  Turn "ON" the power. 
[2]  "RUN" CPU. 
[3]  Turn "ON" RA2 after the DC power supply on. 
[4]  Turn "ON" the timer (TM) after the DC power supply is completely on. (The 

setting value of the TM shall be the time between turning "ON" RA2 and the 
full establishment of the DC voltage. Configure the setting value to 0.5 
second.) 

[5]  Turn "ON" the start-up SW. 
[6]  Turn "ON" the electromagnetic contactor (MC) to drive the output 

equipment with a program. (If a voltage relay is used for RA2, the timer 
(TM) in the program is not required.) 
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(2)  Fail safe measure against programmable controller failures 
Although failures of the programmable controller CPU and memory are detected 
by the self-diagnostics function, a failure may not be detected depending on the 
CPU when an error occurs at the I/O control part. etc. 
In such cases, depending on the failure status, it is expected that all outputs are 
turned ON or OFF or that the proper operations or safety of the controlled 
systems cannot be secured. 
Although Mitsubishi assures the best quality products, configure a fail-safe circuit 
outside in order to prevent machine damage and accidents when the 
programmable controller fails for some reason. 
The following illustrates a sample system and its fail safe circuit example: 
 
<Sample system> 

Power
supply
module

CPU
module

Input

16 points16 points 16 points 16 points 16 points

Output

16 points

Output

16 points

Output

16 points

16 pointsOutput
Output

EmptyY80

Y8F

Fail safe output
module*1

Power
supply
module

Input Input Input

 
 

*1:  Mount the output module for fail safe in the last slot of the system. (For 

the above system, the last slot shall contain Y80 to Y8F.) 
 
<Sample fail-safe circuit> 

Internal program

CPU module

On delay timer

External load

SM412

Y80

Y8F

Y81

24V

0V
24 V DC

T1 T2

MC

*2

Y80

Ｌ

Ｌ

T1

T2

1 s

1 s

0. 5 s 0. 5 s

Y80

Output module
*1

MC

On delay timer

 
Figure 4-3 Sample fail-safe circuit 1 

 
*1  Since Y80 is repeatedly turned ON and OFF every 0.5 second, use an output 

module (transistor in the example above) with no contact. 
 
*2  If off delay timers (especially, miniature timer) are difficult to obtain, use on delay 

timers as shown in the next page to configure a fail-safe circuit. 
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When configuring a fail-safe circuit using only delay timers 

CPU module

On delay timer

External load

Y80

Y8F

Y81

24V

0V

MC

*1

Y80

Ｌ

Ｌ

T2

1s

0. 5 s 0. 5 s

Output module

1 s

Internal program

SM412

M1

T2M2

M1

M2

T1

M1

24 V DC

MC

M2T1

Y80

On delay timer

 
Figure 4-4 Sample Fail-safe Circuit 2 

 
*1  Use a solid state relay for the M1 relay. 
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Chapter 5 Preventive Maintenance 

Preventive maintenance consists of daily maintenance and inspection and periodic 
maintenance and inspection. 
 

5.1 Necessity of Preventive Maintenance 

High availability of equipment cannot be ensured from occurrence of production 
system failure to its repair. 
Because preventing failures and equipment stop are top priorities, if reliable preventive 
maintenance is performed, prevention of catastrophic failures becomes possible, and 
recovery from failures will be quick. 
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5.2 Daily Maintenance and Inspection 

The following table shows items to be inspected daily to find risks in a production 
system in advance. 

 
Table 5-1 Daily Maintenance and Inspection 

Item Inspection item Inspection content Criterion Corrective action 

1
Mounting condition of 
base unit 

Check that mounting 
screws are not 
loosened and the 
cover is not detached.

They must certainly 
be fixed. 

Drive the screws in 

tight again. 

2
Mounting conditions of 
I/O modules, etc. 

Check that the 
modules are not likely 
to come off and 
module fixing hooks 
are surely locked. 

The module fixing 
hooks shall be surely 
locked and fixed. 

Be sure to lock the 

module fixing hooks.

Looseness of terminal 
screws 

They must not be 
loosened. 

Drive them in tight 
again. 

Proximity of solderless 
terminals 

They must be at an 
appropriate interval. 

Correct the interval. 3 Connection status 

Connector parts of 
cables 

The connectors shall 
not be loosened. 

Drive connector fixing 
screws in tight again.

Power supply 
"POWER" LED 

Check if it is ON 
ON 
(The LED is faulty if is 
OFF) 

Refer to Section 6.4 

CPU 
"RUN" LED 

Check if it is ON in 
"RUN" state 

ON 
(The LED is faulty if is 
OFF) 

CPU 
"ERR." LED 

Check if it is OFF 
OFF 
The LED is faulty if is 
ON or flashing 

CPU 
"BAT." LED 

Check if it is OFF 
OFF 
(The LED is faulty if is 
ON) 

Refer to section 6.5 

Input module 
Input status 
indicator LED 

Check whether it is 
ON or OFF. 

ON when input is ON. 
OFF when input is 
OFF. 
(The LED is faulty if it 
is in a state other than 
above) 

4

M
ai

n 
in

di
ca

to
r 

la
m

p 

Output module 
Output status 
indicator LED 

Check whether it is 
ON or OFF. 

ON when output is 
ON. 
OFF when output is 
OFF. 
(The LED is faulty if it 
is in a state other than 
above) 

Refer to Sections 6.6 
and 6.7 

5 Condensation 

Check the presence 

of water droplet and 

moisture. 

Not allowed. 
Remove the 

condensation. 
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5.3 Regular Maintenance and Inspection 

The following table shows items to be inspected once or twice a year to find risks in a 
production system in advance. 

 
Table 5-2 Regular Maintenance and Inspection 

Item Inspection item Inspection method Criterion Corrective action 
Ambient 
temperature 

0 to 55°C 

Ambient humidity 5 to 95%RH *1 1
E

nv
iro

nm
en

t 
Atmosphere 

Measure using 
thermo-hygrometers. 
Measure corrosive 
gases. No corrosive gases 

If a module is used 
inside a panel, the 
in-panel temperature 
must meet the criterion 
for the ambient 
temperature. 

85 to 132 V AC 

170 to 264 V AC 2
Power supply voltage 
check 

100/200 V AC, 24 V 
DC, Measure voltage 
between terminals 

15.6 to 31.2 V DC 

Change the supply 
power. 

Looseness and 
play 

Move the modules. 
They must firmly be 
fixed. 

Drive the screws in tight 
again. 
If the CPU module, the 
I/O module, or the 
power supply module is 
loosened, fix it with 
screws. 

3

M
ou

nt
in

g 
co

nd
iti

on
 

Adhesion of dirt 
and foreign 
matters 

Visual inspection 
There must be no 
adhesion of them. 

Remove and clean 

Looseness of 
terminal screws 

Retightening the 
screws using a 
screwdriver 

They must not be 
loosened. 

Drive the screws in tight 
again. 

Proximity of 
solderless 
terminals 

Visual inspection 
They must be at an 
appropriate interval. 

Correct the interval. 
4

C
on

ne
ct

io
n 

st
at

us
 

Looseness of 
connectors 

Visual inspection 
They must not be 
loosened. 

Drive connector fixing 
screws in tight again. 

5 Battery 

Check that SM51 or 
SM52 is OFF in the 
monitoring mode of GX 
Works2. 

(preventive 
maintenance) 

Replace a battery of 
which specified life is 
exceeded even if there 
is no indication of low 
battery capacity. 

6 Fuse 
Check that they are 
not blown with a blown 
fuse indicator LED. 

(preventive 
maintenance) 

Periodically replace 
them even if they are 
not blown because the 
elements are 
consumed by inrush 
current. 

7 Spare parts 
Attach them to the 
actual module and 
check the operation. 

They must work as the 
specifications. 

Use the parts that 
attached to the actual 
module as spare parts.

8
Checking stored 
programs 

Compare with the 
current programs. 

Must be the same. 
Correct if they are not 
the same. 

9
Fan (heat exchanger) 
filter 

Rotation status 
Rotation sound 
Clogging 

It must rotate without 
abnormal sound and 
not be clogged. 

Clean or replace it if 
there is a problem. 

10 Analog input/output 
Checking the 
offset/gain values 

Are they the same as 
the specifications 
(designed values)? 

Correct if they are not
the same. 

*1: 10 to 90% RH when a module for AnS series is used for the system. 
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5.4 Condition Monitoring-based Maintenance 

This design achieves maintenance in response to errors and failures by externally 
monitoring the condition of production system all the time and immediately reporting 
the occurrence of errors and failures.  
The following are examples of condition monitoring. 
 
(1)  Example of external display of error code numbers 

Connect a digital HMI (Human Machine Interface) to output modules of the 
programmable controller to display a code number on the HMI (Human Machine 
Interface) when an error code is detected. 

 

Output module (Y70 to Y8F)

Displays an error code number
on the digital indicator when an
error is detected

SM1

(Error detection)

Fault indicator lamp

Control panel

Error code

BCD SD0 K2Y70

0 0

Error code

3 2

(Error code)

Y80 Turns on the fault indicator
lamp when an error is detected

 

 
(2)  Example of displaying error code numbers on GOT screen 

Error report messages and error code numbers are displayed on a liquid crystal 
screen externally connected to the programmable controller. 
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5.5 Checking Operating Environment 

When equipment is changed, modified, added, or replaced, the following items must 
be checked because the usage environment may change. 

 
Table 5-3 Operating Environment 

Checkpoint Check timing 

Power supply voltage, 

voltage drop, 

instantaneous power failure, 

frequency fluctuation, 

waveform distortion, and 

harmonics 

When equipment is changed (especially when equipment which 

has large power consumption is installed) 

Noise and surge levels 
When high frequency equipment, large current equipment, or 

equipment which generates high noise is installed or connected 

Temperature When the environment changes 

Humidity When the environment changes 

Vibration and shock When equipment which generates them is installed 
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Chapter 6: Corrective Maintenance 

Electronic devices such as a programmable controller have fewer consumable parts 
and those to be deteriorated. However, it does not mean that troubles caused by 
failures and accidents can always be prevented even if preventive maintenance is 
not performed. When an unexpected reason causes failure and a production system 
stops, corrective maintenance will be performed. 
There are four types of troubles, and it is necessary to identify causes and take actions 
quickly.  

Table 6-1: Trouble Types 

Trouble type Description 
Hardware failure Error status continues due to reasons such as electronic component 

failure and pattern disconnection in a module circuit board. Repairing 
or replacing with a good one will fix it. 

Malfunction of a 
programmable 
controller system 

Error in CPU operation or input/output occurs due to causes such as 
noise, surge, voltage drop, instantaneous power failure, external radio 
wave, and static electricity. Identifying the cause and taking measures 
will restore it. 

Trouble due to an 
accident 

Due to an accident such as power supply short, load short, disconnection 
of signal wire, and faulty operation of a programmable controller main unit 
or peripherals. Repairing will restore it. 

Fault of a sequence 
program 

Due to reasons such as incorrect interlock setting and device number 
error. Revising it to a correct program will fix it. 

 
POINT  

For the life and preventive maintenance of a programmable controller CPU or a 
module, refer to Mitsubishi programmable controller TECHNICAL BULLETIN 
"MELSEC A/Q series, preventive maintenance of a programmable controller" 
(PLC-D-434). 
The TECHNICAL BULLETIN described above can be found at the Mitsubishi 
Electric FA Global Website. 
(Mitsubishi Electric FA Global Website: 
http://www.mitsubishielectric.co.jp/fa/index.html) 

 
6.1 Important Points in Corrective Maintenance 

In corrective maintenance, error is discovered by troubleshooting, and then its cause 
is identified and repaired. The important points and advance preparations of the 
corrective maintenance are described below.  
(1)  Important points  

1)  Read error codes self-detected by the programmable controller or each module. 
If the error code is identified, the cause can be estimated from the list of error codes. 

2)  Understand the real cause of the failure. 
Assume it was restored normally after replacing the module suspected to be 
the cause with a good one. To determine whether the module is the real 
cause or not, put it back to the previous state. If the trouble occurs again, the 
executed action is confirmed to be correct.  
In the case that the trouble does not occur, however, the module before the 
replacement was good and the real cause lies somewhere else. 

3)  Save the status when the error occurs. 
With GX Works2, the status can be read and stored to a personal computer 
when an error occurs.  
The cause of the error can be analyzed later using the stored information.  
The following information can be read:  
• Device   • Buffer memory 
• System configuration  • Link memory 

4)  Minimize the stop time of the production system. 
Long stop time results in larger production loss and bad serviceability. 

5)  Resume operation carefully while restoration. 
When the operation is resumed, it is necessary to provide sufficient safety 
confirmation in order to prevent accidents. 
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(2)  Advance preparation 
 

1)  Understand the target equipment and machines well. 
Receiving enough explanations during test operation and reading manuals 
for deeper understanding is important. 

2)  Get to know well about the programmable controller and the related equipment. 
It is important to improve product knowledge on a regular basis, for example, 
attending manufacturer's training school.  
(For information about a programmable controller, refer to the Mitsubishi 
Electric FA Global Website. 
(http://www.mitsubishielectric.co.jp/fa/index.html)) 

3)  Get used to peripheral operation. 
It is important to get used to peripheral operation on a regular basis, for 
example, attending manufacturer's training school. 

4)  Understand the status immediately before the accident. 
It is important to carry out periodic inspection frequently in order to always 
understand the operating status of the target equipment and machines. 

5)  Understand the causes and measures well. 
It is important to learn background information in advance, for example, reading 
the "Causes and measures" of instruction manuals and attending 
manufacturer's training school. 
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6.2 Operation to Read Error Codes Using GX Works2 

Current error status or error history can be displayed using the PLC diagnostic 
function and the system monitor of GX Works2. 
In this example, an error is raised intentionally so that an operation to find the cause 
can be performed using GX Works2. 
 
(1)  PLC diagnostics function 

This function monitors the error status of the CPU. 
(Actual machine operation) 

Front

Side of the CPU module

Battery holder

Battery connector

Battery

 
1)  Power-off the programmable controller 

CPU and open the battery holder. 
 
2)  Disconnect the battery connector. 
 
3)  Close the battery holder and power-on 

the programmable controller CPU. 

 
 

(5) Click!

 

 

4)  Click the [Diagnostics] → [PLC 
Diagnostics] menu. 

 

5)  The PLC diagnostics dialog box is 
displayed.  
Make sure that "1600 BATTERY 
ERROR" is displayed in the Current 
Error. 

 
6)  Click the  Error Help  button. 
 

Error details are displayed. Operate as 
described in Section 4.2.2 in order to 
check the error description of the error 
code 1600. 
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POINT  

When a current error is double-clicked in the error display area, the content of SD5 
to 15 (common error information) and SD16 to 26 (error individual information) of 
the programmable controller CPU is displayed in the error details dialog box. 
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(2) System monitor 

The error status of the entire system can be monitored. 

Errors diagnosed by the module are displayed as well as ones diagnosed by the 

CPU. 
 

(a) Writing a test project 

To raise an error in the D/A converter module (Q62DAN), open the 

following project and write it to the CPU. 

 

Project name System monitor 
 

CH1 enabled, CH2 disabled setting

Operating condition setting completed

CH1 output enabled

CH1 DA conversion data writing

 
 

(b) Error confirmation 

Operate the training machine to raise an error. 

1)  Turn ON X2. 

2)  Set "9999" in the digital switch (X20 to X2F) and turn ON X3. 

3)  The ERROR lamp of the Q62DAN turns on. 
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(c) Launching the system monitor 

 

(1) Click!

 

 

1)  Click the [Diagnostics] → [System 
Monitor] menu. 

 

 

(To the next page) 

2)  The system monitor screen is displayed. 
The system status is displayed as 
follows: 

 
a)  Base information list:  

The status of each base unit/block is 
displayed. 

b)  Module information list:  
The module information on the 
base unit or in the block to which 
the selected module is attached is 
displayed. 

c)  Legend:  
The legend of screen icons is 
displayed. 

 
3) Select the Q62DAN. 

 
4) Click the detailed information button. 
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(From the previous page) 

 

 

 
 
 
 
5) The module detailed information screen 

is displayed.  
This shows the information on 
"Q62DAN". 

 
6) On the "Error Information", check the 

error code that has been occurred.  
 
On the module detailed information 
screen, the error code stored in the 
buffer memory address of the D/A 
converter module is displayed. 

 
7) Set the "Display Format" of the error 

code to "Decimal". 
 
8) Click the error history update button to 

display the "Error description/handling". 
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REMARKS  

The system monitor allows the following system statuses can be monitored: 

 

 
1)  The error status of the module is displayed with icons.  

The legend of icons can be found here. 
 

2) Diagnostics button 
The status and the setup content of 
the module indicated by the cursor 
can be changed. 
This will not be displayed if the 
utility package has not been 
installed. 
For the detailed description, refer to 
each utility manual. 

 

 
3)  Product Information List button 

The product information list of the 
module installed on the base is 
displayed. 
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(3)  Diagnosing network status 

GX Works2 can diagnose the network module and the line status of the network. 

The list of the network diagnostic functions is described below. 

 

Network type Function list 

1)  Network diagnostics 
Click the [Diagnostics] → [CC IE Control Diagnostics]/[CC IE Field Diagnostics]/[MELSECNET Diagnostics] 
menu to display.  
This provides the network status of MELSECNET/10, MELSECNET/H, and CC-Link IE, as well as the 
execution of various tests. 

<CC IE control diagnostics> 

 

MELSECNET/10 
MELSECNET/H 

CC-Link IE 

 Module change 
Changes the module to be diagnosed. 

 Selected station change 
Click this after inputting a station number to the 
"Selected Station" so that the selected station is 
changed to the station specified by the number. 
The status of the selected station is displayed in the 
"Display field of network device status on the 
selected station". 

 Previous screen ▲/Next screen ▼ 
Switches the network information screen when the 
total number of stations is 61 or more. 

 Communication test 
Checks the communication route from the 
connection station to the communication 
destination specified station. 

 IP communication test (available for universal model 
only) 
Checks the IP communication route from the 
connection station to the communication destination 
station. 

 Link start/stop 
Starts/stops data link for the specified station. 

 Logging 
Monitors the communication route switching 
information and the transient transmission errors of 
the connection station. The monitored information 
can be saved in a file. 

 System monitor 
Checks the system status of the selected station. 

 Remote operation 
Performs remote operation for the programmable 
controller CPU of the selected station. 
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Network type Function list 

<CC IE field diagnostics> 

 

 Module change 
Changes the module to be diagnosed. 

 Disconnected station deletion 
Deletes disconnected stations from the network map.

 Legend display 
Displays the legend of icons on the diagnostics 
screen. 

 Communication test 
Checks the communication route from the connection 
station to the communication destination specified 
station. 

 IP communication test (available for universal model 
only) 
Checks the IP communication route from the 
connection station to the communication destination 
station. 

 Cable test 
Tests the connection status of the cable. 

 Link start/stop 
Starts/stops data link for the specified station. 

 Network event history 
Displays the event history and various network 
information that occur on the host station or the 
network. 

 Temporary clear/cancel of a reserved station 
Clears/cancels a reserved station temporarily. 

 Temporary error invalid station setting/clear 
Sets/cancels a temporary error invalid station. 

 System monitor 
Checks the system status of the selected station. 

 System error history 
Checks the system status of the selected station. 

 Remote operation 
Performs remote operation for the programmable 
controller CPU of the selected station. 

<MELSECNET diagnostics> 

 

MELSECNET/10 
MELSECNET/H 

CC-Link IE 

 Network test 
Tests link status, starting/stopping a link for the 
network. 

 Loop test 
Checks network loop status. 

 Setup confirmation test 
Checks the setup contents of the station number, the 
network number, and the group number of each 
station. 

 Station order setting test 
Checks the forward/reverse loop station order of the 
network. 

 Communication test 
Performs communication test between networks. 

 Error history monitor 
Displays error history of the network. 

 Network monitor details 
Displays detailed network line status of the 
network. 

 Other station information 
Monitors other stations connected to the network. 
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Network type Function list 

2)  CC-Link/CC-Link/LT diagnostics 
Click the [Diagnostics] → [CC-Link/CC-Link/LT Diagnostics] menu to display. 
This function monitors the network information of each station, as well as diagnoses and tests the network 
status. 
The CC-Link and CC-Link/LT diagnostic function can be executed only when the programmable controller 
CPU is directly connected. 

 

CC-Link 

 Network test 
Starts/stops data link for a CC-Link module specified 
by target module specification (all stations 
specification). 

 Line test 
Performs a test with all stations specification or of a 
specified station. 
This function is effective only when a master station 
is specified in transfer setup. 

 Other station monitor 
Monitors CC-Link's other station line connected to 
the programmable controller CPU. 
This function can be executed only during data link.

3)  Ethernet diagnostics 
Click the [Diagnostics] → [Ethernet Diagnostics] menu to display. 
It checks the various setting status of the Ethernet module. 

 

Ethernet 

 Parameter status 
Monitors the parameter status of the 
Ethernet module. 

 Error history 
Monitors the error log area. 

 ・Status for each connection 

Monitors status for each connection. 
 Status for each protocol 

Monitors status for each protocol. 
 LED status 

Monitors the LED lighting status in front 
of the Ethernet module. 

 Received e-mail information 
Monitors received e-mail information. 

 Sent e-mail information 
Monitors sent e-mail information. 

 PING test 
Tests and checks the existence of a 
specified IP address or an Ethernet 
module on the Ethernet line whose initial 
processing has ended. 

 Loopback test 
Checks whether each module has 
ended initial processing or not, 
sequentially sending loopback test 
transmission to the Q-compatible E71 
whose network number and station 
number are specified. 
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6.3 Basic Practice of Troubleshooting 

The following items are the basic contents that must be kept in mind during 
troubleshooting. 

 
(1) Visual check 

1) Determine whether the cause of the trouble lies inside of the programmable 
controller or lies in an external controlled system.  
(Note that usually this cannot be determined only by visual check.) 

2) Watch the operating status of the machine, and take notes of it. 
 

 In which process of the controlled system does the trouble occur? 
 Is the controlled system in operation or stopped? 
 What is the type of the stop? Is that overrunning, disorder, fire, human 

error, or other types? 

 
3)  Watch the I/O module and the intelligent function module, and take notes of 

their status. 
 

 How is the wiring status of each module? 
 How is the setting switch status of each module? 

 
4) Watch the LED status of each module, and take notes of it. 

 
 Is the "POWER" LED of the power supply module on or off? 

 
 Is the "MODE" LED of the CPU module on, off, or flashing? 
 Is the "RUN" LED of the CPU module on, off, or flashing? 
 Is the "ERR." LED of the CPU module on, off, or flashing? 
 Are the "USER", "BAT.", and "BOOT" LEDs of the CPU module on or 

off? 

 
 Is the monitor LED of the I/O module on or off? 

 
 Is the monitor LED of the intelligent function module on or off? 

 
(2)  Checking an error number by reading the error code 

1)  Read the error code of the CPU and the error code of each module using GX 
Works2. 

2)  Use the error code that was read in order to check the cause of the error and 
the corrective action. 

 
(3)  Observation of the fault after resetting the CPU 

If it goes back to the normal operation after resetting the CPU, the cause may be 
noise or temporary fault in the CPU, I/O module, electrical connection part, 
external devices, etc. 
1)  Set the RUN/STOP/RESET switch to [STOP]. 
2)  Reset using the RUN/STOP/RESET switch. 
3)  Turn the power OFF and ON again. 

 
(4)  Troubleshooting for each module 

1)  Troubleshoot the power supply module. 
2)  Troubleshoot the CPU module. 
3)  Troubleshoot the input module. 
4)  Troubleshoot the output module. 
5)  Troubleshoot the intelligent function module. 
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(5)  Narrowing the range of the failure cause 

1)  Replace the programmable controller module with a spare module to check 
whether the trouble occurs again. 

2)  Disconnect a ground cable and a control line for a test. 
 
(6)  Fault investigation for the failure module 

1)  Take notes of the product's serial number and function version.  
The serial number and the function version can be checked on the rating 
plate or in the system monitor of GX Works2. 
 Check by the rating plate 

MADE IN JAPAN

80M1 IND. CONT. EQ.

MODEL

SERIAL Function version

-Q

05032 0000000000 C

Serial number

 

 Check by the system monitor (product information list) of GX Works2 
Display the system monitor screen using the [Diagnostics] - [System 
Monitor] menu, then click the product information list button to display the 
product information list.  
The serial number and the function version of the CPU or the intelligent 
function module can be checked on the product information list. 

 

Clicking the CSV file creation button shows the [Save as] screen. Specify a file 
name here. 
The file can be opened using software such as Excel. 
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2) Save the device status during an error.  

Read the status of the device, link memory, and buffer memory during an 
error from the programmable controller CPU and save them. 

 
 Procedure for reading device status using GX Works2 (read from PLC) 

Click the [Online] - [Read from PLC] menu, and read the device status on 
the read from PLC screen. 

 

 
 

 
3)  Fill out a [Programmable Controller Fault Investigation Report] (refer to 

Appendix 6), and send the faulty module to the manufacturer with the report 
to have them investigate the cause of the failure.  
(The programmable controller fault investigation report is in Appendix. Copy 
and use it.) 

4)  Carry out sufficient measures for investigation results returned from the 
manufacturer. 
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6.4 Troubleshooting for the Power Supply Module 

There are two types of troubles regarding the power supply module: a case in which 
a type of the power supply module was selected incorrectly, and a case in which the 
POWER LED does not turn on. 

 
Power 
supply 

5 V DC output 
current 

         

Q61P 6 A          

Q62P 3 A   Main base 
5 V DC current 
consumption 

  CPU 
5 V DC current 
consumption  

Q63P 6 A   Q33B 0.105 A   Q00UJCPU 0.37 A  

Q64PN 8.5 A   Q35B 0.110 A (0.074 A)*1   
Q00UCPU, 
Q01UCPU 

0.33 A  

Q61SP 2 A   Q38B 0.114 A (0.077 A)*1   Q02UCPU 0.23 A  
    Q312B 0.121 A (0.087 A)*1   Q03UD(E)CPU 0.33 A  
    Q32SB   Q04UD(E)HCPU  
    Q33SB 

0.086 A 
  Q06UD(E)HCPU  

    Q35SB 0.091 A   Q13UD(E)HCPU  
        Q20UD(E)HCPU  
    Extension base (power supply module unmountable)   Q26UD(E)HCPU 

0.39 A 

 
CPU (power supply integrated type)   Q52B 0.080 A   Q50UDEHCPU  

Q00JCPU 0.22 A*2   Q55B 0.100 A   Q100UDEHCPU 
0.50 A 

 
           
           
    Extension base (power supply module mountable)   Input module  
    Q63B 0.105 A   QX10  
    Q65B 0.110 A (0.081 A)*1   QX28  
    Q68B 0.114 A (0.087 A)*1   QX40 

0.05 A 

 
    Q612B 0.121 A (0.098 A)*1   QX40-S1 0.06 A  

For 
QA1S65B 

      QX41  

and 
QA1S68B 

5 V DC rated 

output current       QX41-S1 
0.075 A 

 

A1S61PN 5 A   
Extension base (power supply module 

mountable, AnS series) 
  QX42  

A1S62PN 3 A   
For mounting an input, output, and special 

function module 
  QX42-S1 

0.09 A 
 

A1S63P 5 A   QA1S65B 0.117 A (0.088 A)*1   QX70 0.055 A  
    QA1S68B 0.118 A (0.091 A)*1   QX71 0.07 A  
        QX72 0.085 A  
      QX80 0.05 A  
      QX81 0.075 A  
      QX82  
    

For an AnS series input, output, and special 
function module available for the QCPU, refer 
to the user's manual of each CPU. 

  QX82-S1 
0.09 A 

 
           
           
*1: Values for a non CE compatible product are given in (  ).   Output module  
*2: Total value of the CPU and the base unit.   QY10 0.43 A  
        QY18A 0.24 A  
        QY22 0.25 A  
        QY40P 0.065 A  
        QY41P 0.105 A  
        QY42P 0.15 A  
        QY50 0.08 A  
        QY68A 0.11 A  
        QY70 0.095 A  
        QY71 0.15 A  
        QY80 0.08 A  
        QY81P 0.095 A  
           
           
        I/O combined module  
        QH42P 0.13 A  
        QX48Y57 0.08 A  
           
           
        Interrupt module  
        QI60 0.06 A  
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6.4.1 Selection of a Power Supply Module 

If 5 V DC supply capacity is insufficient because the power supply module was 
selected incorrectly, devices such as an I/O module and an intelligent function 
module may malfunction. 
Therefore, it is necessary to select a power supply module whose output current is 
larger than the total current consumption of connected modules. 

 
(1)  5 V DC current consumption of major modules 

 

         
   Intelligent function module 
   Q64AD 0.63 A QD35ID1 0.40 A 
   Q68ADV 

ID interface 
QD35ID2 0.42 A 

   Q68ADI 
0.64 A 

Web server QJ71WS96 0.65 A 
   Q64AD-GH 0.89 A QJ71E71-B5 0.50 A 

   

A/D conversion 

Q62AD-DGH 0.22 A QJ71E71-B2 0.60 A
*1

 
   Q62DA 0.33 A 

Ethernet 

QJ71E71-100 0.50 A 
   Q64DA 0.34 A QJ71BR11 0.75 A 
   Q68DAV 0.39 A QJ71LP21-25 
   Q68DAI 0.38 A QJ71LP21G 

0.55 A 

   

D/A conversion 

Q62DA-FG 0.37 A QJ72BR15 1.10 A 
   Q64TDV-GH QJ72LP25-25 
   Q64TD 

0.50 A 

MELSECNET/H 

QJ72LP25G 
0.89 A 

   Q64RD 0.60 A QJ71FL71-F01 0.50 A 

   

Temperature input 

Q64RD-G 0.62 A 
FL-net QJ71FL71-B2-F0

1 
0.70 A 

   Q64TCTT 0.55 A CC-Link QJ61BT11 0.46 A 
   Q64TCTTBW 0.60 A CC-Link/LT QJ61CL12 0.13 A 
   Q64TCRT 0.55 A AS-i QJ71AS92 0.40 A 
   

Temperature control 

Q64TCRTBW 0.60 A QJ71C24N 0.31 A 
   QD62 0.30 A 

Serial 
communication QJ71C24N-R2 0.26 A 

   QD62D 0.38 A Modem I/F QJ71CMO 0.46 A 
   

High-speed counter 
QD62E 0.33 A Intelligent QD51 0.26 A 

   Pulse input QD60P8-G 0.58 A communication QD51-R24 0.31 A 

   QD75P1 0.40 A 
*1:  For internal current consumption (5VDC) whose the first 

five digits of the serial number are 04091 or earlier, 
   QD75P2 0.46 A internal current consumption (5 V DC) is 0.70 A. 
   QD75P4 0.58 A    
   QD75D1 0.52 A    
   QD75D2 0.56 A    
   QD75D4 0.82 A    
   QD75M1    
   QD75M2    
   QD75M4 

0.40 A 
   

   QD70P4 0.55 A    
   

Positioning 

QD70P8 0.74 A    
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(2)  Criteria for use of an extension base requiring no power supply module 
In the Q52B/Q55B (hereafter, the Q5B), a voltage drop occurs at an extension 
cable because a power supply module on a main base unit supplies 5 V DC. 
If the "IN" connector of the Q5B does not supply a specified voltage (4.75 V 
DC or more), incorrect input or incorrect output may occur. 
When using the Q5B, make sure that the voltage is 4.75 V DC or more at the 
"IN" connector of the Q5B. 
When using the Q5B, it is recommended to use an extension cable as short 
as possible for connection just after the main base unit because of a voltage 
drop. 

 

(a)  When only the Q5B is connected to an extension base unit 
The 5 V DC output voltage minimum value of the power supply module on 
the main base unit is set to 4.90 V DC. Therefore, if a voltage drop due to 
an extension cable is 0.15 V (4.9 V - 4.75 V = 0.15 V) or less, the Q5B is 
usable. 

 

Extension cable 
model 

Extension cable 
conductor 

resistance value 
(Ω) 

QC05B 0.044 
QC06B 0.051 
QC12B 0.082 
QC30B 0.172 
QC50B 0.273 

QC100B 0.530 

First extension

Second extension

Seventh extension

V1

V2

V7

R1

R2

R7

Main base unit

Power
supply
module

（Q3□B）

Extension base unit（Q5□B）

Extension base unit（Q5□B）

Extension base unit（Q5□B）

I1

I2

I7

 

  

Symbol Description 
V1 The voltage drop of the extension cable between the main base unit and the extension base unit 

Vn 
The voltage drop of the extension cable between the extension base unit ((n-1)th extension) and the extension base unit (nth 
extension) 

R1 The cable resistance between the main base unit and the extension base unit 
Rn The cable resistance between the extension base unit ((n-1)th extension) and the extension base unit (nth extension) 
I1 to I7 5 V DC current consumption in the first to seventh extension *1 
*1:  I1 to I7, which is the current consumption of the Q5B + the total current consumption of the I/O modules and intelligent function 

modules mounted to the Q5B, varies depending on modules mounted to the extension base unit. Refer to the user's manual for 
the value of each module. 

 

Calculation list of a voltage drop by an extension cable in first to seventh extension system configuration 
Voltage drop by an extension cable for each extension base number Q5B 

mount 
position V1 V2 V3 V4 V5 V6 V7 

Total voltage drop to the 
Q5B "IN" connector 
(V) 

1st 
extension 

R1･I1 － － － － － － V = V1 

2nd 
extension 

R1(I1 + I2) R2･I2 － － － － － V = V1 + V2 

3rd 
extension 

R1(I1 + I2 + 
I3) 

R2(I2 + I3) R3･I3 － － － － V = V1 + V2 + V3 

4th 
extension 

R1(I1 + I2 + 
I3 + I4) 

R2(I2 + I3 + 
I4) 

R3(I3 + I4) R4･I4 － － － V = V1 + V2 + V3 + V4

5th 
extension 

R1(I1 + I2 + 
I3 + I4 + I5) 

R2(I2 + I3 + 
I4 + I5) 

R3(I3 + I4 + 
I5) 

R4(I4 + I5) R5･I5 － － 
V = V1 + V2 + V3 + V4 
+ V5 

6th 
extension 

R1(I1 + I2 + 
I3 + I4 + I5 + 
I6) 

R2(I2 + I3 + 
I4 + I5 + I6) 

R3(I3 + I4 + 
I5 + I6) 

R4(I4 + I5 +
I6) 

R5(I5 + I6) R6･I6 － 
V = V1 + V2 + V3 + V4 
+ V5 + V6 

7th 
extension 

R1(I1 + I2 + 
I3 + I4 + I5 + 
I6 + I7) 

R2(I2 + I3 + 
I4 + I5 + I6 + 
I7) 

R3(I3 + I4 + 
I5 + I6 + I7) 

R4(I4 + I5 +
I6 + I7) 

R5(I5 + I6 +
I7) 

R6(I6 + I7) R7･I7 
V = V1 + V2 + V3 + V4 
+ V5 + V6 + V7 
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(b)  When the Q6B is connected between the Q3B and the Q5B 
 

[When the Q5B is connected at the second extension] 
Extension cable 

model 

Extension cable 
conductor 

resistance value 
(Ω) 

QC05B 0.044 
QC06B 0.051 
QC12B 0.082 
QC30B 0.172 
QC50B 0.273 

QC100B 0.530 
First extension

Second extension

V

R1

Main base unit（Q3□B）

Extension base unit（Q6□B）

Extension base unit（Q5□B）

I1

Power
supply
module

Power
supply
module

 

  

Symbol Description 
V The voltage drop by an extension cable between the main base unit and the extension base unit (Q5B) 

In 

The 5 V DC current consumption when the Q5B is used at the (n+1)th extension, where n = 1 to 6 (n: number of 
extension bases of the Q6B) 
(The current consumption of the Q5B + the total current consumption of the I/O modules and intelligent function modules 
mounted to the Q5B) 

Rn 
Extension cable resistance value between the main base unit or an extension base unit (Q6B) and another extension 
base unit (Q6B) 

Rn+1 Extension cable resistance value between the extension base unit (Q6B) and the extension base unit (Q5B) 

 
Calculation list of a voltage drop by an extension cable when the Q6B is connected 

between the Q3B and the Q5B 
 

Mount position of the extension base unit 
Q6B Q5B 

Voltage drop by an extension cable from the main base 
unit and the IN connector of the Q5B (V) 

1st extension 2nd extension V = (R1 ＋ R2)I1 
1st and 2nd extension 3rd extension V = (R1 ＋ R2 ＋ R3)I1 
1st to 3rd extension Fourth extension V = (R1 ＋ R2 ＋ R3 ＋ R4)I1 
1st to 4th extension 5th extension V = (R1 ＋ R2 ＋ R3 ＋ R4 ＋ R5)I1 
1st to 5th extension 6th extension V = (R1 ＋ R2 ＋ R3 ＋ R4 ＋ R5 ＋ R6)I1 
1st to 6th extension 7th extension V = (R1 ＋ R2 ＋ R3 ＋ R4 ＋ R5 ＋ R6 ＋ R7)I1

 
 

POINT  

 An I/O module and an intelligent function module, which have large internal 
current consumption (internal current consumption (5VDC)), must be mounted to 
the main base unit or an extension base that requires power supply module 
(Q63B, Q65B, Q68B, and Q612B) in order to use. 

 Overall cable distance of an extension cable must be 13.2 m or less. 
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(3)  24 V DC current consumption for each module 
The 24 V DC output current capacity of the power supply module and the 24 V 
DC current consumption of each module are described below. Refer to the 
values below, and when insufficient, use an external DC stabilized power 
supply. 
 

 
Power supply 
module 

24 V DC output 
current 

 
 

  

Q62P 0.6 A     

   
 

Output module 
24 V DC current 
consumption 

    QY40P 0.01 A 
    QY41P 0.02 A 
    QY42P 0.04 A 
    QY50 0.02 A 
    QY70 0.09 A 
    QY71 0.17 A 
    QY80 0.02 A 
    

Transistor output 

QY81P 0.04 A 
      
      

   
 

Intelligent function module 
24 V DC current 
consumption 

    A/D conversion Q62AD-DGH 0.36 A 
    Q62DA 0.12 A 
    Q64DA 0.18 A 
    Q68DAV 0.19 A 
    Q68DAI 0.28 A 
    

D/A conversion 

Q62DA-FG 0.30 A 
    QD62 
    QD62E 
    

High-speed counter
QD62D 

0.008 A 

    QD70P4 0.065 A 
    

Positioning 
QD70P8 0.12 A 

    QD35ID1 0.17 A 
    

I/D interface 
QD35ID2 0.33 A 
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(4)  Power supply module selection example 
When the sum of the connected modules described below is 5 V DC 2.399 A 
and 24 V DC 0.48 A, the Q62P (5 V DC 3 A output and 24 V DC 0.6 A output) 
must be selected. 
If an external stabilized power supply is designed to provide 24 V DC, the Q61P 
(5 V DC 6 A output) is also acceptable. 

 
 Base unit          
  

Q 
3 
8 
B 

 
Q 
6 
2 
P 
 

 
Q 
0 
6 
U 
D 
H 
 

 
Q 
X 
4 
1 

 
Q 
X 
8 
0 

 
Q 
X 
8 
0 

 
Q 
Y 
4 
2 
P 

 
Q 
Y 
4 
2 
P 

 
Q 
6 
2 
D 
A 

 
Q 
6 
8 
D 
A 
I 

 
Q 
J 
6 
1 
B 
T 
1 
1 
 

            
5 V DC current consumption 0.114 － 0.64 0.075 0.05 0.05 0.15 0.15 0.33 0.38 0.46 
24 V DC current consumption － － － － － － 0.04 0.04 0.12 0.28 － 
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6.4.2 When the "POWER" LED Turns Off 

The flow chart below shows causes and measures in the case that the "POWER" 
LED turns off at power-on or during operation. 
 

The "POWER" LED turns off

Is the power supplied?

　

　

End　

NO

YES
NO YES

YES
NO YES

NO

YES
NO YES

NO

NO

NO YES

YES

Is power supply voltage
within the specified

voltage range?

Is the power supply
module fixed?

Is overcurrent
protection or

overvoltage protection
working?

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Supply the power

Does the "POWER"
LED turn on?

Control the supply voltage to be within the rated range

Securely fix the power supply module

Does the "POWER"
LED turn on?

Does the "POWER"
LED turn on?

Does the "POWER"
LED turn on?

Check the current capacity.
Suppress the overcurrent.
Turn OFF the input power supply
then on again after several minutes.

(1)

(2)
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6.4.3 When the ERR Terminal (Negative Logic) Turns OFF (Opens) 

The flow chart below shows causes and measures in the case that the "ERR 
terminal" of the power supply module turns OFF (opens) at power-on or during 
operation. 

 

YES

・Is the power supplied?
・Is the voltage of the
supply power proper?

Not flashing

NO

The ERR terminal turns OFF (opens)

The "ERR" LED of the
CPU module is...

Flashing (CPU
module is in stop
error)

Hardware failure
Perform operation check one by one,
starting from the minimum
configuration system.
For a module that does not work,
explain the fault symptoms and
consult with the nearest system
service, distributor or branch office.

Check the error details and take
measures according to them

Supply the power with a proper voltage

 
 

 Detectable error definitions at the ERR terminal 
Detectable error definitions at the ERR terminal of a power supply module are 
described below. 

 
1) When a power supply module is the Q61P-A1, Q61P-A2, Q61P, Q62P, 

Q63P, and Q64P 

Base unit Error definition 

Main base unit (Q3B) 
No AC power supply input, power supply module fuse blown, and CPU module stop 
error (including when the CPU module is 
reset) are detectable. 

Extension base unit (Q6B) Error definitions are not detectable (always OFF) 

 
2) When a power supply module is the Q61SP 

Base unit Error definition 
Slim type main base unit 
(Q3SB) 

No AC power supply input, power supply module fuse blown, and CPU module stop 
error (including when the CPU module is reset) are detectable. 
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6.4.4 When Uninterruptible Power Supply (UPS) Is Connected 

With a standby UPS, momentarily interruption occurs in timing of power supply relay 

switching from the battery and AC down (error code: 1500 AC/DC DOWN) may be 

detected at the time of power failure or a voltage drop. 

Therefore, an online inverter UPS or line-interactive UPS whose voltage distortion is 

5% or less must be used. 

 

Mitsubishi's recommendation products are described below: 

(1) Online inverter UPS (Example) FREQUPS-V series, FW-V10-0.7K 

(2) Line-interactive UPS (Example) FREQUPS-A series, FW-A10L-0.7K 

 

Note that when a standby UPS is adopted, only Mitsubishi's FREQUPS-F series 

UPS (serial number P or later) is usable. (Example) FW-F10-0.3K/0.5K 
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6.5 Troubleshooting for the CPU 

For troubles regarding a CPU module, there are cases in which hardware failure 
occurs or a program cannot be written. 
 

6.5.1 Troubles regarding Hardware Failure 

Identify a CPU error based on each LED status. 
 

LED type Status Reference 
Not turn on (1) of this section"MODE" LED 
Flashes (2) of this section
Turns off (3) of this section

"RUN" LED 
Flashes (4) of this section
Turns on/flashes (5) of this section
Turns on/flashes 
(UNIT VERIFY ERR. occurs) 

(6) of this section"ERR." LED 
Turns on/flashes  
(CONTROL-BUS ERR. occurs) 

(7) of this section

"USER" LED Turns on (8) of this section
"BAT." LED Turns on (9) of this section
"BOOT" LED Flashes (10) of this section
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(1)  When the "MODE" LED does not turn on 

The flow chart below shows causes and measures in the case that the "MODE" 

LED does not turn on at power-on. 
 

End　　

NO

YES NO YES

YES

NO

NO YES

NO

NO

YES

NO

YES

The "MODE" LED does not turn on

Have all the powers of the
power supply modules been

turned on? Is the wiring of the
power supply module correct?

Can the CPU module
communicate with GX Works2?

Is the connection direction of
the extension cable correct?
(IN-IN, OUT-OUT, or IN-OUT

connection is not correct)

Replace the power supply module
and check the "POWER" LED status

Connect between GX Works2 and the
CPU module

Does the "MODE" LED
turn on?

Is the "POWER" LED
of the power supply

module on?

The following hardware failure may have
occurred.
(1) CPU module
(2) Main base unit or extension base unit
(3) Extension cable
(4) Network module
Perform operation check one by one,
starting from the minimum configuration
system, which consists of the main base
unit with the power supply module and the
CPU module mounted.
For a module that does not work, explain
the fault symptoms and consult with the
nearest system service, distributor or
branch office.

Go to the "when the 'POWER' LED turns
off" flow diagram, described in Section 6.4.2

Check wiring, and turn on all power
supplies

Does the "MODE" LED turn on?

Perform PLC diagnostics, and troubleshoot
according to the diagnostic results.

Connect the extension cable properly

Does the "MODE" LED turn on?

Power supply module hardware failure
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(2)  When the "MODE" LED flashes 

The flow chart below shows causes and measures in the case that the "MODE" 

LED flashes at power-on, at the time of starting operation, or during operation. 
 

The MODE LED flashes

Has forced ON/OFF
settings been done? Clear the forced ON/OFF settings

Hardware failure
Perform operation check one by
one, starting from the minimum
configuration system.
For a module that does not work,
explain the fault symptoms and
consult with the nearest system
service, distributor or branch office.

　

NO YES

NO

Does the "MODE" LED �
turn on?

YES

End
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(3)  When the "RUN" LED turns off 

The flow chart below shows causes and measures in the case that the "RUN" 

LED turns off at power-on or during operation. 

 

The "RUN" LED turned off

Is the "POWER" LED
of the power supply

module on?

Is the "ERR" LED on
or flashing?

Reset using the RUN/STOP/RESET
switch of the CPU module

Set the RUN/STOP/RESET switch of
the CPU module to STOP, and write
END to Address 0 using GX Works2

Set the RUN/STOP/RESET switch to
RUN, and operate in the monitoring
mode using GX Works2

Some error in a sequence program
may be the cause

Check the program and correct the
defective part

Doesthe "RUN" LED
turn on?

Go to the "when the 'POWER' LED
turnsoff" flow diagram, described in
Section 6.4.2

Go to the "when the 'ERR.' LED turns
on or flashes" flow diagram,
described in Section 6.5.1 (6)

(1) Failure of programmable
controller parts or poor contact
(2) Due to excessive noise

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Connect a surge suppressor circuit
such as CR to a noise source

YES

NO

"RUN" LED is off

End　

YES

NO

NO

YES

"RUN" LED is on

"RUN" LED is on

"RUN" LED does not
turn on

In the case of (1) In the case of (2)
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(4)  When the "RUN" LED flashes 

When the "RUN" LED flashes during operation, it is presumed that a parameter 

or program change is in invalid status (operation stop). 
 

If a program was written, perform one of the following operations: 
 Reset the CPU using the RUN/STOP/RESET switch 
 Turn the power off and on again 
 Set the RUN/STOP/RESET switch from STOP → RUN again 

 
If parameters were changed, perform one of the following operations: 

 Reset the CPU using the RUN/STOP/RESET switch 
 Turn the power off and on again 

 
If the "RUN" LED flashes even after the operation described above was 
performed, it is presumed to be hardware failure. 

 

POINT  

After a program or parameters were written during stop, the QCPU checks 
programs when setting the RUN/STOP/RESET switch from STOP → RUN. 
In this state, the CPU has been stopped its operation. (Though it is not an error, the 
"RUN" LED flashes.) 
To resume the operation, set the RUN/STOP/RESET switch from STOP → RUN 
again. 
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(5)  When the "ERR." LED turns on or flashes 

The flow chart below shows causes and measures in the case that the "ERR." 

LED turns on or flashes at power-on, at the time of starting operation, or during 

operation.  

When the "ERR." LED turns on or flashes, it is presumed that an error has 

occurred. 
 

 

The "ERR." LED is on or flashing

Check the error definition using
GX Works2

Set the RUN/STOP/RESET switch to STOP

Take measures according to the error definition

Reset using the RUN/STOP/RESET
switch

Set the RUN/STOP/RESET switch to RUN

Does the "ERR." LED
turn off?

Hardware failure

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

End　

NO

YES
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(6)  When the "ERR." LED turns on or flashes (when UNIT VERIFY ERR. occurred) 

The flow chart below shows causes and measures in the case that a UNIT 

VERIFY ERR. occurred and the "ERR." LED turns on or flashes. 

 

UNIT VERIFY ERR. occurred

Check the error slot using GX
Works2

Check that the module of the
slot is connected and
disconnected during

operation

Check that the module of the
slot is mounted correctly

Check that all extension
cables of the base unit have

been connected properly

Replace the module
Normal operation

Normal operation

Normal operation

Error detection

Error detection

Error detection

Replace the CPU module

Replace the base unit

Hardware failure.
Explain the fault symptoms and consult
with the nearest system service,
distributor or branch office

Mount the module properly

Reset the CPU module

Did the error disappear?

Connect the extension cable properly

Did the error disappear?

Did the error disappear?

Replace the module

NO

YES

NO YES

YES

NO YES

NO

End　　

NO

YES

YES

NO
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(7)  When the "ERR." LED turns on or flashes (when CONTROL-BUS. ERR. 

occurred) 

The flow chart below shows causes and measures in the case that a 

CONTROL-BUS. ERR. occurred and the "ERR." LED turns on or flashes.  

Note that this flow diagram is available only when a slot/base unit can be 

specified by an error code. 

 

NO

YES NO YES

YES NO YES

NO

End　　

NO

YES

CONTROL-BUS ERR. occurred

Check the error slot and the base unit
using GX Works2

Check that the module of the
slot is mounted correctly
Check that the extension
cable of the base unit is

connected properly

Check that all extension
cables of the base unit have

been connected properly

Check that there is any
noise influence

Replace the module

Replace the CPU module

Replace the base unit

Normal operation

Normal operation

Normal operation

Error detection

Error detection

Error detection

Hardware failure.
Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Mount the module and the cable properly

Did the error disappear?

Connect the extension cable properly

Take measures against noise

Did the error disappear?
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(8)  When the "USER" LED turns on 

The "USER" LED turns on when an error is detected at a CHK instruction or 
when an annunciator (F) turns on. 
When the "USER" LED turns on, monitor SM62 and SM80 of the special relay 
using the GX Works2 monitoring mode. 
 When SM62 is ON 

An annunciator (F) is ON. 

Identify the error cause using SD62 to SD79. 

 When SM80 is ON 

Execution of a CHK instruction turns on the "USER" LED. 

Identify the error cause using SD80. 

 

Once an error cause is identified, remove the error cause. 

The following operation will turn off the "USER" LED: 

 Reset using the RUN/STOP/RESET switch 

 Execution of a LEDR instruction by a programmable controller program 
 

REMARKS 

To execute latch clear processing, use the remote latch clear operation of GX 

Works2. 

 

 
(9)  When the "BAT." LED turns on 

The "BAT." LED turns on when a battery low is detected. 
If the "BAT." LED turns on, monitor special relays and special registers using 
functions of GX Works2 such as the device batch monitor in order to identify 
which battery is low, either the CPU module or an SRAM card. (SM51 to SM52 
and SD51 to SD52) 
After identification and replacement with a new battery, reset using the 
RUN/STOP/RESET switch or execution of a LEDR instruction will turn off the 
"BAT." LED. 
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(10) When the "BOOT" LED flashes 

The flow chart below shows causes and measures in the case that the "BOOT" 
LED of the CPU module flashes at the programmable controller power-on, at the 
time of starting operation, or during operation. 

 

The "BOOT" LED flashes

Turn OFF the power supply of the programmable
controller

Turn on the SW2 and SW3 DIP switches

Turn ON the power supply of the programmable
controller

Does the "BOOT" LED turn on?

CPU module hardware failure.
Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Automatic writing from a memory card
to the standard ROM is completed

Execute boot operation from the standard ROM

Detach a memory card

YES

NO
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6.5.3 When a Program Cannot Be Read/Written 

(1)  When a program cannot be written 
The flow chart below shows causes and measures in the case that a program 
cannot be written to the CPU module. 
 

A program cannot be written

Is the DIP switch 1 OFF?

Has a password been
registered?

Is the memory program
memory?

Program memory

Memory
card

Try the following items
・ Organize and rearrange files
・ Check the free space of the memory
・ Check the specification of a write destination

Can a program be written?

Format the memory

Can a program be written?

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Set the DIP switch 1 (system
protection) to OFF

Can a program be written?

Clear the password using GX
Works2

Can a program be written?

Try the following items
・ Check whether the write protect

switch is OFF
・ Check whether it is formatted
・ Check the specification of a write

destination

Can a program be written?

End

Only for high
performance models

OFF
NO YES

ON

NO
NO YES

YES

YES

NO
YES

NO

NO

YES
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(2)  When a program cannot be read 
The flow chart below shows causes and measures in the case that GX Works2 
cannot communicate with the programmable controller while its power is ON. 
 

Cannot communicate with GX Works2

Is memory to be read correct? Choose correct memory

Can the CPU
module communicate with

GX Works2?

Is the connection cable
connected correctly?

Connect the connection cable
correctly.

Can the CPU
module communicate with GX

Works2?

End

NO

YES NO YES

YES
NO YES

NO

YES

YESCan it communicate with
GX Works2 after the replacement

of the connection cable?

Can the CPU
module communicate with GX

Works2?

NO

YES

Has a USB driver
been installed to the
personal computer?

NO Install a USB driver to the personal
computer.

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

NO
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(3)  When a program is unexpectedly overwritten 

The flow chart below shows causes and measures in the case that a program is 

unexpectedly overwritten at power-on or reset operation. 
 

A program is unexpectedly overwritten

ON (Boot operation is going on)

Is SM660 ON?

Format the program memory that is
executing boot operation from the standard
ROM, and write to the standard ROM

Disable the "Execute boot operation from
the standard ROM" checkbox in the boot
file setting of the PLC parameter

Write parameters and a sequence
program to the program memory

Restart/reset the power supply of
the programmable controller

Is a program overwritten?

End Hardware failure.
Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office.

YES

OFF (Program memory execution)
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(4)  When boot operation from a memory card cannot be executed 

The flow chart below shows causes and measures in the case that boot 

operation of the CPU module from a memory card cannot be executed. 
 

Boot operation cannot be executed

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Did CPU fault occur? Remove the error causes

Can boot operation be
executed?

Has a parameter-valid
drive been specified?

Specify a parameter-valid drive
using the DIP switches 2 and 3

Can boot operation be
executed?

Set a file to the boot file setting

Can boot operation be
executed?

Has a file set in
the boot file setting of

the parameters?

Can boot operation be
executed?

Has a file set in
the program settings of

the parameters?

End

Set a file to the program settings

Can boot operation be
executed?

Has a file executed
by boot operation been stored

in the memory card?

YES

YES

YES

YES

YES

YES

YES

YES

YES

YESNO

NO

NO

NO

NO

NO

NO

NO

NO
NO

Write a file to the memory card

Only for high
performance models
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6.5.3 CPU Troubles and Measures 

 Trouble symptom Measures 

E
xa

m
pl

e 
1 

 Disturbance to the programmable 
controller such as noise causes 
unauthorized access to the memory 
inside the CPU, overwriting data 
temporarily. 

 

 Fundamentally, various measures against noise are required. For temporary and 
early restoration, however, avoiding this trouble using boot operation from a flash 
ROM (standard ROM), which is an internal standard attachment, or from a 
memory card is useful. Storing programs and parameters into a standard ROM or 
a memory card in advance enables to perform boot operation triggered by a CPU 
reset or turning the power OFF and ON again, which transfers data to an internal 
program memory (SRAM) whenever this happens. (The following figure is a 
operation image) Furthermore, backing up programs and parameters to a CF 
card using the backup and restoration function of the GOT also enables this. (The 
following figure is a operation image) The CPU module processes the operation 
of programs stored in the program memory. The operation of program stored in 
the standard ROM and the memory card is not processed. To process the 
operation of programs stored in the standard ROM or the memory card, configure 
the module so that programs in the standard ROM and the memory card can be 
booted (read) into the program memory when the power is turned OFF and ON 
again or when the CPU module is reset. 

 
 Boot operation from the standard ROM or the memory card 

Boot

Standard
ROM

Program
memory

Boot

Memory card

 

 Function to backup and restore connected devices 

Backs up the setting information of connected
devices to a memory card/USB memory

Memory card/
USB memory

Restores the backed up setting
information of connected devices

 

E
xa

m
pl

e 
2 

 Once a battery error occurs, the battery 
error can be displayed after battery 
replacement. 

 

 There are two types of battery errors depending on a place in which the error 
occurred. Therefore, perform the PLC diagnostics using peripherals such as GX 
Works2 to check the error code. 
(1) Error code 1600: CPU module itself 
(2) Error code 1601: Memory card 
* The basic model and the universal model QCPU Q00U(J)CPU and Q01UCPU 

are not equipped with a memory card. 

E
xa

m
pl

e 
3 

 The programmable controller does not 
start and the front LED does not turn 
on, even after power-on. 

 

 The RESET switch may be fixed at the reset position. Check visually to make 
sure that the RESET switch is not at the reset position. 

 

RUNSTOP

L.CLRRESET

5
4
3
2
1

RESET/
L.CTR switch

 
* The basic model and universal model QCPU has the RUN/STOP/RESET 

switch. When the switch is released at the reset position, it automatically goes 
back to the stop position. Therefore it cannot be fixed at the reset position. 

(To the next page) 
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(From the previous page) 
 Trouble symptom Measures 

E
xa

m
pl

e 
4 

 When the base is mounted, the base 
connector can be damaged. 

 
 

 

 When the base is mounted, ensure that the module fixing projection and the 
module fixing hole are fitting into each other, then insert the module. 

 

 

Base unit

Base unit

Module
mounting lever

Module
mounting lever

Module

Module connector

Module fixing hole

Module fixing hole

Module fixing
projection

Module fixing
projection

Base unit

Module
fixing
hook

 
 

E
xa

m
pl

e 
5 

 When a module with USB interface is 
connected to a personal computer 
using USB, electric shock or module 
failure may occur depending on the 
model of the personal computer and 
operating conditions. 

When using a personal computer with an AC power supply, use one whose 
power plug has three pins or a grounding wire, or ensure that the ground cable is 
grounded. When using a battery-driven personal computer, use the computer as 
is.  
 
(For more details, refer to the Mitsubishi programmable controller TECHNICAL 
BULLETIN No. PLC-D-464.) 
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6.6 Troubleshooting for the Input Module 

6.6.1 Troubles regarding Hardware Failure 

(1)  If external input equipment is OFF and a programmable controller side input 
signal is ON, it is presumed to be input module failure or a leakage current. 

Remove the input module from
the base unit, and monitor the
input signal using GX Works2

Restart it after removing the error
cause such as a leakage current

The input signal is on even though
the external input device is OFF

Is the LED of the input
module on?

Can an external factor be
the cause?

Reset has not been performed
after it turned ON forcibly in
device test operation

Is the input signal ON?

Reset the CPU module and
monitor the signal again
using GX Works2
Check the program,
because the signal turns
ON after the reset if the
program improperly outputs
to an input

The CPU module may be
faulty. Explain the fault
symptoms and consult with
the nearest system service,
distributor or branch office.

Is the input signal ON?

The input module may be
faulty. Explain the fault
symptoms and consult with
the nearest system service,
distributor or branch office.

The input signal cable is
faulty. Replace it with a
new cable.

Is the input signal ON?

Replace the input signal
cable and monitor the signal
again using GX Works2

NO

NO

NO

NO

NO

YES

YES

YES

YES

YES

 

 

POINT  

The external factors include external device failure, external power supply failure, 
incorrect wiring, and noise. 
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(2)  If external input equipment is ON and a programmable controller side input 
signal is OFF, it is presumed to be input module failure or disconnection of an 
input circuit. 

 

Set the input signal of the
programmable controller within
the range of voltage specifications

Check the external input circuit

The input signal is OFF even though
the external input device is on

Does the LED of
the input module turn

on?

NO

Is the "POWER"
LED on?

Does the LED
of the input signal

turn on?

The input module may be faulty.
If there is an empty input terminal
on the input module, migrate the
wiring of the external input
devices and change the input
number. Otherwise, replace the
module.

NO

Monitor the input signal using
GX Works2

Go to the "when the 'POWER'
LED turned off" flow diagram

Check the "POWER" LED
of the power supply module

Is the signal on the
monitor ON?

Is the external
input voltage within the range of

input signal?

End

Replace the input signal cable
and the extension cable

The input signal cable or the
extension cable is faulty

NO

YES

NO

YES

NO

YES

NO

YES

NO

YES
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6.6.2 Input Circuit Troubles and Measures 

This section explains examples of input circuit troubles and measures. 

Table 6-2: Input Circuit Troubles and Measures 

 Condition Cause Measures 

E
xa

m
pl

e 
1 

An input signal 
does not turn 
OFF. 

 Leakage current of the input switch 
(For example, drive by a contactless switch) 

Leakage current

Power supply

AC input

Input module

 

 Connect a proper resistor so that a voltage between 
input module terminals can be lower than the OFF 
voltage value. 

AC input

Power supply

Input module

 
 The recommended CR constant is: 
 0.1 to 0.47 μF + 47 to 120 Ω (1/2 W). 

E
xa

m
pl

e 
2 

An input signal 
does not turn 
OFF. 

 Drive by a limit switch with neon lamp 

Leakage current

Power supply

AC input

Input module

 

 Same as Example 1 
 Alternatively, make the circuit independent and 

install a display circuit separately. 
 

E
xa

m
pl

e 
3 

An input signal 
does not turn 
OFF. 

 Leakage current due to the line capacity of an 
connecting cable 
The approximate line capacity of a twisted pair 
cable C is defined as: C = 100 PF/m. 

Leakage
current

Power supply

AC input

Input module

 

 Same as Example 1 

 However, when the power supply is located at the 
side of the input equipment shown as the following 
figure, this trouble does not occur. 

Power supply

AC input

Input module

 

E
xa

m
pl

e 
4 

An input signal 
does not turn 
OFF. 

 Drive by a switch with a LED indicator 

Leakage current Input module

DC input
(Positive common)

 

 Connect a proper resistor so that a current in the 
input module is lower than the OFF current. 

DC input
(Positive common)

Input moduleResistor

 
* The next page shows the calculation examples for 

the values of resistance to be connected. 

E
xa

m
pl

e 
5 

An input signal 
does not turn 
OFF. 

 Sneak current due to usage of two power supplies 
DC input

Lamp
Input module

 

 Unite two power supplies into one. 

 Connect a diode to suppress a sneak current. (The 
figure below) 

DC input

Input module Lamp

diode
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Table 6-2: Input Circuit Troubles and Measures (Continued) 

 Condition Cause Measures 

E
xa

m
pl

e 
6 An input signal 

does not turn 
ON.  
(AC input module) 

There exists stepwise distortion near the zero cross 
voltage in the input signal (AC) as shown below. 

Zero cross
voltage

Improve the waveform of the input signal, for 
example, using an online inverter UPS. 

E
xa

m
pl

e 
7 

Incorrect input 
due to noise 

Noise is captured as input. 

Change the response time setting. *1 
Example: 1 ms → 5 ms 
If setting the response time longer makes no 
difference, take measures described below: 
 Avoid bundling a power cable and an I/O cable to 

prevent excessive noise. 
 Take measures against noise. For example, 

suppress noise by adding a surge absorber to noise 
sources such as relays and conductors that use the 
same power supply. 

 
*1: If the noise is periodic and excessive, setting response time short may be more effective. 

 

<Calculation examples for Example 4> 
When a switch with LED indicator, through which a 2.33 mA leakage current 
flows when a 24 VDC power supply is applied to the QX40, is connected: 

Leakage current 2.33 mA Input module

 
 

(1) This does not meet the QX40 OFF current, 1.7 mA. Therefore, a resistor must 

be connected as follows: 

input impedance

 
 

(2) The connection resistance value R is calculated as follows. 

The connection of a resistor R by which 0.63 mA or more flows through the 

connection resistor is required in order to meet the QX40 OFF current of 1.7 mA 

or less. 

 
IR:IZ＝Z（ ）:R

R≦　　　Z（ ）＝　　　 5.6＝15.11[kΩ]
IR
IZ

0.63
1.7

Input impedance

Input impedance
 

 

That is, R ＜ 15.11 kΩ. 

When resistor R is 12 kΩ, power capacity W for the resistor R is: 

W = (input voltage) 2 ÷ R = 28.82 ÷ 12000 = 0.069 (W) 
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(3) Because the power capacity of a resistor is three to five times of the actual 

power consumption, a 12 (kΩ) and 1/4 to 1 (W) resistor must be connected to 

the issued terminal, 

 

(4) Besides, the OFF voltage when resistor R is inserted is: 

 

1

12.0[kΩ] 5.6[kΩ]

×2.33[mA]＝8.90[V]
1

＋

1

 

 

It satisfies the QX40 OFF voltage, which is 11 V or less. 
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6.6.3 Input Module Terminal Voltage Checking Methods 

The input module differs in control voltage, which is 100 V AC, 200 V AC, 5 V DC, 12 
V DC, and 24 V DC, and in source/sync input. This offers various combinations. 
Methods for terminal voltage check for the input module using a tester are described 
below. 

Negative electrode (-)

Positive electrode (+)

 

Table 6-3: Terminal Voltage Checking Methods 

Control voltage Module/unit terminal measuring point 

100 V AC 
200 V AC 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

NC

100VAC
8mA60Hz
7mA50Hz

Set the voltage range of the tester to 100 V AC/200 V 
AC measurement. 
 

 

 

Connect the negative electrode of the tester to each 
input terminal 
 
 
Connect the positive electrode of the tester to the 
COM terminal 
 

5 V DC 
12 V DC 
24 V DC 
Positive 
common 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

NC

24VDC

4mA

+-

Set the voltage range of the tester to 100 V DC 
measurement. 
 
 
 
 
Connect the negative electrode of the tester to each 
input terminal 
 
 
Connect the positive electrode of the tester to the 
COM terminal 

5 V DC 
12 V DC 
24 V DC 
Negative 
common 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

NC

24VDC

4mA

Set the voltage range of the tester to 100 V DC 
measurement. 
 
 
 
 
Connect the negative electrode of the tester to the 
COM terminal 

 

Connect the positive electrode of the tester to each 
input terminal 
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6.7 Troubleshooting for the Output Module 

6.7.1 Troubles regarding Hardware Failure 

(1)  When the load of the output module does not turn ON during operation 
The flow chart below shows causes and measures in the case that the load of 

the output module does not turn ON during operation. 
 

YES

NO

NO

YES

0V

NG

OK

0V
　
　

An output load does not turn ON

Is the operation
indication of the output

module on?

Is a voltage to
the load
applied?

Is the operation
indication of the

output module on?

The output module is faulty
Replace the output module

Check the rush current while the
maximum number of loads is
simultaneously ON

What is the voltage
between output

COM terminals of
the output module?

Equal to the
supply voltage

Check the output status using the
GX Works2 monitoring mode

Check the external wiring and the
external output devices

Measure the voltage between the
output of the module and the
COM terminal

Explain the fault symptoms and
consult with the nearest system
service, distributor or branch
office

Confirm that the output signal is
off using the GX Works2
monitoring mode

Check the wiring of the power
supply to the load, and restore the
power

Check the load and its wiring, and
restore them

Change the output relay number and change
the maximum simultaneous ON current of the
load so that it satisfies the specifications

ON
(T

h
e

m
on

ito
r

si
gn

al
is

O
F

F
)

T
h

e
va

lu
e

of
th

e
su

pp
ly

vo
lta

g
e

OFF
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(2)  When the LED of the output module does not turn ON during operation 

The flow chart below shows causes and measures in the case that the LED of 

the output module does not turn ON during operation. 
 

NO
(flashing)

YES

NO

YES

NO

YES

NO

YES

NO

YES

The LED of the output module does not turn on

Check the I/O number using
GX Works2 system monitor

Is the "MODE" LED on? Refer to Section 11.2.3

Review the program

Change the output number

Is it ON when monitoring
using GX Works2?

Does the LED turn ON by
turning on forcibly another

output module?

Output module hardware failure.
Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Hardware failure of the CPU module,
base unit, or extension cable.
Explain the fault symptoms and
consult with the nearest system
service, distributor or branch office

Does the LED turn ON after
replacing with another output module

and turning on forcibly again?

Is the output number
correct?
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6.7.2 Output Circuit Troubles and Measures 

This section explains the examples of output circuit troubles and measures. 
 

Table 6-4: Output Circuit Troubles and Measures 

 Condition Cause Measures 

E
xa

m
pl

e 
1 

Overvoltage is 
applied to the load 
during output OFF. 

 When the load is internally half-wave rectified
(Some solenoids act like this.) 

 
QY22

D1 [1]

[2]

Output module

Load

 
 
 C is charged when the polarity of the power 

supply is [1], and the sum of a voltage 
charged to C while the polarity is [2] and the 
power supply voltage is applied across D1. 
The maximum voltage value is about 2.2 E. 
(If it is used in this way, although output 
element does not pose a problem, a built-in 
diode in the load is deteriorated and 
accidents such as burnout may occur.) 

 Connect a resistor (from 10kΩ to 1000kΩ) 
on across the load. 
 

Resistor

Load
 

E
xa

m
pl

e 
2 

The load does not 
turn OFF. 
(Triac output) 

 Leakage current due to a built-in surge 
suppressor 
 

QY22
Output module

Leakage current

Load

 

 Connect a resistor across the load.  
(Caution is required when wiring length 
between the output module and the load 
is long, because there is also a leakage 
current due to line capacity.) 
 

Resistor

Load
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Table 6-4: Output Circuit Troubles and Measures (Continued) 

 Condition Cause Measures 

E
xa

m
pl

e 
3 

The load does not 
turn OFF. 
(Triac output) 

 The minimum load current is not satisfied. 
 If the load current is lower than the minimum 

load current of the output module, the triac 
does not work and the load current will flow 
to the phototriac, as the arrow in the following 
figure shows.  
When an inductive load is connected as a 
load in this state, the off-time surge is applied 
to the phototriac and the load may not turn 
OFF. 
 

QY22

Control
circuit

Surge suppressor

Phototriac

Triac

Load

 
 

 Connect a resistor across the load so that a 
current equal to or higher than the minimum 
load current will flow. 
 

Resistor

Load
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Table 6-4: Output Circuit Troubles and Measures (Continued) 

 Condition Cause Measures 

E
xa

m
pl

e 
4 The load turns ON 

momentarily when an 
external power supply 
is started up. (transistor 
output) 

Incorrect output due to floating capacitance (C) between the collector 
and the emitter of the photocoupler. 

Although it poses no problem at a normal load, a sensitive load  
(such as a solid state relay) may output incorrectly. 

 
Output module/combined module

Photocoupler

Load

Constant-
voltage circuit

 
When an external power supply is started up rapidly, a current Ic 
flows due to floating capacitance (C) between the collector and the 
emitter of the photocoupler. 
The current Ic flows into the next stage, the gate of the transistor 
Tr1, and the output of Y0 turns ON for about 100 μs. 
 

External power
supply due to SW

ON (24 V)

10 ms or less

About 100 µs

Y0 output

 
 

When the external power supply is turned 
ON/OFF, make sure that the start-up of 
the external power supply itself takes 10 
ms or more and then insert a switch SW1 
into the primary side of the external 
power supply. 

External power supply
Programmable
controller

Primary side Secondary side

If a switch is need to be inserted into the 
secondary side of the external power 
supply, connect a capacitor and a resistor 
so that the start-up of the external power 
supply becomes slower (10 ms or more).
Sink output 

Load

Source output 

Load

*  The measures have no effect for the 
module(s) below, due to the 
characteristics of its/their external 
power supply circuit.  
•  QY81P  

R1:  Several tens of Ω 
Power capacity ≥ (External power supply 
current

*1
)
2 × Resistance value × (3 to 5)

*2

C1: Several hundreds μF 50 V 
 
*1:  Refer to the manual of the current 

consumption for the external power 
supply of a module to be used. 

*2:  The power capacity of a resistor is 
chosen from three to five times of the 
actual power consumption. 

 
(application example) 
R1 = 40 Ω, C1 = 300 μF 
Time constant is calculated by the 
following formula: 
C1 × R1 = 300 × 10-6 × 40 

= 12 × 10-3 s 
= 12 ms 
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Table 6-4: Output Circuit Troubles and Measures (Continued) 

 Condition Cause Measures 

E
xa

m
pl

e 
5 The load that has 

been OFF turns ON 
when the power 
supply is shut off. 
(transistor output) 

When an inductive load is used, the load [2] that has been OFF 
may turn ON because a back EMF during the power supply 
shut-off [1] sneaks. 
 

Output module/
combined module

Output module/
combined module

Source output

Sink output

Back EMF

Back EMF

Load

Load

Load

Load

Shut-off

Shut-off

 

 

Take one of the measures described 
below. 
1.  Connect a diode parallel to the load in 

which a back EMF is generated in 
order to suppress the back EMF. 

 
Source output 
[3] 

－ ＋Back EMF

Load

 

 
Sink output 
[3] 

＋ －Back EMF

Load

 

2.  Make a sneak current path by 
connecting a diode between (+) and (-) 
of the external power supply.  
Note that if Example 4 is implemented 
simultaneously, connect it parallel to 
C1 and R1. 

Back EMFSource output

Example 4

Shut-off

Load

Load

*  The measures have no effect for the 
module(s) below, due to the 
characteristics of its/their external 
power supply circuit. 
•  QY81P 
•  QY82P 

Back EMFSink output

Example 4

Shut-off

Load

Load

 
D1:  Reverse voltage VR (VRM)…*1, 

Forward current IF (IFM)…*2 
*1:  Approximately 10 times of the 

specified rated voltage 
Example: Approximately 200 V when 
24 V DC 

*2:  Equal to or higher than two times of 
the specified maximum load current 
(common) 
Example: More than 4 A when 2 A/1 
common 
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Table 6-4: Output Circuit Troubles and Measures (Continued) 

 

REMARKS 

When short-circuit occurs in an output module with protection, a programmable 

controller CPU cannot detect an error because a thermal protection works and 

prevents fuses from blowing. 

Therefore, a check circuit or its equivalent must be made externally. 

 
 

 

 Condition Cause Measures 

E
xa

m
pl

e 
6 

The load operates only 
by external power 
supply power-on 
(transistor output) 

The polarity of the external power supply is reversely connected. 

Output element
protection diode

Transistor output
module

Load

Wrong

External
power supply

Correct

 

When the polarity of the external power supply is reversely 
connected, a current may go through the output element 
protective diode and flow to the load. 

Connect the polarity of the external power 
supply correctly. 

E
xa

m
pl

e 
7 When output is ON, a 

load connected to other 
output turns ON 
simultaneously. 
(transistor 
output (source type)) 

When it becomes unwired due to shut-off or disconnection of 
wiring that connects the 0 V of the external power supply and the 
common of the load, a current flows to the load of an output 
element that has been turned ON, passing through the parasitic 
circuit of an output terminal that has been turned OFF. 

Transistor
output module

Source output

Output
element

Output
element

Load

Load

Shut-off
or
disconnection

Output
control
circuit

Output
control
circuit

If it continues to be used in those conditions, it may cause a 
failure. 

Connect the wiring between the external 
power supply and the load correctly. 
In addition, prevent the occurrence of the 
conditions described on the left by 
attaching diodes to each output terminal 
as shown below. 

Source output
Load

Load



 

6 - 53 

 

6.7.3 Output Module Terminal Voltage Checking Methods 

The output module, depending on its output, differs from AC and DC, in addition to 
the difference in control voltage. This offers various combinations. 
Methods for terminal voltage check of each output module using a tester are 
described below. 

Negative electrode (-)

Positive electrode (+)

 

Table 6-5: Terminal Voltage Checking Methods 

Control 
voltage 

Module/unit terminal measuring point 

Contact output 
AC/DC 

common 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

NC
24VDC

240VAC

2A

L

L

L

L

L

L

L

Set the voltage range of the tester to AC/DC 
measurement. 
 
 
 
 
 
Connect the negative electrode of the tester to each 
output terminal 
 
Connect the positive electrode of the tester to the 
COM terminal 
 

Triac output 
AC only 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

100VAC
240VAC
0.6A

L

L

L

L

L

L

L

Set the voltage range of the tester to AC 
measurement. 
 
 
 
 
Connect the negative electrode of the tester to the 
COM terminal 
 
 
Connect the positive electrode of the tester to each 
output terminal 

Transistor DC 
sink output 

only 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

12VDC
24VDC
0.1A

L

L

L

L

L

L

L

Set the voltage range of the tester to DC 
measurement. 
 
 
 
 
Connect the negative electrode of the tester to the 
COM terminal 

 
 
Connect the positive electrode of the tester to each 
output terminal 
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Table 6-5: Terminal Voltage Checking Methods (Continued) 

Control 
voltage 

Module/unit terminal measuring point 

Transistor DC 
source 

output only 

7
8
9
A
B
C
D
E
F

9

A

B

C

D

E

F

COM

12VDC
24VDC
0.5A

L

L

L

L

L

L

L
+-

Set the voltage range of the tester to DC 
measurement. 
 

 

 
Connect the negative electrode of the tester to each 
output terminal 
 
 
Connect the positive electrode of the tester to the 
COM terminal 
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6.8 Troubleshooting Using Cart Conveying System Training Machine 

(1) Explanation of the training machine (operation panel) 

This section explains troubleshooting using the training machine system that 

conveys workpieces. 

It contains practical training of moving the conveyance table to the workpiece set 

position with GOT screen operation. 

 

(2) Explanation of operating procedures 

(a) Manual control 

1) JOG operation 

It moves left and right by touching arrow switches on the operation panel. 

It stops by touching the stop switch. 

2) Point specification 

It can be moved to the workpiece set workpiece set position, inspection 

position, and pass sensor position. 

It starts to move by touching the square switch near the screen center 

then touching an arrow switch of desirable direction. It stops moving 

when it reaches a specified point. 

 

(b) Automatic control 

Starts automatic operation: Touch…Start (HMI (Human Machine Interface)) 

Stops automatic operation : Touch…Stop (HMI (Human Machine Interface)) 

Failure switch (HMI (Human Machine Interface)): Touch…Failure 

Pass switch (HMI (Human Machine Interface)): Touch…Pass 

 

[Operation example] 

1) Stop the table at the workpiece set position. 

2) Touching the start switch on the operation panel starts automatic 

operation.  

First, the table moves to the inspection position. Inspect the workpiece 

visually. 

3) When it fails → Touch the failure switch on the visual inspection panel. 

If the result of the visual inspection is failure, it moves back from the 

inspection position to the workpiece set position and stops automatic 

operation. 

When it passes → Touch the pass switch on the visual inspection panel. 

If the result of the visual inspection is passed, the table moves forward 

from the inspection position to the pass sensor, then moves back to the 

workpiece set position and stops automatic operation. 

 

* For the safety reasons, the workpiece on the table cannot be removed.  

Proceed with the training assuming the workpiece is set. 
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[Operation panel] 

 

①

④ ⑤ ⑥

②③

⑦ ⑧

⑨

⑨

⑩

⑩

 

 

1) M0: Move left switch 

2) M1: Move right switch 

3) M2: Stop switch 

4) M20: Point specification switch (pass sensor position) 

5) M22: Point specification switch (inspection position) 

6) M24: Point specification switch (workpiece set position) 

7) M300: Start automatic operation switch 

8) M300: Stop automatic operation switch 

9) Control switching switch 

10) Device display switching switch 

 

To understand the status, check the inspection, passed, and failure lamps under 

the cart training machine. 

 

[Visual inspection panel] 

 

① ②  

 

1) Passed switch 

2) Failure switch 
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[Wiring of the training machine] 

 

X20～X3F

Y60～Y7F

USB

Connect the input cable of the training
machine to X20 to X3F of QX42, and the
output cable to Y60 to Y7F of QY42.

RS-232C

RS-485

Cart training machine

Programmable controller
training machine

 
 
* Before starting-up, set the training programmable controller CPU to STOP first.  

When the cart training machine is started up first, an error may be displayed on 

the GOT. 

 

 

[Overview of the cart training machine] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Advance 

end LS 

(X24) 

Inspection 

position LS 

(X22) 

Workpiece set

position LS 

(X23) 

Retract 

end LS 

(X25) 

Pass LS 

(X20) 

Inspection LS 

(X21) 

Workpiece

Table 
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[Assignment of I/O signals] 

 

(Terminal number 4) Pass LS X20

X21

X22

X23

X24

X25

X27

X28

X26

Input Output

Y60

Y61

Y62

Passed lamp (Terminal number 1)

Inspection lamp (Terminal number 2)

Failure lamp (Terminal number 3)

MELSEC-Q

(Terminal number 5) Inspection LS

(Terminal number 7) Inspection position LS

(Terminal number 9) Workpiece set position

Advance end LS

Backward end LS

(Terminal number 10) Mock contact 1

(Terminal number 11) Mock contact 2

(Terminal number 12) Mock contact 3
 

 

* The terminal numbers represent the switch numbers on the rear side of the 

training machine. 

(Initial setting) Terminal number 1 to 5, 7, and 9…ON/6, 8, and 10 to 

12…OFF 
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Project name QDAISYA
(3) Sequence program 

Manual/automatic Control mode switching

The virtual production system starts in the manual mode.

Always
OFF

ON only
for one
scan after
RUN

Manual
mode flag

Manual control
switching request

Automatic
flag mode

Automatic
flag mode

Manual
mode flag

Automatic
control
switching
request

Manual control JOG operation Forward rotation start

Manual
mode flag

Manual
forward
run JOG
request

Manual
forward run JOG
command

Manual
stop
request

Point
specification
stop
command

Manual
reverse
run JOG
command

Advance
end LS

Manual control JOG operation Reverse rotation start

Manual
forward run
JOG
command

Manual
mode flag

Manual
reverse
run JOG
request

Manual
stop
request

Point
specification
stop
command

Manual
forward
run JOG
command

Backward
end LS

Manual
reverse run JOG
command

Manual
reverse
run JOG
command
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Manual control Select a point
Select a stopping point

Manual
mode
flag

Point
specification:
Passed

Point
specification:
Pass flag

Point
specification
stop instruction

Point
specification:
Pass flag

Point
specification:
Inspection
position

Point
specification
stop instruction

Point specification:
Inspection position
flag

Point
specification:
Inspection
position flag

Point
specification:
Workpiece
set

Point
specification
stop instruction

Point
specification:
Workpiece
set flag

Point
specification:
Workpiece
set flag

Stop when it reaches a point

Manual
mode
flag

Point
specification:
Pass flag

Pass
sensor

Point
specification:
Inspection
position flag

Inspection
position
LS

Point
specification:
Workpiece
set flag

Point
specification
stop
command

Workpiece
set position
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Automatic control Operating flag

Automatic
mode flag

Automatic
start
request

Automatic
operating flag

Workpiece
set
position

Workpiece
set position
move end:
Passed

Workpiece
set position
move end:
Failure

Advance
end LS

Backward
end LS

Automatic
stop
request

Automatic
operating flag

Automatic control Move to inspection position

Automatic
start PLS

Automatic
mode flag

Automatic
operating
flag

Automatic
start PLS

Inspection
position
move

Inspection
position
move

Inspection
position move
end pulse

Inspection
sensor

Inspection
position LS

Inspection
position
move end
pulse

Inspection
position
move

Automatic control Waiting for passed/failure determination

Automatic
mode flag

Automatic
operating
flag

Inspection
position
move end
pulse

Inspecting

Inspection
end pulse:
Passed

Inspection
end pulse:
Failure

Inspecting

Inspection
lamp

Inspection
window
display

Inspecting Touch
passed

Touch
failure

Inspection
end pulse:
Passed

Inspection
end pulse:
Failure
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Automatic control Determination result: Passed

Move to pass sensor position

Automatic
mode flag

Automatic
operating
flag

Inspection
end pulse:
Passed

Passed
position move

Passed
position
move

Passed
position
move end
pulse

Pass sensor

Passed
position
move

Passed
position move
end pulse

Standby 2 seconds

Automatic
mode flag

Automatic
operating
flag

Passed
position
move end
pulse

Standing by for
2 seconds

Standing by for
2 seconds

2.0 s timer

Standby
for 2
seconds
end pulse

Standing by
for
2 seconds

2.0 s timer

Standby for
2 seconds
end pulse

Move to workpiece set position and end

Automatic
mode flag

Automatic
operating
flag

Standby for
2 seconds
end pulse

Workpiece
set position
move:
Passed

Workpiece
set position
move:
Passed

Workpiece
set position
move end:
Passed

Workpiece
set
position

Workpiece
set position
move:
Passed

Workpiece
set position
move end:
Passed

Passed
lamp
output
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Automatic control Determination result: Failure

Move to workpiece set position and end

Automatic
mode flag

Automatic
operating
flag

Inspection
end pulse:
Failure

Workpiece
set position
move: Failure

Workpiece
set position
move:
Failure

Workpiece
set position
move end:
Failure

Workpiece
set position

Failure
lamp
output

Workpiece
set position
move:
Failure

Workpiece
set position
move end:
Failure

Stroke limit error Display

Advance
end LS

Stroke limit
error screen
display

Backward
end LS

Stroke limit
error
screen
display

Device name
screen
display

Touch panel initial display: Manual control

ON only for
one scan after
RUN

Stroke limit
error screen
display
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Output processing

Cart forward rotation output

Manual
forward run
JOG
command

Inspection
position
move

Passed
position
move

Cart forward
rotation

Cart reverse rotation output

Manual
reverse run
JOG
command

Workpiece
set position
move:
Passed

Workpiece
set position
move:
Failure

Cart reverse
rotation

Passed
lamp
output

Passed lamp output

Passed lamp

Inspecting lamp output

Inspecting Inspection
lamp

Failure lamp output

Failure
lamp
output

Failure
lamp
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The following is a communication program between a programmable controller and an inverter.
Do not change this program because it is completed.

Command send preparation

ON only for
one scan
after RUN

Forward rotation start command send

Cart forward
rotation

Reverse rotation start command send

Cart
reverse
rotation

Stop command send

Cart
forward
rotation

Cart
reverse
rotation
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Receive response

 

 
(4)  Practical operation for trouble examples 

Mock contacts and switches of an I/O signal disconnection terminal block on the 
rear side of the training machine are used as a trouble example of the training 
machine, as shown in the following figure. 
1) When a contact does not turn ON 

A mock contact that turns non-conductive when it turned ON externally

Fault contact
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Investigate the cause of Trouble example 1 to 4 described below. 

 
<Trouble example 1> 
The cart does not move forward. 
 
 
 
 
 
 
 
 
 
<Trouble example 2> 
The cart does not stop at the position of the inspection sensor. 
 
 
 
 
 
 
 
 
 
<Trouble example 3> 
The cart does not move backward. 
 
 
 
 
 
 
 
 
 
<Trouble example 4> 
The cart does not stop at the workpiece set position. 
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For the cause of Trouble example 1 to 4, refer to Appendix 8. 

 
 

 

6.9 Trouble Example: Troubleshooting Using Training Machine 

Write the following sequence program to the training programmable controller, make 

sure it works correctly, and then investigate the occurring troubles and their causes. 

 

Project name QTORABURU
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(1) Question 1 
 

1) Training machine system 

 

Q61P Q06UDHCPU QX42

64 points

QY42P

64 points

Q64AD

16 points

Occupied

Q62DAN

16 points

Occupied

Empty

X02

X03

X04

X05

X06

+

-

24 V DC

 
 

2) Fault description 

Whichever input signal turns ON, it does not turn ON in the program, even 

though the monitor LED of the input module has turned on. 

 
Target

Input 
External device

QX42 monitor 
LED 

Program 

X0 to X3F 
ON/OFF 
switching 

ON/OFF Always OFF 

 
3) How to answer 

Use the flow diagram in troubleshooting (Section 6.6) of the school text to 

find the cause of the trouble, the reason why the CPU does not read the 

signals even though they are input to the input module from outside. 
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(2) Question 2 
 

1) Training machine system 

 

Q61P Q06UDHCPU QX42

64 points

QY42P

64 points

Q64AD

16 points

Occupied

Q62DAN

16 points

Occupied

Empty

 
 

2) Fault description 

When the CPU is set to RUN and Y60, Y61, Y62, and Y63 are turned 

ON/OFF in the program, nothing is output to the external device even 

though the monitor LED of the output module QY42P turns on/off.  

When Y70, Y71, and Y72 are turned ON/OFF in the program, nothing is 

output to the external device even though the monitor LED of the QY42P 

turns on/off.  

Assume that external wiring is correct. 

 
Target

Output 
Program 

QY42P monitor 
LED 

External device 

Y60 to Y63 
ON/OFF 
switching 

ON/OFF 
No output 

(always OFF) 

Y70 to Y72 
ON/OFF 
switching 

ON/OFF 
No output 

(always OFF) 

 
3) How to answer 

Use the flow diagram in troubleshooting (Section 6.7) of the school text to 

find the cause of the trouble, the reason why the external device does not 

turn ON/OFF. 
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(3) Question 3 
 

1) Training machine system 

 

Q61P Q06UDHCPU QX42

64 points

QY42P

64 points

Q64AD

16 points

Occupied

Q62DAN

16 points

Occupied

Empty

 
 

CPU fault occurs after the sequence program described below is modified. 

 

Ladder diagram 

 

D10 D10 

 

 

2) Fault description 

CPU error occurs. 
 

3) How to answer 

Use the flow diagram in troubleshooting (Section 6.5) of the school text to 

find the cause of the trouble, the reason why the CPU error occurs. 

 

* For the FROM instruction, refer to Appendix 9. 
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6.10 Troubleshooting for the Intelligent Function Module 

Various intelligent function modules can be used with a programmable controller. 
This section explains common items that should be known at troubleshooting. 
 

6.10.1 Common Items about Intelligent Function Modules 

(1)  Type of intelligent function modules 
Intelligent function modules are designed to process functions that the 
programmable controller CPU cannot do or functions whose application is 
limited. Some typical types are described below: 
 
1)  Analog module 
 Analog-digital converter module 

Receives analog (current/voltage) as input and converts it to digital value. 
 Digital-analog converter module 

Converts digital value and outputs analog (current/voltage). 
 Temperature input module 

Connects a temperature sensor and converts to digital value. 
 Temperature control module 

Connects a temperature sensor and controls a heating/cooling device to 
keep the temperature of a target object constant. 

 
2)  High-speed counter module and positioning module 
 High-speed counter module 

Receives high speed pulses as input from an encoder in order to count. 
 Positioning module 

Outputs high-speed pulses to a servo amplifier for positioning. 
 
3)  Network module 
 MELSECNET/H network module 

Performs data communication between programmable controllers using a 
network. 

 Ethernet interface module 
Performs data communication between a personal computer and a 
programmable controller via Ethernet. 

 Web server module 
Allows a personal computer to monitor a programmable controller via the 
Internet. 

 CC-Link module 
Performs data communication of a programmable controller or various 
devices on a distributed system. 

 CC-Link IE 
An integrated network which realizes seamless data transfer, from 
information systems to production sites. This achieves both conventional 
control information transmission and information processing data 
transmission, such as equipment information maintenance and device 
settings. 

 
4)  Serial communication module and modem interface module 
 Serial communication module 

Connects a programmable controller and a calculator, printer, bar code 
reader, or other devices and performs data communication. 
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(2)  Relation to the programmable controller CPU 
An intelligent function module has internal buffer memory to store necessary 
data. 
As needed, a programmable controller CPU can write data to the buffer memory 
using a TO instruction, and read from the buffer memory using a FROM 
instruction. 
Besides, specifying an intelligent function module device (U\G) using a MOV 
instruction enables writing to and reading from the buffer memory. 
 
Signals are exchanged by setting output signal Y to ON/OFF when the 
programmable controller CPU commands the intelligent function module, and by 
setting input signal X to ON/OFF when the intelligent function module answers 
to the programmable controller CPU. 

REFERENCE  
When an error occurs during the 
execution of TO/FROM 
instruction, error code numbers 
described below are stored to 
SD0 and the CPU stops. 
1412 ··· Cannot be executed. 
1402 ··· No answer came. * 
2110 ··· No intelligent function 

module. * 

*: If some CPU parameters 
have been set, operation 
will not stop but continue. 

P
ow

er
su

pp
ly

m
o

du
le

C
P

U
m

o
du

le

I/O
m

o
du

le

In
te

lli
g

en
tf

u
nc

tio
n

m
od

ul
e

I/O
m

o
du

le

Device
memory such
as D, W, R,

X, and Y

Buffer
memory

FROM instruction

TO instruction

I/O
signals

Input X

Output Y

Intelligent function
module device

(U□\G□)

MOV instruction

MOV instruction

 

 

 
Assignment of the buffer memory and the I/O signals is explained in the user's 
manual of each intelligent function module. 
 

REMARKS 

 With intelligent function module operation by GX Works2, it is possible to set, 

monitor, and test functions easily without realizing the I/O signals and the 

buffer memory. Example functions are intelligent function module parameters 

of an analog module (initial setting and auto refresh), the system settings of a 

serial communication module, and the positioning data and parameters of a 

positioning module. 
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6.10.2 Buffer Memory Monitor Operation of the Intelligent Function Module 

The buffer memory of the intelligent function module can be directly monitored using 
a personal computer (GX Works2) to check the current value. 
 
(1)  Monitoring buffer memory 

 
 Set the "RUN/STOP/RESET" key switch of the 

CPU to "RUN". 
 

 

 

 
1)  Click the [Online] → [Monitor] → 

[Device/Buffer Memory Batch] menu. 

 

2)  Specify a start I/O number (whole digit 
specification) and a buffer memory 
address (decimal/hexadecimal) of the 
intelligent function module to be 
monitored.  
In this example, specify "80" as a module 
start number, and "0" as an address. 

 
3)  Press . 

 

4)  Monitoring of the specified buffer memory 
is started. 

 
5)  Turn the voltage potentiometer of the 

training machine to set the meter to 5 to 8 
V DC.  
The current value of Q64AD CH.1 can be 
monitored. 
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(2)  Changing a current value of the buffer memory 
In this example, a current value of the buffer memory monitored in (1) will be 
changed. 

 

 

 

1)  Click the  Modify Value  button. 

 

 

2)  From the "Buffer memory" tab, specify 
"80" in the "Module start" and "0" in the 
"Address". 

 
3)  Input "2" in the "Value to be set". 
 
4)  Click the  Set  button. 

 

5)  The current value is replaced with the 
specified value. 
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(3)  Saving the buffer memory 
In this example, a current value of the buffer memory will be read and saved. 
 

 

(1)　Click!

 

 

1)  Click the [Online] → [Read from PLC] 
menu. 

 

 

2)  Click the  Parameter + Program  button. 
 
3)  Click the  Execute  button. When the 

"The parameter exists already. Do you 
want to overwrite it?" message appears, 
click the  Yes  button. 

 
4)  When the "Operation ended" message 

appears, click the  OK  button. 

 

 

(To the next page) 

5)  Check the "Device data" to select it. 
 
6)  Click the "Detailed information" button. 
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(From the previous page) 

 

 

 

 
 
 
 
7)  Input "MAIN" in the Device data name. 
 
8)  Check the "Buffer memory" to select it. 
 
9)  Input the address of the module whose 

buffer memory is read. 
 
10) Click the  OK  button. 
 

 

11) Click the  Execute  button.  
When the "The device memory (MAIN) 
exists already. Do you want to overwrite 
it?" message appears, click the  Yes  
button. 

 
12) Click the  Close  button after reading 

finished. 
 
13) Click the [Project] → [Save] menu to save 

the project.  
By saving the project, the read device 
memory is saved. 

 

 

 



 

6 - 78 

 

6.10 Intelligent Function Module Troubles and Measures 

 

(To the next page) 

 

 Product model Trouble symptom Measures 

E
xa

m
pl

e 
1 Q62DA(N) 

Q64DA(N) 
Q68DAV(N) 
Q68DAI(N) 

In analog input wiring check, when a wiring 
conduction test is performed using a 
checker with a buzzer (6 V, 60 mA) while a 
programmable controller power supply is 
being turned on, a operational amplifier IC in 
analog output circuit may cause a failure. 

The cause is presumed as that an excessive 
surge voltage is applied during a wiring check 
with a buzzer or current application test using 
an external device. Take measures described 
below. 
(1) Stop using the buzzer used in the test in 

order not to apply an external voltage. 
(2) When an external voltage is applied, 

perform the test holding the terminal 
block of the module afloat. 

E
xa

m
pl

e 
2 Q62DA(N) 

Q64DA(N) 
Q68DAV(N) 
Q68DAI(N) 

Analog output reduces sometimes. It is presumed that a poor contact causes 
unstable analog output because a screw is 
not tightened enough at the load side 
(isolator) terminal block connected to the 
analog output. Tighten the screw at the load 
side. 

Due to combined use of an RS-232 cable 
and a USB cable as well as 24 V DC 
positive grounding specification conditions, 
a closed loop circuit is formed by 24 VDC 
power supply, Q64DA (a typical example), 
servo amplifier, personal computer, 
Q06UDHCPU, and FG. When the RS-232 
cable is connected to the servo amplifier, a 
voltage is applied between external power 
supply 24 G and analog output COM, 
causing a current flow through the filter coil 
of the Q64DA internal common line and 
blowing the coil. 

(1) Change to the Q64DAN (a typical 
example), in which a gap between the 
external power supply and the analog 
output is isolated. 

(2) Ensure to avoid combined use of an 
RS-232 cable and a USB cable in order 
not to form a closed loop circuit. 

 

E
xa

m
pl

e 
3 Q62DA 

Q64DA 
Q68DAV 
Q68DAI 

Q06UDHCPU Q64DA

RS-232

FIL

USB

F
G

USB communication cable

The shield of USB
and FG are in
common

The analog
output and
the common
are in
common

24 V DC
common

24 V DC
positive

Filter coil blown

Analog output

Servo amplifier
The input and the RS-232
common are in common

Compared to the ground, FG and
24 V DC positive are in common

Personal computer
The USB shield and the
RS-232 common are in

common internally
RS-232 communication cable

Failure occurs when the
cable is connected
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(From the previous page) 

 

(To the next page) 

 Product model Trouble symptom Measures 

In the Q64DA (a typical example), when 24 
V DC is applied to external wiring of the 
COM terminal, a current flows through the 
filter coil of the common line, blowing the 
coil. 

(1) Change to the Q64DAN (a typical example), 
in which a gap between the external power 
supply and the analog output is isolated. 

(2) Improve the wiring so that the 24 V DC is not 
applied to the external wiring. 

E
xa

m
pl

e 
4 Q62DA 

Q64DA 
Q68DAV 
Q68DAI 

<Internal ladder block diagram of Q64DA>

To internal
control circuit

D/A
conversion
circuit

Channel
switching
circuit

Output
circuit

It is presumed that 24 V
DC is applied to the
COM terminal of one of
the channels according
to external wiring, and
an overcurrent flows.

DC-DC converter

Analog ground (AG)

Filter
24 V DC

E
xa

m
pl

e 
5 

Q68AD 
Q68ADV 
Q68ADI 

Digital conversion value of analog input is 
unstable (varies). 

Analog/digital conversion value is unstable 
(varies) due to the influence of superposition of 
noise generated by the servo to analog input 
signals. 
(1) Configure the average processing function 

using parameters in order to reduce the 
influence of the input noise. 

(2) Review wiring so that any cable does not 
come near to the power cable and is not 
bundled to it. 
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(From the previous page) 

 

 

(To the next page) 

 

 

 Product model Trouble symptom Measures 

E
xa

m
pl

e 
6 

Q68AD-G 
Q66AD-DG 

When a connector/terminal block converter 
module and a dedicated cable are used with 
current input, the accuracy of analog/digital 
conversion value is not within the 
specifications. 

The factory default setting of offset/gain 
setting has been adjusted for a single module. 
Therefore, when the connector/terminal block 
converter module and the dedicated cable are 
used, error in conversion property may occur 
due to influence such as conductor resistance. 
If the influence such as conductor resistance 
is a problem, configure the offset/gain setting 
using user range setting. (For more details, 
refer to the Mitsubishi programmable controller 
TECHNICAL BULLETIN No. PLC-D-555.) 

When a personal computer (with a power supply 
plug and without a ground cable connected) and the 
QJ71C24N are connected with an RS-232 cable, 
the QJ71C24N and the personal computer may 
cause a failure due to the potential difference of the 
QJ71C24N and the personal computer. 

When the QJ71C24N and a personal computer are 
connected, ground the ground cable of the personal 
computer first, then connect the RS-232 cable. If a 
personal computer with no ground cable is used, 
check whether it has shock protection with no earthing 
(grounding) cable. Ensure to use a personal computer 
with shock protection. 
Alternatively, use a battery-driven personal computer. 
(For more details, refer to the Mitsubishi programmable 
controller TECHNICAL BULLETIN No. PLC-D-464.) 

E
xa

m
pl

e 
7 

QJ71C24N 
QJ71C24N-R2 

QJ71C24N Personal computer

COM port

Frame Leakage current

Potential is
generated

AC
adapter

E
xa

m
pl

e 
8 

QJ71C24N 
QJ71C24N-R4 

When a relay device (intrinsically safe 
explosion-proof interface) is connected 
between the QJ71C24N and the measuring 
equipment, normal communication becomes 
unavailable. 

Remove the relay device and connect the 
QJ71C24 and the measuring equipment 
directly. 
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(From the previous page) 

 

 

 

 

 Product model Trouble symptom Measures 

Because the communication cable and the 
power cable are bundled together, 
communication becomes unstable when the 
servo turns ON. 

Separate the communication cable and the 
power cable. 

E
xa

m
pl

e 
9 

QJ71C24N 
QJ71C24N-R2 
QJ71C24N-R4 

Programmable controller

RS-232C cable

Terminal

Ground (FG)

Servo amplifier

Power cable

Separate a communication
cable and a power cable

Motor

 

E
xa

m
pl

e 
10

 

QJ71E71-100 

A self-made communication cable is used, 
causing the deformation of contact pins of a 
10BASE-T connector. After that, 
communication error occurs due to poor 
contact between the communication cable 
and the connector part. 

Replace the module, and use a genuine cable 
specified by Mitsubishi as a communication 
cable. 

E
xa

m
pl

e 
11

 

QJ71E71-100 

Communication error occurs in Ethernet 
communication because noise prevents data 
from being received correctly. 

(1) Ground the shield of the communication 
cable. 

(2) Use a HUB designed for FA. 
(3) Ground the power supply of the HUB. 
(4) Separate the communication cable from 

the main circuit and the power cable. 
(5) When a non-shielded twisted pair cable is 

used, replace it with a shielded twisted 
pair cable. 
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6.11 Sequence Program Troubles 

Using ladder monitor, check the relevant ON/OFF status in the program as well as 
whether program errors like the following exist or not. 
 
(1)  Example of normally open/closed contact program error 

When an external stop switch is a normally closed contact, because 
programming is done as a normally closed contact, a stop normally closed 
contact becomes non-conductive and it cannot be started. 

Y70
Start

Y70

Stop Start output

Normally open contact is correct.

 

 
(2)  Example of device number program error 

Because a start-up Y70 self-holding circuit is programmed as Y07, self-holding 
cannot be done. 

Y70
Start

Y7

Stop Start output

Y70 is correct.  

 
(3)  Example of interlock program error 

It does not work when a move-forward command and a move-back command 
turn ON. 

 

Y70

Advance
command Advance output

Y71
Backward output

Y71

Y70

Normally closed contact are correct for these interlocks.

Advance
end LS

Backward
command

Backward
end LS

 

 
(4)  Example of operation program error, such as four arithmetic operations 

Multiply C55 by 30 and output the result to the digital HMI (Human Machine 
Interface).  
Because D50 is 32-bit data and exceeds 32767, a 4-digit BCD conversion 
instruction is not available.  
(An operation result of integration of 16-bit and 16-bit may exceed 32767.) 
Operation
condition

Using a DCCD D50 K8Y40 conversion instruction is correct.

K4Y40D50BCD

D50K30C55*P

Execution
instruction
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(5)  Example of program jump destination error by a CJ and CALL instruction 
Programming of jump destination pointer P5 is forgotten. 

X0

X3

M2

M7
Y77

No Pointer P5

END

P5CJ

 

 
(6)  Example of TO instruction program error 

Because there is a mistake in a TO instruction when the Q62DA conversion 
module is mounted to X/Y0A0, analog output cannot be done. 

X0 X0A1

Upper two digit H0A is correct for a mounting address.

K1K0H0A0TOP

D10K4X20BINP

D10
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Project name QHOZEN
6.12 Practical Training in Case of Error 

This document is intended for training of reading error descriptions and taking actions 
by operating a personal computer (with GX Works2). Use the [Project Name: 
QHOZEN] sequence program for training.  
There are training operations from Training 1 to Training 13. Follow instructions for the 
operations. 

 
6.12.1 Training 1 I/O Number Assignment Mistake Using Personal Computer with GX Works2 

Check faults when the parameter I/O number setting differs from that of the mounted 
module using a personal computer with GX Works2. 
 
(1) Assign a slot to 16 inputs according to the following operations. 

 
<Operation> 
(a)  Double-click "Parameter" → "PLC parameter" in the project data list. 

 

(b)  Click the "I/O assignment setting" tab of the Q Parameter Setting dialog box. 
(c)  Assign a slot as follows.  

 "Type": Input, "Model Name": QX42, "Points": 16 points 

 

(d)  Click the  End Setting  button. 
(e)  Set the CPU to STOP. 
(f)  Click  (Write to PLC) on the toolbar. 
(g)  On the Write to PLC dialog box, click to select "Parameter" → "Network/remote 

password/switch setting" and click the  Execute  button. 
(h)  A confirmation dialog box is displayed. Click the  Yes  button. 

 
(2) Set the CPU to RUN and turn ON X2. The current value of timers is not displayed 

in the digital HMIs (Human Machine Interfaces) for Y40 to Y4F. 
 
(3) Monitor the ON/OFF statuses of outputs Y40 to Y4F with the following operations. 

 
<Operation> 
(a) Click the [Online] → [Monitor] → [Device/Buffer Memory Batch] menu. 
(b)Input "Y40" in "Device" on the Device Batch Monitor dialog box. 
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(c) Click the  Start Monitoring  button. 

 

Turn on X2 and turn ON/OFF X0.  
The display shows that the values are normally output to Y40 to Y4F in the 
program.  
It is assumed that the current value of the timer is not output to the output 
module because of a problem other than the program. 

 
 

(4) Check that the number of I/O points matches that of the mounted I/O points with 
the following operation. 

 
<Operation> 
(a)  Click the [Diagnostics] → [System monitor]menu. 
(b)  On the System Monitor screen, check that the number of I/O points assigned in 

parameters matches that of the mounted I/O points. 
 

 
 

(5) Action 
Correct the I/O assignment for the parameters according to the mounted module. 

 
REMARKS  

The following examples show possible causes of mismatching between the I/O 
number and the mounted one. 
 Assignment of an I/O numbers is incorrectly set using the personal computer 

with GX Workers2. 
 Connector pins on the back side of the I/O module are bent or faulty. 
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(6) Set the CPU to STOP and restore the parameters to the original status before the 

next practical training with the following operations. 
<Operation> 
(a)  Double-click "Parameter" → "PLC parameter" in the project data list. 

 

(b)  Click the "I/O assignment setting" tab of the Q Parameter Setting dialog box. 
(c)  Click the  Default  button. 
(e)  A confirmation dialog box is displayed. Click the  Yes  button. 
(f)  Click the  End Setting  button. 
(g)  Click  (Write to PLC) on the toolbar. 
(h)  On the Write to PLC dialog box, click to select "Parameter" → "Network/remote 

password/switch setting" and click the  Execute  button. 
(i)  A confirmation dialog box is displayed. Click the  Yes  button. 

RESET CPU 
 
 

↓  

RUN CPU 

The current value of timers are not displayed  
in the digital indicators for Y40 to Y4F HMIs (Human 
Machine Interfaces). (Turn ON X2 and turn ON/OFF 
X0.) 
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6.12.2 Training 2 Operation Failure Due to Redundant Coil 

If there are two or more coils of the same device in a program, executing ON/OFF 
causes an operation failure. 
 
(1) Create a new project and then create the following program. 

 
 
(2) The ON/OFF status of Y70 cannot be changed by operation of X2. 
 
(3) Methods for checking redundant coils are described below. 
 
 Displaying coils in ladder programs 

(a)  Click  (read mode) on the toolbar to switch to the read mode. 

 
(b)  Press the following keys to search coils. 

F7  Y  7  0     
( ) 

 
 Reads the 

first coil 
Reads the 
second coil 

Reads the third coil 
(Displays "Search 
completed." when the 
third coil does not 
exist.) 

 
 Displaying coils in the list of used devices 

(a)  Click to select the [Search/Replace] → [List of used devices] menu. 
(b)  Input "Y70" in "Device" on the List of Used Devices dialog box. 
(c)  Click the  Search  button. 
 

[List of used devices] 

 

 
 Displaying coils in cross reference 

(a)  Click to select the [Search/Replace] → [Cross Reference] menu. 
(b)  Input "Y70" in "Device/Label" on the Cross Reference dialog box. 
(c)  Click the  Search  button. 
 

[Cross Reference] 

This result shows that the Y70 coil exists in two places, step 1 and step 3 of 
the MAIN program. 
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 Executing program check 

(a)  Click to select the [Tool] → [Check Program...] the menu. 
(b)  Click the  Execute  button. 
 

[Check Program...] 

 
This result shows that there are two Y70 coils. 

 
(4) Action 

Avoid the duplication of coils using an internal relay.  
Change the existing program to the following program. 

 
 
This change enables ON/OFF operation of Y70 with either X2 or X3. 
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6.12.3 Training 3 Jump Destination Error in Use of CJ instruction 

If there is no jump using a branch instruction, the CPU stops. 
Confirm the phenomenon. 
 
(1) Add the following program to the existing program. 

 

 

 
(2) Turn ON X4.  

An error occurs and the CPU will stop. 
 
(3) Read the error step and code with the following operation. 

 
<Operation> 
(a)  Click the [Diagnostics] → [PLC Diagnostics] menu. 
(b)  Check "Current Error" on the PLC Diagnostics dialog box. 

 

No. Current error 
Year/Month/

Day 
Time 

4210 CAN'T EXECUTE(P) 2013-10-1 9:10:11 
 

For details of errors, click the  Error Help  button on the PLC Diagnostics 
dialog box to display details of currently generated errors. 
 

(4) Reset the programmable controller CPU. 
(a)  Turn OFF X4. 
(b)  Press the RESET switch of the CPU to reset. 
 

(5) Action 
When programming with a CJ, SCJ, JMP, CALL, or CALLP instruction, be sure to 
insert the jump destination pointer "P3" as a label before the destination ladder. 
(a)  In the write mode ( ), select outside the left rail of the ladder just below the 

ladder of the added CJ instruction. 
 

 Change the existing program to the following program. 

 
 
(b)  Turn ON X4.  

No error will occur. 
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REMARKS  
 CAN'T EXECUTE(P) error occurs when a jump destination specified with a CJ, 

SCJ, JMP, CALL, or CALLP instruction does not exist.  
"A jump destination does not exist" means that the label from P0 to P4095 has 
not been input. 

 In use of a CJ, SCJ, JMP, CALL, or CALLP instruction, if the same label exists 
in a program, CAN'T SET(P) error occurs. 

 On GX Works2, CAN'T EXECUTE(P) and CAN'T SET(P) errors can be 
checked by the program check function ([Tool]→[Check Program...] menu) in 
advance. 

 After the timer coil turns on, the current value will not be updated even if the coil 
is moved by a jump instruction. 
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6.12.4 Training 4 BCD Code Error 

When the input data is not a BCD code at an execution of a conversion instruction 
(BIN, etc.) or when a value cannot be converted at an execution of a conversion 
instruction (BCD, etc.), an error occurs. 

 
(1) Add the following program to the existing program. 

 
X2SM400

D1K4X20BIN
 

 
(2) Change the digital switches X20 to X2F to various values until an error occurs.  

(BCD code error does not occur depending on the structure of digital switch.) 
 

(3) Read the error step and code with the following operation. 
 

<Operation> 
(a)  Click the [Diagnostics] → [PLC Diagnostics] menu. 
(b)  Check "Current Error" on the PLC Diagnostics dialog box. 

 

No. Current error 
Year/Month/

Day 
Time 

4100 OPERATION ERROR 2013-10-1 9:10:11 
 

For details of errors, click the  Error Help  button on the PLC Diagnostics 
dialog box to display details of currently generated errors. 
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(4) Read the program in the error step.  
There are two methods to read the program as follows. 
 Click the  Error JUMP  button on the PLC Diagnostics dialog box which read 

the error step in (3). 
 Read the error step by the device/buffer memory batch monitor. 

1) Click the [Online] → [Monitor] → [Device/buffer Memory Batch Monitor] menu. 
2) Input "SD4" in "Device Name" on the Device/Buffer Memory Batch Monitor 

dialog box and press . 

 

Error step 59 (BIN K4X20 D1) can be read. 
 
This instruction converts a BCD code into a binary code. When the data is not a 
BCD code, the error occurs. 
The cause is that the program constantly reads BCD-coded values of digital switches and 
hexadecimal codes A to F are generated when the values of the digital switches is 
changed. 

 
(5) Action 

Modify and make an addition to the program as follows so that signals other than 0 
to 9 will not be read.  
When a ladder with 12 contacts or more in a line is created as follows, the program 
automatically loops back (*1) and proceeds to the next line. (It is necessary to 
insert an empty line to loop the program back in advance.) 

 

 
 

REMARKS  
The following cases are examples of BCD code errors. 
 When BIN K4M0 D1 is executed, any of the contents of M0 to M15 is not a 

BCD code (binary-coded decimal). 

 When BCD D8 K4Y40 is executed, the content of D8 is a negative value or 
larger than 9999. 

 When DBCD D8 K8Y40 is executed, the content of D8 and D9, which is 32-bit 
data, is a negative value or larger than 99999999. 

 

*1 
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6.12.5 Training 5 BCD Instruction Error to Minus Data 

Check an error phenomenon when BCD instruction is executed to minus data. 
 
(1) Add the following program to the existing program. 

X2

X8

X7
D2D1MOVP

K4Y40D2BCD

D2K10D2-P

 
 

(2) With ladder monitoring, set the programmable controller to RUN, set X20 to X2F 
digital switches to 0050, turn ON X7, and turn ON/OFF X8 to decrease D1 in 
increments of 10. When D1 becomes minus data, BCD code error occurs. 

 
(3) Read the error step and code with the following operation. 

 
<Operation> 
(a)  Click the [Diagnostics] → [PLC Diagnostics] menu. 
(b)  Check "Current Error" on the PLC Diagnostics dialog box. 

 
No. Current error Year/Month/

Day 
Time 

4100 OPERATION ERROR 2013-10-1 9:10:11 
 

For details of errors, click the  Error Help  button on the PLC Diagnostics 
dialog box to display details of currently occurring errors. 
 

(4) Action 
Insert an interlock as follows so that BCD conversion is not carried out when D1 is 
minus data. 

 

X2

X8

X7

Interlock

D2D1MOVP

D2K0<= K4Y40D2BCD

D2K10D2-P
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6.12.6 Training 6 How to Use Failure Detection Annunciators (F) 

Upon an annunciator (F) receives the failure condition of an external signal, the F 
numbers to be turned ON are automatically stored in special registers (SD64 to SD79) 
depending on failures descriptions and the number of detected failures is stored in 
SD63. The contents can be output to an external HMI (Human Machine Interface) or 
read by the host computer. 
 
(1) Add the following program to the existing program. 

 

 

 
When X0 is turned ON, LEDR instruction can be executed to reset the memory. 
X9 and XA assume failure conditions of external failure signals such as "stroke limit 
signal", "blade breakage detection signal", and "arm breakage detection signal" 
and turn ON annunciators F. 
 

(2) Write the program to the CPU. 
 

STOP CPU 
 

(a)  Click  (Write to PLC) on the toolbar. 
(b)  Click the  Parameter + Program  button on the Write to PLC dialog box 

and then click the  Execute  button. 
(c)  A confirmation dialog box is displayed. Click the  Yes  button. 

RUN CPU 
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(3) Monitor special relays and special registers with the following operation.  
The display shows whether each annunciator (F) is ON, which annunciator turned 
ON first, and how many annunciators are ON. 

 
<Operation> 
(a) Click the [Display] → [Docking window] → [Watch window (1) to (4)] menu.  

* In this training, select (1). 
(b) The watch 1 window is displayed. Select the line to be edited, click the 

Device/Label field, and input the following devices. 
SM52 Turns ON when the battery voltage becomes lower than the 

specified level and turns OFF when it returns to normal. 
SM51 Turns ON when the battery voltage becomes lower than the 

specified level and remains ON even after it returns to normal. 
SM1 Turns ON when there is an error as the result of self 

diagnostic and remains ON even after the condition returns to 
normal. 

SM62 Turns ON when at least one annunciator F turns ON. 
SM63 Stores the number of annunciators F which have turned ON. 
SD64 Stores the number of the F that turned ON in the first place. 
SD65 Stores the number of the F that turned ON in the second 

place. 
SD66 Stores the number of the F that turned ON in the third place. 
SD67 Stores the number of the F that turned ON in the fourth place. 
SD68 Stores the number of the F that turned ON in the fifth place. 
SD69 Stores the number of the F that turned ON in the sixth place. 
SD70 Stores the number of the F that turned ON in the seventh 

place. 
SD71 Stores the number of the F that turned ON in the eighth place. 

(c) Click the [Online] → [Watch] → [Start Watching] menu. 
The following screen is displayed. Check the contents. 
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6.12.7 Training 7 Setting of Operation Mode When There Is an Error 

The operation of CPU after an error occurrence can be selected from "Stop" and 

"Continue" by setting a parameter. 

 

(1) Setting 
 

 

 

 
1) Double-click "Parameter" → "PLC 

parameter" in the project data list. 

 

2) On the "PLC RAS setting" tab, change 
"Operating Mode When there is an Error" → 
"Computation Error" to "Continue". 

 
3) Write the parameter to the programmable 

controller using the Write to PLC function to 
reset. 

 

(2) Operation check 

1) Turn ON XB and operate the digital switch (K4X30). 

2) When the numerical value changes from 7 to 8 or from 8 to 7, an error occurs. 

Check that the CPU does not stop even when the error occurs. 
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6.12.8 Training 8 Error Check and Error Clean from a Program Using SM and SD 

Errors can be checked and cleared by using special relays SM and special registers 

SD. 

 

● Error check 

The number of the occurring error is stored in [SD0] (diagnostic errors). The 

occurring error can be checked by displaying the current value. 

 

● Error clear 

(1) Checking special relays and special registers 
 

(1) Click!
 

 

 
1) Click "Help"→"GX Works2 Help" on the 

menu bar. 

 
 

2) Click "Special Relay/Register Help" → "Q 
series PLC (Q Mode)" → "Special register 
(Diagnostic information) [Numbers SD0 to 
SD183]" → "[Numbers SD50 to SD53]" → 
"[Number SD50] Error reset". 

 
3) Check the content of [SD50].  

(Also, check the content of [SM50] in the 
same way.) 

[SD50] (Error reset): Stores the number of the error to be cleared. 

[SD50] (Error reset): Clears the error. 
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(2) Operation check 

1) Turn ON XB and operate the digital switch (K4X30). 

2) When the numerical value changes from 7 to 8 or from 8 to 7, an error occurs. 

Check that the CPU does not stop even when the error occurs. 

3) Turn ON XC and check that the error LED turns off. 

 

 

 

6.12.9 Training 9 Saving of Error Histories 

The history of errors which have occurred can be saved in CSV format on the personal 

computer. 

 

(1) Operating procedure 
 

 

 

 
1) Click [Diagnostics] → [PLC Diagnostics] on 

the menu bar. 

 
 

2) Click "Create CSV file" on "Error History" to 
save a file on the personal computer. 

 

 

(2) Confirmation 

Open and check the saved file on the personal computer. 
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6.12.10 Training 10 Sampling Trace 

What is the sampling trace function? 

The sampling trace function sequentially collects contents of specified devices in the 

CPU module at a specified timing. 

Sampling trace samples contents of the specified devices at specified intervals 

(sampling cycle) and stores the trace results in a sampling trace file. 

 

Application of sampling trace 

During debugging, this function allows checking changes of the contents of devices 

used in a program at a specified timing. 

This function also reads contents of devices when a trigger condition is satisfied. 

 

POINT  

(1) Sampling trace files can be stored only in standard RAM and SRAM cards. 
(2) When storing a sampling trace file in standard RAM, check the versions of the 

CPU module and GX Works2. *1 

*1: CPUs whose the first five digits of the serial number are 07032 or later are supported 

 

First, follow the procedure below for preparation. 
 

 

 

 
1) Double-click "Parameter" → "PLC 

Parameter" in the project data list. 

 

2) On the "PLC RAS setting" tab, change 
"Operating Mode When there is an Error" → 
"Computation Error" to "Continue". 

 
3) Write the parameter to the programmable 

controller using the Write to PLC function to 
reset. 
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(1) Trace setting 
 

 

 

 
1) Click "Debug" → "Sampling Trace" → "Open 

Sampling Trace" on the menu bar. 

 

 

2) The Sampling Trace screen is displayed. 
 

 

(To the next page) 

3) Click the [Debug] → [Sampling Trace] → 
[Trace Setting] menu. 
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(From the previous page) 

 

 

 

4) Set the trace execution method as follows.  
 
Target memory: Standard RAM 
File name: MAIN 
Select "Execute after overwriting current 
trace setting in the PLC". 

 
5) Click the Condition Setting tab. 

 

(To the next page) 

6) Select "Detail Setting" in Trigger Condition 
Setting and set the Trace Count Setting as 
follows.  
 
Total Count: 8192 counts 
Count Before Trigger: 4096 counts 

 
7) Click the Setting Change button. 
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(From the previous page) 

 

 

 

 

8) The Detail Setting - Trigger Condition dialog 
box is displayed. Set the following items.  
In this case, set error occurrence as a trigger 
condition.  
Device/Label: SM0 
Condition: ↑ 

 
9) Click the End Setting button. 
 
10) The display returns to the Trace Setting 

dialog box. Click the End Setting button to 
close the dialog box. 

(12) Check!

 

 

11) On the Sampling Trace screen, set devices 
to be traced as follows.  
 
Bit device: X33, X32, X31, X30 
Word device: SD0 

 
12) Place a checkmark in the checkbox to 

display the trend graph of SD0. 

 
13) "SD0" is displayed in the trend graph field of the Sampling Trace screen. 
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(2) Trace execution 
 

 

 
1) Click the [Debug] → [Sampling trace] → 

[Start Trace] menu. 

 

 

2) The message on the left is displayed. 
Click the Yes button. 

 

 

 

3) When trace execution starts, the trace data 
storage condition screen is displayed.  
 
After checking that the Total Data reaches 
100%, turn ON XB and operate the digital 
switch (K4) to change 7 to 8 (or 8 to 7).  
 
The trigger condition is satisfied by the error 
occurrence. 

 

 

4) The trace result is displayed on the 
Sampling Trace screen. 
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(3) Trace result 
 

 

 

 
1) Scroll down to the trigger point and check 

that the device value at the time of error 
occurrence. 

 

2) Click the [Debug] → [Sampling trace] → 
[Export CSV Data] menu to display a dialog 
box to save the trace data on the personal 
computer.  
 
The saved data can be processed and used 
for operation check, etc. on a personal 
computer. 

 

REMARKS  

Turning ON SM722 prevents occurrence of OPERATION ERROR at the execution 
of BIN or DBIN instruction. 
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6.12.11 Training 11 Scan Time Measurement 

Scan time within the range of specified steps can be measured. 

 

(1) Setting 
 

 

 

 
1) Switch to the monitoring mode. 
 
2) Click "Debug" → "Scan Time Measurement" 

on the menu bar. 
 

 
 

3)  Set the measurement range as follows.  
 
Start Step: 0 
End Step: Step number of END instruction 
-1 

 
4) Click Start. 

  

 

(2) Operation check 

Check the change of scan time.  

Check that scan time changes depending on instruction execution and 

non-execution in the program. 
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6.12.12 Training 12 Remote Operation 

Remote operation changes the CPU module operating status with external operations. 

 

Remote operation RUN/STOP
state RUN STOP PAUSE RESET Latch clear 

RUN RUN STOP PAUSE 
Cannot be 
operated 

Cannot be 
operated 

STOP STOP STOP STOP RESET Latch clear 

*: Remote RESET requires a parameter setting. 

 

(1) Remote RUN/STOP/PAUSE/latch clear 
 

 

 

 
1) Click "Online" → "Remote Operation" on the 

menu bar. 
 
 
 

 
 

2) Select the operating status to be executed 
from the "Operation" list box and click the 
"Execute" button. 

 
*:  Remote latch clear can be executed only 

when the CPU is in the STOP state. 
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(2) Remote RESET 
 

 

 

 
1) Double-click "Parameter" → "PLC 

parameter" in the project data list. 
 
 
 

 

 

2) Place a checkmark in the checkbox 
"Remote Reset" on the "PLC System 
Setting" tab to permit remote reset operation.

 
3) Write the parameter to the programmable 

controller using the "Write to PLC" function 
to reset. 

 

 

4) Select "RESET" from the "Operation" list box 
and click the "Execute" button. 

 
*: Remote RESET clear can be executed only 

when the CPU is in the STOP state. 
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6.12.13 Training 13 Forced On/Off Function for External I/O 

Select [Debug] → [Modify Value] on GX Works2 to forcibly turn ON/OFF external input 

and output. 

Registered forced ON and OFF information can be cleared by operation on GX 

Works2. 

*  Alternatively, selecting [Debug] → [Forced Input and Output Registration/Clear] to 

forcibly turn ON/OFF external input and output. 

 

Behaviors of devices at forced ON/OFF 

Forced ON/OFF registration allows forced ON (Register Forced ON), forced OFF 

(Register Forced OFF), and clear of forced ON/OFF (Clear Registration).  

The behaviors of devices at forced ON, forced OFF, clear of forced ON/OFF are 

shown below. 

  
Operation Behavior of input (X) Behavior of output (Y) 

At clear (no operation) 
Executes operations of sequence 
programs by external input. 

Externally outputs operation results of 
sequence programs. 

ON 
Processes operations of sequence 
programs in the forced ON status. 

Externally outputs "ON" regardless of 
operation results of sequence 
programs. 

OFF 
Processes operations of sequence 
programs in the forced OFF status. 

Externally outputs "OFF" regardless of 
operation results of sequence 
programs. 

 

The behaviors of devices forcibly turned ON/OFF are shown below. 

Y10

M1

Y11

END

M0

X0

Y10

(OFF)

(ON)

(Y10 OFF)

(X0 ON)

Y10

M1

Y11

END

Forced ON/OFF operation for output

Forced ON/OFF operation for input

Output refresh

Input refresh

Sequence execution

External input performs
forced OFF operation

It turns on on the ladder even if it is
turned OFF forcibly (external output
is off)

Y10 device forced OFF

X0 device forced OFF

Y10 output

X0 input

External output

External input
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Checking the forced ON/OFF and clear status 

The statuses of forced ON/OFF and ON/OFF inversion can be checked on GX 

Works2. 

When at least one device is registered in "Forced Input Output Registration/Clear", the 

status can be checked by the MODE LED. (The MODE LED flashes.) 

In the case of Universal model QCPU, the status can be checked by a special register 

(SD849). 

 

Forced ON/OFF registrations can be cleared by any of the following operations. 

 Power-on → Power-off 

 Reset by RESET/L.CLR switch or RUN/STOP/RESET switch of the CPU module 

 Reset by remote reset operation 
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(1) Setting 
 

 

 

 
1) Switch GX Works2 to the monitoring mode. 
 
2) Click "Debug" → "Forced Input Output 

Registration/Cancellation" on the menu bar. 
 

 

 

3) Input "XD" in the Device field and click the 
"Register Forced ON" button.  
 
The device XD is in ON status regardless of 
ON/OFF status of the external input XD. 
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4) Input "Y79" in the Device field and click the 
"Register Forced ON" button.  
 
The device Y79 is in ON status regardless of 
operation result of the device Y79. 

 

 

5) Check that the MODE LED of the CPU is 
flashing. 

 
6) Click the "Batch Clear Registration" button. 
 
7) Check that the MODE LED of the CPU is 

turned ON. 
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6.12.14 Sequence Program 

Sequence program
Operation failure due to duplicated coil

Jump destination error in use of CJ instruction

BCD code error

BCD instruction error to minus data

How to use failure detection annunciators (F)

Operation mode setting when there is an error
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Sequence program
Error check and error clean from a program using SM and SD

Forced ON/OFF function for external I/O
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Chapter 7 Improvement Maintenance 

In order to improve serviceability of production systems, it is necessary to reduce 
deterioration of equipment and make maintenance work easier. 

 
7.1 Equipment Serviceability Improvement 

(1)  Improvement for reducing deterioration of equipment 
1)  Review the working environment and carry out improvements such as 

provision of ventilation and air-conditioning so that the equipment does not 
deteriorate abnormally. 

2)  Carry out improvements for preventing abnormal deterioration of equipment by 
taking dust-proof, moisture-proof, and anti-vibration measures. 

3)  Replace any equipment estimated to deteriorate faster with ones with higher 
durability. 

 
(2)  Carry out improvement to make repair easier 

1)  Improve the equipment structure. 
2)  Carry out improvements to secure a repair space. 
3)  Change to products that can be easily repaired. 

 
(3)  Change to products with fewer failures 

(1)  Change to products with a low failure rate and high reliability. 
 

7.2 Improving Automatic Detection of Equipment Failure 

(1)  Detection with sequence programs 
Change sequence programs so that equipment failures can be detected 
automatically. 

 
<Program example> 
When an LS configured at the limit end is a normally closed contact, an 
equipment failure is automatically detected with the following ladder because the 
forward end LS and the backward end LS cannot be non-conductive at the same 
time. 
 

Y70
Y71

Y71
Y70

Y73
SM412

Advance
command

Backward
command

Advance
end LS

Backward
end LS

Backward
end LS (1 second clock) Equipment failure

detection

Backward
output

Advance
output

Advance
end LS
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7.3 Enhanced Condition Monitoring-based Maintenance 

This section introduces four examples that automatically display or notify of error 
definitions to improve the function always monitoring the status of the equipment 
controlled by the programmable controller. 

 
Example 1 Displays detected error descriptions in a character message 

 
Character 

display 
 

 

Connect the GOT to the programmable controller and display a message 
corresponding to detected error descriptions. 

 

No.1 95

No.2 58

GOT

Error
occurred!

Messages registered in advance are
displayed for each error detection
signal and error code number.

Error 1 detected

Error 2 detected

 

 
Example 2 Announces voice message of detected error descriptions 

 
Voice 

announce
ment 

 

 

Connect the GOT to the programmable controller and announce voice messages, 
etc. that have been prerecoded using a microphone from a speaker when an 
error is detected. (A voice output module and external amplifier speaker are 
separately required.) 

 

No.1 95

No.2 58

GOT

Error
occurred!

Messages registered in advance are
announced from a speaker for each
error detection signal and error code
number.

Error 1 detected

Error 2 detected

External
amplifier speaker

Error is detected!
Investigate the

error.
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Example 3 Prints out detected error descriptions 
 

Printing  
 

Connect a printer to a programmable controller unit that enables the print output 
and print out error messages and error times. 

 
 

'04-04-01

Printer

Fuse blown

Error detection

Program to print out a
message

A message is printed out

 

 
The MELSEC-Q offers various types of intelligent function modules and GOTs that can 
be connected to a printer. 

Modules that enable the print output Printer type 
QJ71C24(N) serial communication 

QJ71C24(N)-R2 serial communication 
QD51 serial communication 

QD51-R24 intelligent communication 

RS-232C compliant 

GOT1000 series (GT15-PRN) PictBridge-compatible printer 
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Example 4 Sends detected error descriptions by email 
 

 
E-mail  

 

Connect an Internet connectable network cable to the Web server module of the 
programmable controller and send detected error contents to cellular phones and 
personal computers by e-mail. 

 

E-mail is sent when
an error is detected

A web server module
monitors collected data

Error is detected!
The temperature
has become higher
than the specified
value.Internet

 

It is also possible to monitor device data, etc. collected by the Web server module 
on the cellular phones and personal computers via the Internet. 
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Chapter 8 Reviewing Installation Environment 

8.1 Environment 

Install the programmable controller while avoiding the following environments: 

(1)  Location where the ambient temperature (for a panel, in-panel temperature) 
exceeds the range of 0 to 55°C 

(2)  Location where the ambient humidity exceeds the range of 5 to 95% RH 

(3)  Location where a sudden change in temperature causes condensation 

(4)  Location where there is corrosive gases or combustible gases 

(5)  Location where there are many or much conductive powders such as dust 
and iron powders, oil mist, sodium, or organic solvent(s) 

(6)  Location which receives direct sunlight 

(7)  Location where a high electric or magnetic field is generated 

(8)  Location where a vibration or shock can be transmitted directly to the main 
unit 

 
8.2 Electrical Environment 

(1)  The fluctuation range of power supply 100 V AC or 200 V AC shall be within a 
range of -15% to +10%.  
(For 24 V DC (Q63P), it shall be within a range of -35% to +30%.) 

(2)  Instantaneous power failure 
If it lasts for 20 ms or shorter, the operation can continue.  
(For 24 V DC (Q63P), if it lasts for 10 ms or shorter, the operation can 
continue.) 

(3)  Power supply waveform distortion 
It shall be a sine wave and its distortion rate shall be within 5%. Take heed of 
an electric power capacitor and rectifier. 

(4)  Wire it as far from a power cable and large-current wire as possible.  
The distance when they are placed in parallel shall be 100 mm or more. 

(5)  Do not place it in a panel containing a noise generating equipment, too.  
Install a high frequency equipment, inverter, and electric discharge machine 
in a separate panel as far as possible. Separate the wiring. 

(6)  Install it as far from the equipment generating an arc when it is opened and 
closed, such as an electromagnetic contactor and breaker, as possible. 

 
Figure 8-1 Layout in the Control Panel 

Power supply

Programmable
controller

Input Output

Auxiliary relay

Junction terminals

Main circuit parts
such as an
electromagnetic
contactor

Branch
breaker

Main
circuit

breaker
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8.3 Mounting Condition 

This section describes the installation precautions and installation position of the 
programmable controller. 
When installing a programmable controller in a panel, fully consider the usability, 

maintainability, and environmental resistance.  
 

(1)  Module mounting position 

To improve the ventilation and facilitate the module replacement, maintain the 

following distance between the top/bottom of the module and the structure or 

parts. 

(a) For the main base unit and extension base unit 
 

Position of the ceiling of an
enclosure, a wiring duct, or a part.

30 mm or
more *1

30 mm or
more *1

20 mm or
more *3

5 mm or more *2 5 mm or more

Enclosure Door

Programmable
controller

 
 

*1:  This applies if the height of the wiring duct is 50 mm or lower. Otherwise, the 

distance shall be 40 mm or more. 

*2:  When mounting an extension cable without removing an adjacent module, 

the distance shall be 20 mm or more. 

*3:  For the connector type, the distance shall be 80 mm or more.  

For a network module, maintain the distance considering the F-type 

connector or cable bending radii. 
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(b)  For the slim type main base unit 
 

Position of the ceiling of an
enclosure, a wiring duct, or a part.

30 mm or
more *1

30 mm or
more *1

20 mm or
more *3

17 mm or more *2 5 mm or more

Enclosure Door

Programmable
controller

 
 

*1:  This applies if the height of the wiring duct is 50 mm or lower. Otherwise, the 

distance shall be 40 mm or more. 

*2:  The slim type main base unit will have the wiring of the power supply module 

come out from the left end of the module. To reserve wiring space, install the 

unit apart from the end by 17 mm or more. Additionally, if the structure, 

equipment, or part on the left side of the unit can damage the coating of 

electric wires, protect them with insulators such as a spiral tube. 

*3:  For the connector type, the distance shall be 80 mm or more.  

For a network module, maintain the distance considering the F-type 

connector or cable bending radii. 

 

(2)  Module mounting direction 

(a)  For heat dissipation, use the programmable controller in the mounting 

direction shown in the following figure, which ventilates the controller well. 
 

 

 
(b) Do not use the module in the mounting direction in the following figure. 

 

Vertical mounting Horizontal mounting  



 

8 - 4 

 

(3)  Installation surface 

Install the base unit on a flat surface.  

The uneven installation surface will apply an excessive force to the printed-circuit 

board, causing trouble. 

 

(4)  Coexistence with other equipment 

Avoid the co-existence with sources of vibration such as a large electromagnetic 

contactor and fuse circuit breaker, and install the base unit in another panel or 

apart from them. 

 

(5)  Distances from other instruments 

To avoid the impact of radiation noise and heat, maintain the following distance 

between the programmable controller and instruments (contactors and relays).  

 From instruments mounted on the front side of the programmable controller: 

100 mm or more 

 From instruments mounted on the right and left sides of the programmable 

controller: 50 mm or more 
 

100 mm or more

Conductor, relay, etc.

50 mm or more

50 mm or more
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8.4 Wiring 

8.4.1 Wiring Precautions 

WARNING
 
●  Be sure to switch off all phases of the external power supply 

used by the system before wiring work. Failure to do so may 
cause electric shock or damage the product. 

●  When turning on the power and operating the module after 
wiring is completed, always attach the enclosed terminal cover. 
The absence of the terminal cover can cause electric shock. 

 

CAUTION
 
●  Be sure to ground the FG and LG terminals of the programmable 

controller with the ground resistance of 100Ω or less for the 
exclusive use. Failure to do so may cause electric shock or 
malfunction. 

●  Before wiring the module, confirm the rated voltage and terminal 
layout of the product to wire correctly.  
Input of voltage or connection to a power supply with different 
ratings, or incorrect wiring of them may cause fire or failure. 

●  Crimp or solder external connectors correctly using tools 
specified by the manufacturer.  
Incomplete connection may cause short-circuit, fire, or 
malfunction. 

●  Tighten the terminal screws within the specified torque range.  
A terminal screw that has been tightened too loosely may cause 
short-circuit, fire, or malfunction.  
A terminal screw that has been tightened too tightly may cause a 
drop, short-circuit, or malfunction due to the screw or module 
breakage. 

●  Be careful to prevent foreign matter such as sawdust or wiring 
chips from entering the module.  
Failure to do so may cause fire, failure, or malfunction. 

●  The top surface of the module is covered with protective film to 
prevent foreign matter such as wiring chips from entering the 
module when wiring.  
Do not remove this film during wiring.  
Before operating the system, be sure to remove this film to 
dissipate heat. 

 

The following description is of the precautions for wiring power cables. 
 

(1)  Wiring the power supply 
(a)  Wire the programmable controller power supply, I/O equipment, and motor 

equipment in different systems as follows:  
When there are many noises, connect an isolation transformer. 

T1

200 V AC

Main power supply

Isolation
transformer

Programmable
controller

power supply
Programmable
controller

I/O power supply

Main circuit equipment

Main circuit
equipment

I/O equipment
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(b)  Do not connect the 24 V DC outputs of multiple power supply modules in 
parallel to supply the outputs to one I/O module.  
Parallel connection may break down the power supply module. 

Power supply module

24 V DC

24 V DC 24 V DC

I/O module Power supply module I/O module

External
power supply

 

(c)  Twist 100 V AC wire, 200 V AC wire, and 24 V DC wire as closely as 
possible, and use them to connect modules in the shortest distance.  
Also, use as thick a wire (MAX. 2 mm2) as possible to lessen the voltage 
drop. 

 
(d)  Do no bundle or adjacently place the100 V AC wire and 24 V DC wire with 

the main circuit (high voltage, large current) wire and I/O signal line. Keep a 
distance of approximately 100 mm or more between them. 

 
(e)  As a measure against surge for lightening, connect the surge absorber for 

lightening as shown in the following figure. 

AC

E1

E2

←

Programmable
controller I/O
equipment

Surge absorber for
lightening

 

POINT  

(1)  Separately ground the surge absorber for lightening (E1) and the 
programmable controller (E2). 

 
(2)  Select a surge absorber for lightening that would not exceed its maximum 

allowable circuit voltage even when line voltage is maximum. 
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(2)  Wiring the I/O equipment 
(a)  The solderless terminal with an insulation sleeve cannot be used in the 

terminal block.  
It is recommended to put a mark tube or insulation tube on the cable 
connection part of a solderless terminal. 

 
(b)  For a cable connected to the terminal block, use a cable having a core of 0.3 

mm2 to 0.75 mm2 and outer diameter of 2.8mm or less. 
 

(c)  Set up a wiring route separately from the I/O cables and output cables. 
 

(d)  When those cables cannot be separated from the main circuit line or power 
cable, use the batch shield cable and ground it on the programmable 
controller side.  
However, in some cases, ground it on the opposite side. 

DC

RA

Programmable controller
Shielded cable

Shield coating

Input

Output

 

(e)  When piping and wiring, ground the pipes securely. 
 

(f)  Separate the 24 V DC input wire from the 100/200 V AC wires. 
 

(g)  The long distance wiring of 200 m or more causes trouble caused by a 
leakage current due to the line capacity. 

(h)  Provide a means of using a switch to individually disconnect an external 
power supply of a module relevant for the online module change, in order to 
avoid electric shock or malfunction of an operating module. 

 

(3)  Grounding 
For grounding, perform steps (a) to (c) below: 
 
(a)  Use the independent grounding as much as possible.  

Ground with the grounding resistance of 100 Ω or less. 
 

(b)  If the independent grounding cannot be performed, conduct "(2) Shared 
grounding" in the following figure. 

Programmable
controller

Programmable
controller

Programmable
controller

Another device

Ground resistance
of 100 Ω or less

Ground resistance
of 100Ω or less

Another device Another device

(1) Independent grounding......Ideal (2) Shared grounding......Acceptable (3) Common grounding......Not acceptable 

(c)  Use cables with a cross-sectional area of 2 mm2 or thicker for grounding.  
Set the grounding point as close to this programmable controller as possible, 
and shorten the length of the ground cable. 
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8.4.2 Wiring Power Supply Module 

This section illustrates wiring examples of the power cables and ground cables, etc. 

used to connect the main base unit and extension base unit. 

(1)  For a stand-alone power system 

100/110 V AC

Fuse

Extension cable I/O module

Extension base unit
(Q68B)

24 V DC

Main base unit
(Q38B)

CPU module

Connect to the 24 V DC
terminal of modules that
require 24 V DC inside
of the I/O module

100 V AC

Ground cable

*1: The following is the operation of the ERR terminal.
<When a power supply module is mounted to a main base unit>
It turns OFF (opens) when an AC power is not supplied, when a CPU module stop error (including reset) occurs,
or when the fuse of the power supply module is blown.
<When a power supply module is mounted to a extension base unit>
It is alway OFF (open).

*2: Short-circuit between the LG and FG terminals using a ground cable as thick and short as possible (Ø2 mm),
and ground it.

Grounding

 

POINT  

(1)  The power cables for 100/200 V AC and 24 V DC shall be as thick cables as 
possible (a maximum of 2 mm2) and shall be twisted from a cable connected 

terminal. For the terminal block wiring, be sure to use solderless terminals. Use 
the solderless terminal with an insulation sleeve that has a thickness of 0.8 mm 
or less in order to prevent short-circuit when screws get loosened. In addition, 
connect up to two solderless terminals for one terminal area. 

Solderless
terminal with an
insulation sleeve

Terminal block

 

 
(2)  If the LG terminal is connected to the FG terminal, do not forget to perform 

grounding. If the grounding is not performed, the system will be susceptible to 
noise. Because the LG terminal has half as high a potential as the input 
voltage, touching the terminal area may cause electric shock. 

 
(3)  The ERR terminal on the extension base unit cannot detect errors from the 

system. (The ERR terminal is always turned OFF.) 
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(2)  For a redundant power supply system 

＊2 ERR 端子の動作は以下のとおりです。
＜電源二重化基本ベースユニットに二重化電源ユニットを装着した場合＞
AC 電源未入力時，CP U ユニット停止エラー（リセット時を含む）発生時，二重化電源ユニットのヒューズ断時，ま
たは二重化電源ユニット故障時にOFF（開 放）となります。
＜電源二重化増設ベースユニットに二重化電源ユニットを装着した場合＞
AC 電源未入力時，二重化電源ユニットのヒューズ断時，または二重化電源ユニット故障時にOFF（開 放）となりま
す。

＊3 電源二重化基本ベースユニットに装着した二重化電源ユニットと電源二重化増設ベースユニットに装着した二重化電
源ユニットの入力電源を同時に供給した場合，電源二重化基本ベースユニット上のERR 端子のON（短絡）タイミン
グは，CP Uユニットのイニシャル処理時間の分，電源二重化増設ベースユニット上のERR 端子のON（短 絡）より
遅くなります。

＊4 LG 端子とFG 端子は可能な限り太く短い接地線（φ2mm）で 短絡し，必ず接地してください。

接地線

増設ケーブル

接地

入出力ユニット

電源二重化基本ベースユニット

電源二重化増設ベースユニット

接地線

接地

Extension cable
I/O module

Redundant power extension base unit
(Q68RB)

Redundant power main base unit
(Q38RB)

CPU module

Ground cable

*2: The following is the operation of the ERR terminal.
<When a redundant power supply module is mounted to a redundant power main base unit>
It turns OFF (opens) when the AC power is not supplied, when a CPU module stop error (including reset) occurs,
when the fuse of the redundant power supply module is blown, or when redundant power supply module failure
occurs.
<When a redundant power supply module is mounted to a redundant power extension base unit>
It turns OFF (opens) when the AC power is not supplied, when the fuse of the redundant power supply module is
blown, or when redundant power supply module failure occurs.

*3: When both input powers of the redundant power supply modules mounted on the redundant power main base
unit and the redundant type extension base unit are supplied simultaneously, the ON (short-circuit) timing of the
ERR terminal on the redundant power main base unit is delayed from that of the redundant type extension base
unit by the time of the initial processing of the CPU module.

*4: Short-circuit between the LG and FG terminals using a ground cable as thick and short as possible (Ø2 mm),
and ground it.

Grounding

System A System B

Ground cable

Grounding
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POINT  

(1)  The power cables for 100/200 V AC and 24 V DC shall be as thick cables as 
possible (a maximum of 2 mm2) and shall be twisted from a cable connected 

terminal.  
For the terminal block wiring, be sure to use solderless terminals.  
Use the solderless terminal with an insulation sleeve that has a thickness of 
0.8 mm or less in order to prevent short-circuit when screws get loosened.  
In addition, connect up to two solderless terminals for one terminal area. 

Solderless
terminal with an
insulation sleeve

Terminal block

 

 
(2)  Supply the power to the redundant power supply modules via respective 

systems (duplicate the power system). 
 

(3)  If two redundant power supply modules (Q64RP) are operated in parallel as a 
redundant power supply system, it is recommended to use one redundant 
power supply module to input the AC power supply and the other to connect an 
uninterruptible power supply (UPS). 

 
(4)  If the LG terminal is connected to the FG terminal, do not forget to perform 

grounding.  
If the grounding is not performed, the system will be susceptible to noise.  
Because LG terminal has half as high a potential as the input voltage, touching 
the terminal area may cause electric shock. 
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Chapter 9 Measures against Noise 

9.1 Common Mode Noise and Normal Mode Noise 

The causes of troubles occurring while operating the programmable controller include 
malfunction and stop due to noise. 
Measures against noise are essential to maintenance of the programmable controller. 
In general, the common mode noise impacts the programmable controller more 
significantly than normal mode noise. This is because the normal mode noise is line 
noise that can be filtered out while the common mode noise depends on the floating 
capacitance that disables it to be easily filtered out. It is also because the measures 
against normal mode noise can be taken even by the user while common mode noise 
immunity is a feature that the manufacturer built in, which the user cannot take an 
effective measure against the actual programmable controller. 

 
9.2 Common Mode Noise 

The following figure illustrates the concept of common mode noise. 
 

Cs

Cs

Cs

Cs

L

Programmable controller

Input

Power supply

Grounding

Noise source Noise source

Cs: Floating capacitance

Internal

circuit
Output

 

Figure 9-1 Common Mode Noise 

 
Common mode noise may cause malfunctions when the internal circuit is affected by a 
potential different generated between the grounding (ground) and the power supply or 
the I/O signal wire due to noise induced from other wires to each wire, induced voltage 
with high potential, radio waves, or static electricity. 
This is because the floating capacitance between each external signal and the internal 
circuit causes electric charge and discharge, resulting in sudden changes in the 
internal circuit voltage. 
Programmable controllers with a metal case is said to be more susceptible to common 
mode noise due to floating capacitance Cs. 
In addition, grounding is important because it is also a measure against common mode 
noise. 
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9.3 Normal Mode Noise 

The following figure illustrates the idea of normal mode noise. 
 

L

Programmable controller

Input

Power supply

Grounding

Noise source
Noise source

Noise source

Output

 

Figure 9-2 Normal mode noise 

 
Most of normal mode noise is generated by the back EMF of inductive load applied to 
the power supply, input and output cables. For a power supply, normal mode noise is 
generated from the instrument connected to the power supply system. On the other 
hand, for an output cable, normal mode noise is generated from the instrument 
controlled by the programmable controller. All these noises are also referred to as line 
noises, too.  
Consequently, the user can easily take measures against this noise such as 
suppressing it in the instrument generating the noise, filtering it out in the programmable 
controller, and installing a transformer and surge (noise) suppressor. 
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9.4 Measures against Noise in External Input Signal CableH 

(1) When an inductive load is connected in parallel with the input module of a 
programmable controller, as in the following figure, connect a CR surge suppressor 
for alternating current input and a flywheel diode for direct current input, both in 
parallel with each load. Connect the surge suppressor as close to the inductive 
load as possible. 

 

C

R

AC DC

D

Programmable controller Programmable controller

Input

CR: Surge suppressor D: Flywheel diode

(1) AC input (2) DC input

InputL
Load

L
Load

Common Common

 

Figure 9-3 When There Is an Inductive Load in Parallel with Input 

 
(2) In the following cases, take measures against induced voltages as in the figure 

below: 
 When an external wiring is 200 m or more long 
 When a built-in operation indication neon lamp or an opened contact of a limit 

switch generate a voltage because of the current of the neon lamp 
 When an induced voltage is high for alternating current input signal 

 

DC

AC AC Z RA

AC

RA
Programmable controller Programmable controller Programmable controller

Input Input Input

Z: Dummy resistor or CR
surge suppressor RA: Auxiliary relay

(1) Input power supply DC
conversion

(3) Making a relay circuit
using a relay

(2) Connection of dummy
resistor or CR surge
suppressor

Common Common

 

Figure 9-4 Measures against an Induced Voltage for Input 
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9.5 Measures against Noise in External Output Signal Cable 

(1) For an inductive load for an alternating current, connect a CR surge suppressor to 
the both ends of the load, because noise is generated by an inrush current when 
an output signal is turned OFF and ON and by back EMF when the signal is turned 
ON and OFF and because arc noise is generated by a contact such as an 
electromagnetic contactor.  
Use a CR surge suppressor with 0.5 μF + 47 Ω if its specifications are up to about 
400 VA for 100/200 V AC. This CR surge suppressor will not be effective unless it 
is connected most close to the load. 

 

0.47μFC

R 47Ω

AC

Programmable controller

Output

Place CR near the load

L
Load

 

Figure 9-5 Measures against Noise in Alternate Current Inductive Load 

 
(2) For a direct current inductive load, connect flywheel diodes across the load. Ensure 

to connect these diodes most close to the load. The diodes should have four or 
more times as high a reverse breakdown voltage as the load voltage.  
Connecting flywheel diodes to the direct current inductive load causes the load 
operation to be delayed due to the current flowing through the diodes during 
shutdown. When this delay matters, connect a CR surge suppressor as in the 
alternate current measures described above. 

 

D

DC

Programmable controller

Output

Place D near the load

L
L

oa
d

 

Figure 9-6 Measures against Noise in Direct Current Inductive Load 
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(3) When an external contact opens and closes a load connected to programmable 
controller output, ensure to take the measures in the following figure, whether or 
not the programmable controller provides measures against noise. 

 

AC

C

R
D

DC

Programmable controller Programmable controller

LS (external contact)

(1) For AC (2) For DC

LS (external contact)

L
Lo

ad

L
Lo

ad

 

Figure 9-7 When an External Contact Opens and Closes a Load 

 
(4) For an alternating current inductive load where a large amount of noise is 

generated during shutdown, effective will be the opening and closing of it at a triac 
that will be shut down by the load current. 

(5) For arc noise when opening and closing the contact of an electromagnetic 
contactor, it would be effective to connect a CR surge suppressor across the 
contact. Note that, even when the contact is opened, the CR surge suppressor 
circuit causes a leakage current (part (A) in Figure 9-8). 

(6) When the shutdown noise of a motor or transformer matters, connect a CR surge 
suppressor between phases (part (B) in Figure 9-8). 

 

C R

C R

C R

C

R

C

R

M
C

R

MC

MC Measures against arc noise (A)

Measures against break noise (B)

Programmable
controller output  

Figure 9-8 Measures against Noise in a High Capacity Load 

 
(7) Relaying in a panel is also effective.  

It is desirable to relay those specific outputs of a programmable controller which 
generate a large amount of noise. 

 

AC

RA RA

AC

Programmable controller

Output

L
Lo

ad

 

Figure 9-9 Relay-based Load Driving 
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9.6 Measures against Noise Troubles 

When a control trouble occurs, if the following is the case, the possible cause would be 
an external noise. 

 
Figure 9-1 Measures against Noise Troubles 

(1) When noise is 
generated in 
sync with the 
behavior of a 
specific 
output 
equipment 

1)  Noise or surge from output equipment are considered as the major 
cause. When the instrument is turned ON and OFF, this trouble 
always or sometimes occurs and the programmable controller 
stops.  
In such cases, measures in Figure 9-5 and 9-6 are usually effective 
as measures against noise. A surge suppressor and diode are not 
effective unless they are connected most close to the load. Note 
that, for a high capacity load, take measures described in Figure 
9-8.  

2)  Possible troubles occurring in sync with the behavior of the 
instrument include bad connection such as disconnection and 
slackness of an input cable and bad electrical contact of input 
equipment. Conduct an inspection thoroughly. 

(2)  When noise is 
generated in 
sync with the 
behavior of an 
instrument 
irrelevant for 
the 
programmable 
controller 

1)  Such noise is caused by noise or surge from another instrument. 
Thus, conduct the same measures as for item "(1)" above. 

2)  Try out measures such as grounding when using the instrument 
without grounding it and changing to non-grounding when using it by 
grounding it, set an I/O signal wire apart from the cable laying of the 
corresponding equipment, or consider the route. 

(3)  When noise 
occurs in 
applying a 
high capacity 
load 

1)  Possible causes include the reduction of the power supply voltage 
and the rise of the ground potential of shared grounding.  
If the power supply voltage is reduced to lower than the prescribed 
value when the load is applied, add a constant-voltage transformer 
in the power supply and change the power supply systems. 

2)  When grounding has been done, ungrounding may be an alternative 
measure. 

(4)  When the 
behavior of the 
programmable 
controller is 
unstable at 
random 

1)  Either in the event of frequent instantaneous power failures of the 
power supply, when the waveform is significantly poor, or when 
there are many power supply noises, it would be effective to add a 
constant-voltage or only an isolation transformer. 

2)  When there is impact of a high frequency equipment, ensure to 
ground the high frequency equipment and the programmable 
controller storage panel and shield the I/O signal wire of the 
programmable controller. 

(5)  When the 
induced 
voltage of an 
input is high 

1)  The programmable controller will not stop, resulting in false input 
causing faulty output. Even if the induced voltage is low, it is 
overlapped with noise, and results to false input. 
In that case, take the measures described in Figure 9-3. 

(6)  Others 

1)  Noise from the ignition system of a forklift: Occurs when a car 
passes by. 

2)  Noise affected by radio wave: Occurs when a door of the control 
panel is opened. 

3)  Noise generated by radio wave: Occurs when a transceiver or 
cellular phone are used. 

 
The above measures taken against the noise troubles of the programmable controller 
should have been conducted when producing a panel or during external wiring 
construction, in order to reduce the costs. During a system is designed using a 
programmable controller, the designer should have considered which measure to 
take, 
The designer also must check whether the taken measure is really effective when a 
trouble occurs, by reproducing the same trouble and omitting that measure. 
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9.7 Procedure for Noise Measurement 

This section describes the measurement procedures of noise and items related to 
programmable controller power supply 100/200 V AC systems / 24/5 V DC systems. 

 
Table 9-2 Noise Measurement of 100/200 V AC Systems 

S
ys

te
m

 

T
yp

e 

Item 
Measuring 

point 
Key point 

Measuring 
instrument 

Judgment 
level 

Actual 
measure-

ment 
value 

Check

Voltage Must be within 
the input 
voltage range 

Digital voltmeter 100 V system 
85 to 132 V 
200 V system 
170 to 264 V 

  

Waveform Must be a 
waveform 
similar to a sine 
wave 

No fluctuation 
for 85 to 132 
V of peak 
voltage 
Distortion 
factor must 
be 5% or less 

  

Period Must be 
successfully 
observed with 
waveforms 
stabilized, using 
the same 
trigger 

Must be 
between 47.5 
Hz and 63 Hz 
and have no 
significant 
fluctuation 

  

Noise No periodic or 
temporary 
noise must be 
observed 

-1500 to 1500 
V, 
1 μs or less 

  

Li
ne

 

Momentary 
power failure  
Momentary 
power sag 

Input terminals 
of 
programmable 
controller 
power supply 
module  
(e.g. Q61) 

No momentary 
power 
failure/sag 20 ms or less 

  

Waveform Must be a 
waveform 
similar to a sine 
wave 

No fluctuation 
for 85 to 132 
V of peak 
voltage 
Distortion 
factor must 
be 5% or less 

  

10
0/

20
0 

V
 A

C
 s

ys
te

m
s 

A
ga

in
st

 F
G

 te
rm

in
al

 

Noise 

One end (with 
higher voltage) 
of input 
terminal and 
FG terminal 

No periodic or 
temporary 
noise must be 
observed 

Synchroscope 
Digital scope 
Memory high 
coder 
(for observing 
repeatedly) 
+ 
high-pressure 
probe (for 200 
V system and 
noise 
observation) 

-1500 to 1500 
V, 
1 μs or less 
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Table 9-3 Noise Measurement of 24 V DC System 
S

ys
te

m
 

T
yp

e 
Item 

Measuring 
point 

Key point 
Measuring 
instrument 

Judgment 
level 

Actual 
measure-

ment 
value 

Check

Voltage Must be within 
the voltage 
range of the 
module 

Digital 
volt- 
meter 

For Q63P: 
15.6 to 31.2 V 
For an I/O 
module: 
Example) 
QX41 
10.2 to 26.4 V 

  

Waveform Must be within 
the voltage 
range of the 
module 

Same as the 
judgment 
level of the 
voltage 
Must have little 
fluctuation 

  

Noise No periodic or 
temporary noise 
must be 
observed 

-750 to 750 V, 
1 μs or less 

  

Rise 
Fall 

Overshoot and 
undershoot 
when turned ON 
and OFF must 
be within the 
voltage range of 
the module 

Same as the 
judgment 
level of the 
voltage 

  

Li
ne

 

Momentary 
power failure
Momentary 
power sag 

Input terminals 
of the module 
When 
unmeasurable, 
use junction 
terminals 
or power 
supply output 
terminals 

No momentary 
power 
failure/sag 

0 ms except 
for specifically 
disallowed 
modules 

  

Waveform Must be within 
the voltage 
range of the 
module 

Same as the 
judgment 
level of the 
voltage 
Must have little 
fluctuation 

  

24
 V

 D
C

 s
ys

te
m

 

A
ga

in
st

 F
G

 te
rm

in
al

 

Noise 

Point of +24 V 
and against 
FG terminal 

No periodic or 
temporary noise 
must be 
observed 

Synchroscope
Digital scope 
Memory high 
coder + 
high-pressure 
probe 

+/-750 V, 
1 μs or less 

  

Table 9-4 Noise Measurement of 5 V DC System 

S
ys

te
m

 

T
yp

e 

Item 
Measuring 

point 
Key point 

Measuring 
instrument 

Judgment 
level 

Actual 
measure-

ment 
value 

Check

Voltage There is no 
significant 
voltage drop 

Digital 
voltmeter 
Synchroscope 

4.75 V 
to 5.25 V 

  

Ripple 
 

There is no 
significant ripple

300 mVpp 
or lower 
Refer to 
Figure 9-10 

  

5 
V

 D
C

 s
ys

te
m

 

Li
ne

 

Spike 
 

Base power 
supply 
Between slot 
and extension 
connector 
Between 5 V 
pin and SG pin  

There is no 
significant spike

Synchroscope
 
Digital 
scope 
These should 
be accessed 
as needed 
Probe 
Within the AC 
range 

800 mVpp 
or lower 
Refer to 
Figure 9-10 
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Table 9-5 Ground Noise Measurement 
S

ys
te

m
 

T
yp

e 

Item 
Measuring 

point 
Key point 

Measuring 
instrument 

Judgment 
level 

Actual 
measure-

ment 
value 

Check

B
et

w
ee

n 
S

G
-F

G
 

- 

Noise FG terminal 
and SG 
terminal (GND 
side of 
measuring 
points for 5 V 
DC system) 

Whether noise 
from FG terminal 
affects the inside 
of the 
programmable 
controller 

Synchroscope
/digital scope 
Memory 
high coder 

10 Vpp or 
lower 
Even if lower 
than this, 
care must be 
taken if it is 
obviously 
noise 

  

 

Ripple
voltage

Spike
voltage

 

Figure 9-10 Ripple/Spike Waveforms 
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9.8 Solution Examples for Noise Troubles 

 Before improvement After improvement 

(1
) U

si
ng

 d
iff

er
en

t e
ar

th
in

g 
ca

bl
es

 

The same cable is used as both a ground cable for 
power and a ground cable for the programmable 
controller and leads to power noise so as to make the 
programmable controller malfunction during motor 
operation. 

LGFGLGFG

FG

Programmable
controller

Programmable
controller

Grounding Motor

 

The trouble was successfully solved by separating 
the ground cable for power from that for the 
programmable controller. 

LGFGLGFG

FG

Grounding Motor

Programmable
controller

Programmable
controller

 

(2
) G

ro
un

d 
ca

bl
e 

de
di

ca
te

d 
to

 th
e 

pr
og

ra
m

m
ab

le
 

co
nt

ro
lle

r 

Because an iron panel connects ground terminals A 
and B, the ground cable of the programmable controller 
has an impedance. As a result, the effect of the ground 
cable is halved, causing the programmable controller to 
malfunction. 

LGFG

Programmable
controller

Grounding

B earth terminal

A earth terminal

Control
panel

(Made of
iron plates)

 

The trouble was successfully solved by directly 
grounding the ground cable for the programmable 
controller. 

LGFG

Programmable
controller

Grounding

B earth terminal

A earth terminal

Control
panel

(Made of
iron plates)

 

(3
) S

ep
ar

at
in

g 
ca

bl
es

 in
 th

e 
du

ct
 

The mix of the MELSECNET coaxial cables with the 
power cables for the motor in the wiring duct causes 
communication failures for MELSECNET. 

Wiring duct

Coaxial
cable

Power
cable  

The trouble was successfully solved by separating 
the coaxial cables from the power cables in the 
wiring duct. 
 

Wiring duct

Coaxial
cable

Power
cable  

Figure 9-11 Solution Examples 1, 2, and 3 
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 Before improvement After improvement 
(4

) M
ak

in
g 

si
gn

al
 w

ire
s 

in
to

 a
 tw

is
te

d 
pa

ir 
The RS-232C cables can sometimes come close to the 
power cables for the motor, causing the terminal CRT 
screen to go out of control. 
 

MS

Programmable controller

RS-232C cable

Ground (FG)

Power cable

Motor

Terminal

The trouble was successfully solved by making all 
the signal wires of the RS-232 cable and SG 
terminal wires into twisted pairs. 
 

RDSD

SDRD

DTRDSR

DSRDTR

SGSG

FGFG

To computer
link module

To terminal

 

(5
) S

ep
ar

at
in

g 
bu

nd
le

d 
w

ire
s 

Having bundled the primary winding and secondary 
winding for the noise filter (LNF) leads power supply 
noises to enter the programmable controller, thus 
causing the controller to malfunction. 
 

NFB

100 V AC

LNF

Bundle

Programmable controller

 

The trouble was successfully solved by setting the 
bundled primary and secondary windings of the 
noise filter (LNF) 10 cm or more apart from each 
other, making them into a twisted pair, and 
grounding the LNF. 
 

NFB

LNF

100 V AC

Separate

Programmable controller

Make a twisted pair
cable

Ground  

(6
) S

ep
ar

at
in

g 
a 

co
nt

ro
l l

in
e 

fr
om

 a
 p

ow
er

 c
ab

le
 

Having housed the programmable controller I/O cable 
and power cable in the same duct causes the controller 
to malfunction. 
 

MS RA

NFB

MS

Programmable
controller

Duct

Duct

I/O cable

Power cable

Terminal block
 

The trouble was successfully solved by moving the 
programmable controller I/O cable to a different 
duct from that of the power cable. 
 

MS RA

NFB

MS

Programmable
controller

Duct

Duct

Terminal block
 

Figure 9-12 Solution Examples 4, 5, and 6 
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 Before improvement After improvement 
(7

) F
ilt

er
in

g 
ou

t s
ta

tic
 e

le
ct

ric
ity

 n
oi

se
s When the static electricity electrified in the pallet was 

discharged, the discharge noise affected the 
MELSECNET coaxial cable, causing a communication 
failure. 
 

Pallet

Workpiece Workpiece

Pallet

Coaxial cable of MELSECNET

Programmable
controller

A place where static
electricity is discharged

 

The trouble was successfully solved by additionally 
installing a discharge bar in the pallet and eliminating 
the static electrification. 
 
 

Workpiece Workpiece

Coaxial cable of MELSECNET

Programmable
controller

Add discharge bars

 

(8
) F

ilt
er

in
g 

ou
t r

el
ay

 n
oi

se
s 

Relay noises from the control line adjacent to the input 
signal wire causes the programmable controller to 
malfunction. 
 

OUT IN

Shield wire

Grounding
Double

grounding
Grounding

SG wire Input signal wire

The trouble was successfully solved by changing the 
groundings of the shield wire into a single grounding. 
 

OUT IN

GroundingSingle grounding

Grounding

 

(9
) F

ilt
er

in
g 

ou
t p

ow
er

 n
oi

se
s 

Power noises from the main circuit line adjacent to the 
input signal wire causes the programmable controller to 
malfunction. 
 
 
 

OUT IN

Grounding
Shield wireGrounding

SG wire Input signal wire

 

The trouble was successfully solved by changing the 
shield wire to a change the shield wire to a magnetic 
shielded wire. 
 
 

OUT IN

GroundingGroundingGrounding

Add a magnetic shield

 

Figure 9-13 Solution Examples 7, 8, and 9 
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Chapter 10: Life of Programmable Controller Components 
 

This section describes the lives of a battery, fuse, electrolytic capacitor, and output 

relay. 
 

POINT  

For the lives of a programmable controller CPU and a module, refer to Mitsubishi 
programmable controller TECHNICAL BULLETIN "Recommendation on preventive 
maintenance and inspection of MELSEC A/Q series programmable controllers" 
(PLC-D-434-A). 
The TECHNICAL BULLETIN described above can be found at the Mitsubishi 
Electric FA Global Website. 
(Mitsubishi Electric FA Global Website: 
http://www.mitsubishielectric.co.jp/fa/index.html) 

 

10.1 Battery Life 
(1)  Battery replacement 

The voltage drop of the backup battery for the program function and backup power 
function triggers special relays SM51 and SM52 to be turned ON. Though these 
special relays being turned ON does not immediately cause the program content 
saved by the backup power to be lost, missing the special relays being turned ON 
may result in the contents being lost. 
Replace the battery before the total backup power time since SM51 is turned ON 
reaches the specified time. 

 

POINT  

SM51 turns ON when the battery voltage falls below the specified value and 
maintains ON even after the battery voltage returns to normal. SM52 turns ON 
when the battery voltage falls below the specified value and turns OFF when the 
battery voltage returns to normal. 
Replace the battery immediately after SM51 or SM52 turns ON. 
However, it is recommended to replace the battery periodically according to the 
usage status even before an alarm occurs. 

 

SM51 and SM52 turn ON when any battery voltage for the CPU module and SRAM 
card drops. To judge the memory battery of which voltage drops, check the 
contents of special registers SD51 and SD52. 
When the battery voltage for each memory drops, an SD51 or SD52 bit 
corresponding to the memory turns ON. 

 

Bit number of SD51 and SD52 Target memory 
Bit 0 CPU module 
Bit 1, 2 SRAM card 

 

POINT  

The following table explains the relationships of memory backup between a battery 
mounted on the CPU module and that mounted on the SRAM card. 
There are two points: 
(1)  The battery mounted on the CPU module cannot back up the SRAM card 

memory. 
(2)  The battery mounted on the SRAM card memory cannot back up the CPU 

module memory. 

 
Power supply of 

power supply 
module 

Battery of CPU 
module 

Battery of 
SRAM card 

Memory of 
CPU module 

Memory of 
SRAM card 

 

 Mounted    
 

Connected 
Not mounted    

 Mounted    
 

ON 
Not connected

Not mounted    
 Mounted    
 

Connected 
Not mounted  ×  

 Mounted ×   
 

OFF 
Not connected

Not mounted × ×  

    : Can be backed up ×: Cannot be backed up 
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(2)  Battery life 
(a)  Battery (Q6BAT, Q7BAT) life of the CPU module 

The battery life depends on the serial number (the first five digits) and model 
of the CPU module. 
1)  For the CPU modules whose the first five digits of the serial number are 

"05011" or later 
 

Battery life 

Q6BAT Q7BAT 

Model of CPU 
module 

Power-on 
time ratio 

*1 
Guaranteed 

value 
(70°C) 

*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

0% 
30,000 h 

3.42 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

30% 
42,857 h 

4.89 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

50% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

70% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

Q02CPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

0% 
2,341 h 

0.26 years 
18,364 h 

2.09 years 
120 h 
5 days 

5,000 h 
0.57 years

43,800 h 
5.00 years 

240 h 
10 days 

30% 
3,344 h 

0.38 years 
26,234 h 

2.99 years 
120 h 
5 days 

7,142 h 
0.81 years

43,800 h 
5.00 years 

240 h 
10 days 

50% 
4,682 h 

0.53 years 
36,728 h 

4.19 years 
120 h 
5 days 

10,000 h 
1.14 years

43,800 h 
5.00 years 

240 h 
10 days 

70% 
7,803 h 

0.89 years 
43,800 h 

5.00 years 
120 h 
5 days 

16,666 h 
1.90 years

43,800 h 
5.00 years 

240 h 
10 days 

Q02HCPU 
Q06HCPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

0% 
1,260 h 

0.14 years 
7,755 h 

0.88 years 
48 h 

2 days 
2,900 h 

0.33 years
21,107 h 

2.40 years 
96 h 

4 days 

30% 
1,800 h 

0.20 years 
11,079 h 

1.26 years 
48 h 

2 days 
4,142 h 

0.47 years
30,153 h 

3.44 years 
96 h 

4 days 

50% 
2,520 h 

0.28 years 
15,510 h 

1.77 years 
48 h 

2 days 
5,800 h 

0.66 years
42,214 h 

4.81 years 
96 h 

4 days 

70% 
4,200 h 

0.47 years 
25,850 h 

2.95 years 
48 h 

2 days 
9,666 h 

1.10 years
43,800 h 

5.00 years 
96 h 

4 days 

Q12HCPU 
Q25HCPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
48 h 

2 days 
43,800 h 

5.00 years
43,800 h 

5.00 years 
96 h 

4 days 

*1:  The power-on time ratio indicates the percentage of the time per day (24 hours) while the 
programmable controller power supply is turned ON. 
(The power-on time ratio will be 50% if the total power-on time is 12 hours and the total power-off 
time is 12 hours.) 

*2:  The guaranteed values are the values when the storage ambient temperature is -25 to 75°C 
(operating ambient temperature is 0 to 55°C). 

*3:  The actual values are the values when the storage ambient temperature is 40°C (operating 
ambient temperature is 25°C). 
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2)  For the CPU modules whose the first five digits of the serial number are 
earlier than "05011". 

 

Battery life 

Q6BAT Q7BAT 

Model of CPU 
module 

Power- 
on 

time ratio
*1 

Guaranteed 
value 
(70°C) 

*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

0% 
5,433 h 

0.62 years 
43,800 h 

5.00 years 
120 h 
5 days 

13,000 h 
1.48 years

43,800 h 
5.00 years 

240 h 
10 days 

30% 
7,761 h 

0.88 years 
43,800 h 

5.00 years 
120 h 
5 days 

18,571 h 
2.11 years

43,800 h 
5.00 years 

240 h 
10 days 

50% 
10,866 h 

1.24 years 
43,800 h 

5.00 years 
120 h 
5 days 

26,000 h 
2.96 years

43,800 h 
5.00 years 

240 h 
10 days 

70% 
18,110 h 

2.06 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,333 h 
4.94 years

43,800 h 
5.00 years 

240 h 
10 days 

Q02CPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

0% 
2,341 h 

0.26 years 
14,550 h 

1.66 years 
120 h 
5 days 

5,000 h 
0.57 years

38,881 h 
4.43 years 

240 h 
10 days 

30% 
3,344 h 

0.38 years 
20,786 h 

2.37 years 
120 h 
5 days 

7,142 h 
0.81 years

43,800 h 
5.00 years 

240 h 
10 days 

50% 
4,682 h 

0.53 years 
29,100 h 

3.32 years 
120 h 
5 days 

10,000 h 
1.14 years

43,800 h 
5.00 years 

240 h 
10 days 

70% 
7,803 h 

0.89 years 
43,800 h 

5.00 years 
120 h 
5 days 

16,666 h 
1.90 years

43,800 h 
5.00 years 

240 h 
10 days 

Q02HCPU 
Q06HCPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
120 h 
5 days 

43,800 h 
5.00 years

43,800 h 
5.00 years 

240 h 
10 days 

0% 
1,260 h 

0.14 years 
6,096 h 

0.69 years 
48 h 

2 days 
2,900 h 

0.33 years
16,711 h 

1.90 years 
96 h 

4 days 

30% 
1,800 h 

0.20 years 
8,709 h 

0.99 years 
48 h 

2 days 
4,142 h 

0.47 years
23,873 h 

2.72 years 
96 h 

4 days 

50% 
2,520 h 

0.28 years 
12,192 h 

1.39 years 
48 h 

2 days 
5,800 h 

0.66 years
33,422 h 

3.81 years 
96 h 

4 days 

70% 
4,200 h 

0.47 years 
20,320 h 

2.31 years 
48 h 

2 days 
9,666 h 

1.10 years
43,800 h 

5.00 years 
96 h 

4 days 

Q12HCPU 
Q25HCPU 

100% 
43,800 h 

5.00 years 
43,800 h 

5.00 years 
48 h 

2 days 
43,800 h 

5.00 years
43,800 h 

5.00 years 
96 h 

4 days 
*1:  The power-on time ratio indicates the percentage of the time per day 24 hours) while the 

programmable controller power supply is turned ON. 
(The power-on time ratio will be 50% if the total power-on time is 12 hours and the total power-off 
time is 12 hours.) 

*2:  The guaranteed values are the values when the storage ambient temperature is -25 to 75°C 
(operating ambient temperature is 0 to 55°C). 

*3:  The actual values are the values when the storage ambient temperature is 40°C (operating 
ambient temperature is 25°C). 

 

POINT  

The life of batteries (Q6BAT, Q7BAT) when not connected to the CPU module is 
five years. 
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(a)  Battery (Q6BAT, Q7BAT) life of Universal Model CPU modules 
1) Other than QnUDVCPU, QnUDPVCPU 

 

Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Battery 
usage 

frequency 

Power- 
on 

time ratio 
*1 

Guaranteed 
value 

(70°C) 
*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 30,100 h 
3.44 years

30% 43,000 h 
4.91 years

50% 

70% 

1 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 25,300 h 
2.89 years

30% 36,100 h 
4.12 years

50% 

70% 

Q00U(J)CPU 
Q01UCPU 
Q02UCPU 

Q03UD(E)CPU 

2 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 30,100 h 
3.44 years

30% 43,000 h 
4.91 years

50% 

70% 

1 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 4,300 h 
0.49 years

32,100 h 
3.66 years

11,700 h 
1.34 years 

30% 6,100 h 
0.70 years

16,700 h 
1.91 years 

50% 8,600 h 
0.98 years

23,400 h 
2.67 years 

70% 14,300 h 
1.63 years

39,000 h 
4.45 years 

Q04UD(E)HCPU 

2 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

384 h 
16 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 
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Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Battery 
usage 

frequency 

Power- 
on 

time ratio 
*1 

Guaranteed 
value 

(70°C) 
*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 25,300 h 
2.89 years

30% 36,100 h 
4.12 years

50% 

70% 

1 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 4,200 h 
0.48 years

32,100 h 
3.66 years

11,400 h 
1.30 years 

30% 6,000 h 
0.68 years

16,200 h 
1.85 years 

50% 8,400 h 
0.96 years

22,800 h 
2.60 years 

70% 14,000 h 
1.60 years

38,000 h 
4.34 years 

2 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

384 h 
16 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 2,300 h 
0.26 years

19,200 h 
2.19 years

5,000 h 
0.57 years 

30% 3,200 h 
0.37 years

27,400 h 
3.13 years

7,100 h 
0.81 years 

50% 4,600 h 
0.53 years

38,400 h 
4.38 years

10,000 h 
1.14 years 

70% 7,600 h 
0.87 years

16,600 h 
1.89 years 

Q06UD(E)HCPU 

3 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

192 h 
8 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 
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Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Battery 
usage 

frequency 

Power- 
on 

time ratio 
*1 

Guaranteed 
value 

(70°C) 
*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 22,600 h 
2.58 years

30% 32,200 h 
3.68 years

50% 

70% 

1 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 4,100 h 
0.47 years

26,200 h 
2.99 years

11,100 h 
1.27 years 

30% 5,800 h 
0.66 years

37,400 h 
4.27 years

15,800 h 
1.80 years 

50% 8,200 h 
0.94 years

22,200 h 
2.53 years 

70% 13,600 h 
1.55 years

37,000 h 
4.22 years 

2 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

384 h 
16 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 2,300 h 
0.26 years

18,600 h 
2.12 years

5,000 h 
0.57 years 

30% 3,200 h 
0.37 years

26,500 h 
3.03 years

7,100 h 
0.81 years 

50% 4,600 h 
0.53 years

37,200 h 
4.25 years

10,000 h 
1.14 years 

70% 7,600 h 
0.87 years

16,600 h 
1.89 years 

3 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

192 h 
8 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 1,500 h
0.17 years

13,800 h
1.58 years

3,700 h
0.42 years 

36,100 h 
4.12 years 

30% 2,100 h
0.24 year

19,700 h
2.25 years

5,200 h
0.59 years 

50% 3,000 h
0.34 years

27,600 h
3.15 years

7,400 h
0.84 years 

70% 5,000 h
0.57 years

12,300 h
1.40 years 

Q10UD(E)HCPU 
Q13UD(E)HCPU 
Q20UD(E)HCPU 
Q26UD(E)HCPU 

4 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

144 h 
6 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

432 h 
18 days 
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Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Battery 
usage 

frequency 

Power- 
on 

time ratio 
*1 

Guaranteed 
value 

(70°C) 
*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 19,000 h 
2.16 years

30% 27,100 h 
3.09 years

50% 38,000 h 
4.33 years

70% 

1 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 4,000 h 
0.45 years

25,000 h 
2.85 years

10,900 h 
1.24 years 

30% 5,700 h 
0.65 year

35,700 h 
4.07 years

15,500 h 
1.76 years 

50% 8,000 h 
0.91 years

21,800 h 
2.48 years 

70% 13,300 h 
1.51 years

36,300 h 
4.14 years 

2 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

384 h 
16 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 2,200 h 
0.25 years

18,000 h 
2.05 years

4,900 h 
0.55 years 

30% 3,100 h 
0.35 years

25,700 h 
2.93 years

7,000 h 
0.79 years 

50% 4,400 h 
0.50 years

36,000 h 
4.10 years

9,800 h 
1.11 years 

70% 7,300 h 
0.83 years

16,300 h 
1.86 years 

3 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

192 h 
8 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 1,500 h 
0.17 years

13,500 h 
1.54 years

3,600 h 
0.41 years 

35,200 h 
4.01 years 

30% 2,100 h 
0.24 years

19,200 h 
2.19 years

5,100 h 
0.58 years 

50% 3,000 h 
0.34 years

27,000 h 
3.08 years

7,200 h 
0.82 years 

70% 5,000 h 
0.57 years

12,000 h 
1.36 years 

4 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

144 h 
6 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

432 h 
18 days 

0% 1,160 h 
0.13 years

10,800 h 
1.23 years

2,700 h 
0.30 years 

28,600 h 
3.26 years 

30% 1,600 h 
0.18 years

15,400 h 
1.75 years

3,800 h 
0.43 years 

50% 2,300 h 
0.26 years

21,600 h 
2.46 years

5,400 h 
0.61 years 

70% 3,800 h 
0.43 years

36,000 h 
4.10 years

9,000 h 
1.02 years 

Q50UDEHCPU 
Q100UDEHCPU 

5 

100% 43,800 h 
5.00 years

36,000 h 
4.10 years

120 h 
5 days 

43,800 h 
5.00 years 

40,800 h 
4.65 years 

336 h 
14 days 
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*1:  The power-on time ratio indicates the percentage of the time per day 24 hours) while the 
programmable controller power supply is turned ON. 
(The power-on time ratio will be 50% if the total power-on time is 12 hours and the total power-off 
time is 12 hours.) 

*2:  The guaranteed values are the values when the storage ambient temperature is -25 to 75°C 
(operating ambient temperature is 0 to 55°C). 

*3:  The actual values are the values when the storage ambient temperature is 40°C (operating 
ambient temperature is 25°C). 

 

POINT  

The life of batteries (Q6BAT, Q7BAT) when not connected to the CPU module is 
five years. 

 
2) QnUDVCPU, QnUDPVCPU 
The battery life varies by the power-on time ratio and whether an extended 
SRAM cassette is used or not. 

 
Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Usage of 
extended 

SRAM 
cassette 

Power-on 
time ratio 

*1 Guaranteed 
value 
(70°C) 

*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 41,400 h 
4.72 years

30% 

50% 

70% 

Unused 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 26,600 h 
3.03 years

30% 38,000 h 
4.33 years

50% 

70% 

Q4MCA- 
1MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 23,100 h 
2.63 years

30% 33,000 h 
3.76 years

50% 

70% 

Q4MCA- 
2MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 17,400 h 
1.98 years

30% 24,800 h 
2.83 years

50% 34,800 h 
3.97 years

70% 

Q4MCA- 
4MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 11,000 h 
1.25 years

28,500 h 
3.25 years 

30% 15,700 h 
1.79 years

40,700 h 
4.64 years 

50% 22,000 h 
2.51 years

70% 36,600 h 
4.17 years

Q03UDVCPU 

Q4MCA- 
8MBS 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 
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Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Usage of 
extended 

SRAM 
cassette 

Power-on 
time ratio 

*1 Guaranteed 
value 
(70°C) 

*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 31,700 h 
3.61 years

30% 

50% 

70% 

Unused 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 22,000 h 
2.51 years

30% 31,400 h 
3.58 years

50% 

70% 

Q4MCA- 
1MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 19,600 h 
2.23 years

30% 28,000 h 
3.19 years

50% 39,200 h 
4.47 years

70% 

Q4MCA- 
2MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 15,300 h 
1.74 years

36,600 h 
4.17 years 

30% 21,800 h 
2.48 years

50% 30,600 h 
3.49 years

70% 

Q4MCA- 
4MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 43,800 h 

5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 10,100 h 
1.15 years

26,500 h 
3.02 years 

30% 14,400 h 
1.64 years

37,800 h 
4.31 years 

50% 20,200 h 
2.30 years

70% 33,600 h 
3.83 years

Q04UDVCPU 
Q04UDPVCPU 

Q4MCA- 
8MBS 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 
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Battery life 

Q6BAT Q7BAT 

Model of 
CPU module 

Usage of 
extended 

SRAM 
cassette 

Power-on 
time ratio 

*1 Guaranteed 
value 
(70°C) 

*2 

Actual value
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since 
an alarm is 

raised) 

Guaranteed 
value 
(70°C) 

*2 

Actual value 
(40°C) 

*3 

Time since 
SM52 is 

turned ON
(guaranteed 
time since an 

alarm is 
raised) 

0% 30,600 h 
3.49 years

30% 43,700 h 
4.98 years

50% 

70% 

Unused 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 21,500 h 
2.45 years

30% 30,700 h 
3.50 years

50% 43,000 h 
4.90 years

70% 

Q4MCA- 
1MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 19,100 h 
2.18 years

43,100 h 
4.92 years 

30% 27,200 h 
3.10 years

50% 38,200 h 
4.36 years

70% 

Q4MCA- 
2MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 43,800 h 

5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 15,000 h 
1.71 years

36,200 h 
4.13 years 

30% 21,400 h 
2.44 years

50% 30,000 h 
3.42 years

70% 

Q4MCA- 
4MBS 

100% 

43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 43,800 h 

5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

0% 10,000 h 
1.14 years

24,800 h 
2.83 years 

30% 14,200 h 
1.62 years

35,400 h 
4.04 years 

50% 20,000 h 
2.28 years

70% 33,300 h 
3.80 years

Q06UDVCPU 
Q06UDPVCPU 
Q13UDVCPU 

Q13UDPVCPU 
Q26UDVCPU 

Q26UDPVCPU 

Q4MCA- 
8MBS 

100% 43,800 h 
5.00 years

43,800 h 
5.00 years

600 h 
25 days 

43,800 h 
5.00 years 

43,800 h 
5.00 years 

600 h 
25 days 

 
*1:  The power-on time ratio indicates the percentage of the time per day 24 hours) while the 

programmable controller power supply is turned ON. 
(The power-on time ratio will be 50% if the total power-on time is 12 hours and the total power-off 
time is 12 hours.) 

*2:  The guaranteed values are the values when the storage ambient temperature is -25 to 75°C 
(operating ambient temperature is 0 to 55°C). 

*3:  The actual values are the values when the storage ambient temperature is 40°C (operating 
ambient temperature is 25°C). 

 

POINT  

The life of batteries (Q6BAT, Q7BAT) when not connected to the CPU module is 
five years. 
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(c)  Battery life of SRAM cards 
Battery life of SRAM cards depends on the serial number (the first five digits) 
and model of the memory card. 
The following table describes the battery life of SRAM cards. 
1)  For the CPU modules whose the first five digits of the serial number are 

"04012" or later 
Battery life 

SRAM card 
Power-on
time ratio 

*1 
Guaranteed value 

(MIN) 
Actual value (TYP) 

Time since SM52 is 
turned ON 

(guaranteed time 
since an alarm is 

raised) 

0% 
690 h 

0.07 years 
6,336 h 

0.72 years 
8 h 

Q2MEM-1MBS 
manufacturer 
control number 
"A" *2 100% 

11,784 h 
1.34 years 

13,872 h 
1.58 years 

8 h 

0% 2,400 h 
0.27 years 

23,660 h 
2.7 years 

20 h 

30% 2,880 h 
0.32 years 

31,540 h 
3.6 years 

20 h 

50% 4,320 h 
0.49 years 

39,420 h 
4.5 years 

20 h 

70% 6,480 h 
0.73 years 

43,800 h 
5.0 years 

20 h 

Q2MEM-1MBS 
manufacturer 
control number 
"B" *2 

or 
"B" *2 

(B or later) 

100% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

0% 2,400 h 
0.27 years 

23,660 h 
2.7 years 

20 h 

30% 2,880 h 
0.32 years 

31,540 h 
3.6 years 

20 h 

50% 4,320 h 
0.49 years 

39,420 h 
4.5 years 

20 h 

70% 6,480 h 
0.73 years 

43,800 h 
5.0 years 

20 h 

Q2MEM-2MBS 

100% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

0% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

30% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

50% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

70% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

Q3MEM-4MBS 

100% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

0% 36,300 h 
4.1 years 

43,800 h 
5.0 years 

50 h 

30% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

50% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

70% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

Q3MEM-8MBS 

100% 43,800 h 
5.0 years 

43,800 h 
5.0 years 

50 h 

 



 

10 - 12 

 

2)  For the CPU modules whose the first five digits of the serial number are 
"04011" or earlier 

Battery life 

SRAM card 
Power-on
time ratio 

*1 
Guaranteed value 

(MIN) 
Actual value 

(TYP) 

Time since SM52 is 
turned ON 

(guaranteed time 
since an alarm is 

raised) 

0% 
690 h 

0.07 years 
6,336 h 

0.72 years 
8 h 

Q2MEM-1MBS 
manufacturer 
control number 
“□□A”
“□□B”

＊2
 

Q2MEM-2MBS 
100% 

11,784 h 
1.34 years 

13,872 h 
1.58 years 

8 h 

*1:  The power-on time ratio indicates the percentage of the time per day (24 hours) 
while the programmable controller power supply is turned ON.  
(The power-on time ratio will be 50% if the total power-on time is 12 hours and the 
total power-off time is 12 hours.) 

*2:  The manufacturer control number (the third digit from the left) is described on the 
the back label of the SRAM card main unit (refer to the following figure). 

注意事項
CAUTION
・ 強いショ ッ クを与えないこと 。
　 Do not subject to mechanical shock!
・ 高温・ 直射日光・ 水にさらされないこと 。
　 Do not expose to extreme.

**-*********
3LBN

Manufacturer control number

 

POINT  

Note that the SRAM card consumes the battery even when the battery is 
connected to the CPU module and the programmable controller is powered ON. 

 
 

(3)  Replacement 
In the period after the old battery is removed and before a new battery is 
connected, the built-in capacitor automatically performs backup. The period 
should be within three minutes. 
 

POINT  

Replace the battery of the SRAM card while the programmable controller power is 
ON and the SRAM card is mounted in order to retain data. 
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10.2 Fuse 

The following MELSEC-Q series modules have a built-in fuse to prevent short-circuit 
current and overcurrent. 
 

Table 10-2 List of Modules with a Built-in Fuse 

Module type Model 

Power supply 
Q61P, Q61P-A1, Q61P-A2, Q61P-D, Q61SP,  
Q62P, Q63P, Q63RP, Q64P, Q64PN, Q64RP 

CPU module Q00JCPU, Q00UJCPU 
Output module QY50, QY70, QY71, QY80, QY80-TS 

I/O combined module (output) QX48Y57 

 

POINT  

Note that fuses cannot be replaced by users. 

 
 
For the QY22 and QY68A output modules, it is recommended to install a fuse to an 
external terminal in order to prevent burnout of an external device and the module in 
the event of load short. 

 

Module name 
Recommended 

fuse 

Fuse model 
whose operation 

has been 
checked 

Manufacturer Distributor 

216 02.5 
QY22 

IEC60127 
sheet 1 

compliant item 216 002 

216 3.15 
QY68A 

Quick action 
type 

having a rated 
current of 3 A 312 003 

Littelfuse, Inc. 

Kuroda Electric Co., Ltd.
Headquarters (Tokyo)

03-5764-5500 
Osaka 

06-6303-1300 
Nagoya 

052-852-3321 
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10.3 Life of Electrolytic Capacitor 

The modules using an aluminum electrolytic capacitor has a life of 10 years at an 
ambient temperature of 40°C, but under a condition of a high ambient temperature, 
their capacitance may decrease in four to six years. 
It is recommended to replace it with a new one or have it overhauled considering the 
life described below as a preventive maintenance. 
 Module using an electrolytic capacitor 
 
In general, aluminum electrolytic capacitors are characterized by extremely varying life 
according to the ambient temperature (twofold changes in life when the temperature 
changes by 10°C) become there are chemical reactions inside. 
These characteristics are called Arrhenius law, which is illustrated in the following 
figure. 
 

10℃ 30℃ 50℃

Life

10 years

5 years

Temperature 

Figure 10-1 Arrhenius Law 
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10.4 Life of Output Relay 

The relays of the contact output module become worn with switching actions. 
If the relay mounted directly on the printed-circuit board of the output module becomes 
worn, the entire output module must be replaced. 
As measures against wear, for an alternate current load, change to triac output, for a 
direct current load, change to transistor output, and thus eliminate the contacts. 
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Figure 10-2 Contact Life Characteristics of Output Relay 
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10.5 Spare Parts 

Replacement parts for domestic use can be obtained in a timely manner even after an 
accident occurs because they are easy to obtain from the system service, branch 
office, or distributor. On the other hand, replacement parts for overseas be should be 
shipped beforehand. 
Maintenance will become easy if the following points are considered in the design 
phase: 

 
(1)  Adopting quick recovery types 

Because Q series programmable controllers are a building-block type where each 
module is mounted to the base unit, module replacement is easy. Because of the 
structure, recovery is completed only by replacing the faulty module. 
 

(2)  Memory type 
The standard RAM or memory card (SRAM) requires a battery for backup. 
The standard ROM or memory card (Flash/ATA) does not require a battery and 
can prevent the program from being changed due to a human error. It is 
recommended to use the backup memory particularly for exports. 
 

(3)  Module types reduced 
The number of types of spare parts can be effectively reduced by standardizing 
module names to be used and reducing the number of types. 
 

(4)  Reserving I/O points 
Do not use all I/O points of the 16, 32, and 64 I/O modules but reserve 10 to 20% 
of them. By doing this, faulty modules can be substituted by rewiring and program 
changes (changes in I/O signals) when there is no spare parts. 
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(5)  Spare parts 
 

Table 10-3 Spare Parts 

No. Product name Quantity Remarks 

1 Battery 1 to 2 pcs 

Since the storage life is about five years, the 
battery does not need to be always stocked, but 
should be arranged when the battery in use 
comes close to the end of life. Prepare the one or 
two batteries for an unexpected case. 

2 
Power supply 

module 
1 pc per model in 

use 

The life of this tends to be short when the 
ambient temperature is high, since it is a part that 
easily becomes hot. 

3 I/O module 
1 pc per module 

model 

Consider that it is likely to fail in test operation. 
Additionally, when it is used for a long time, the 
contact of the relay output module will be worn. 

4 CPU module 
1 pc per model in 

use 

5 Memory card 
1 pc per model in 

use 

Since this is a core part of the programmable 
controller, if this part should fail, the system will 
go down. Prepare upper compatible spare 
models. 
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Chapter 11: Preparing for Test Operation 

When starting operation after new installation or modification of a programmable 
controller, if the safety checks are not carried out sufficiently, an accident may result. 
This section describes the check items to proactively prevent accidents and the 
preparation procedure for test operation. 

 
11.1 Check Items before Starting Test Operation 

The following table describes the check items regarding the programmable controller. 
 

Table 11-1 Check Items 

No. Check item Description 

1 Setting the CPU 

 Is the memory capacity to be used correct? 
 Is the type (RAM/ROM) correct? 
 Is the system protection not turned ON? * 
 Is the parameter-valid drive set correctly? * 

2 Mounting a battery 
 Is the connector for the lead wire of the removed battery when 

shipped inserted securely into the connector pin on the CPU 
side? 

3 
Mounting and setting 

up memory cards 

 Are memory cards securely mounted onto the mounting 
connector? 

 Is the memory capacity to be used correct? 
 Is the type (RAM/ROM) correct? 
 Is the write protect not turned ON?  

(only for SRAM card, Flash card, SD memory card) 
 Is the battery holder securely inserted? (only for SRAM card) 

4 
Connecting an 
extension cable 

 Are the connectors of the main/extension bases well fitted with 
the connectors of the extension cable? 

 Is the connectors of the extension base positioned correctly 
(IN/OUT)? 

5 
Setting the extension 

base numbers for 
extension bases 

 Are the numbers set? 
 Is the same number set for multiple bases? 
 Are jumpers inserted into several positions for one base? 

6 Mounting modules 

 Are the module models mounted on each slot of the 
main/extension bases correct? 

 Does the module configuration use a larger number of I/O 
points than that in the CPU specifications? 

7 Fuses  Are fuses blown or damaged? 

8 
Connecting the power 
supply and I/O cables

 Do the cables connected to each terminal of the terminal 
blocks correspond to signal names? 

 Are the terminal screws of the terminal blocks for power supply 
module, I/O module and intelligent function module well 
tightened? 

 Do the cables have a proper wire size? 

* For high performance models only 
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11.2 Preparation Procedure for Test Operation 

The following shows a flowchart from a completion of installation until test operation of 
a programmable controller. 

 

　　

Start

End

Power-on Test operation

Sequence check

Program modification

Program protection

Programming

External input device wiring check

External output wiring check

1. Confirm voltage input from power
supply.

2. Confirm power supply voltage for
I/O equipment.

3. Set the RUN/STOP/RESET switch
of the CPU module to [STOP].

4. Turn on the power.
5. Confirm that the "POWER" LED of

the power supply module is on.

1. Set the RUN/STOP/RESET switch
of the CPU module to RUN.

2. Confirm that the "RUN" LED is on.

Check sequence operations.

Modify a sequence program if it
causes a trouble.

1. Save programs on hard disk or
a CD-ROM.

2. Print a ladder diagram and a list
using a printer.

Write a sequence program that has
been programmed
to the CPU.

Check external output wiring by
forcibly turning ON using device test
operation in GX Works2 with a
personal computer.

Check the wiring of input devices in
the monitoring mode of GX Works2
with a personal computer.

with GX Works2
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Chapter 12: CPU Replacement Procedure during Operation 

When replacing the programmable controller CPU while operating the system and 
machineries and continuing operation, it is necessary to read the sequence program 
and device data (latch data, etc.) out to peripherals and mount a new CPU. The 
procedure is as follows: 
 

Stop during operation.

STOP the CPU.

Start GX Works2 on a personal computer. Refer to Section 3.1.

Connect the personal computer and the CPU using a cable.

Save the program. Refer to Section 3.4.

Turn OFF the power supply of the programmable controller.

Replace the CPU.

STOP the CPU.

Turn ON the power supply of the programmable controller.

Connect the personal computer and the CPU using a cable.

RUN the programmable controller CPU.

Continuous operation starts.

Write the sequence program and the device data. Refer to Section 3.5.

Format the memory of the programmable controller. Refer to Section 3.5.

Read a sequence program and device data. Refer to Section 3.13.
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POINT  

Precautions for module/unit replacement 
 For an intelligent function module 

The intelligent function module may contain data such as parameters in E2PROM 
or EROM. 
In such cases, it is necessary write the same data to the replacement module. 

 For an Ethernet interface module 
If the Ethernet module has also been replaced, reset the external device as well. 
(If the external device retains the Ethernet address of another external device, 
communication may be disconnected because replacing Ethernet module 
changes the Ethernet addresses.) 
Likewise, an external device (e.g. personal computer) is replaced, start up the 
Ethernet module again. 

 

12.1 Universal Model QCPU Replacement Procedure 

Use the QnU(D)(E)(H)CPU Replacement Checklist described in Appendix 7.2 

together. 

 
12.1.1 Preparation 

(1) Enter the date, operator, panel name, and CPU model name in the 

QnU(D)(E)(H)CPU Replacement Checklist. 

(2) In the checklist, enter the switch setting of the CPU to be removed and whether 

there is a memory card. 

(3) As needed, for identification, stick a panel name label on the surface of the CPU 

to be removed. 

(4) When replacing QnUCPU module, use the "CPU module replacement" function.  

For details on how to use, refer to Section 12.1.2. 

 

12.1.2 Data Backup 

(1) Connect GX Works2 to the CPU to be removed, and set the PLC type and 

transfer setup to "Programmable Controller Side I/F: CPU Module". 

 

(3)　 Click!

 

 

1)  Connect the CPU with a personal computer 
using an RS-232C, USB or Ethernet cable. 
(This textbook illustrates the example where 
a USB cable is used.) 

 
2)  Start up GX Works2. 
 
3)  Click the [Online] → [Read from PLC] menu. 

 

  

(To the next page) 

4)  Set the PLC series to [QCPU(Q Mode)] and 
click the  OK  button. 
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(From the previous page) 

 

 

 

 

5)  Double-click [Serial/USB] on the PC side I/F. 
 

 

 

6)  Select the cable used for connection and 
click the  OK  button. 

 

 

7)  Double-click the PLC Module on the PLC 
side I/F. 

 

 

  

(To the next page) 

 

8) Select "QCPU(Q module)" for the PLC Mode 
and click the  OK  button. 
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(From the previous page) 

 

 

 

 

9)  Select "No Specification" for Other Station 
Setting. 

 
10)  Click the  Connection Test  button. 

 

 

 

 

 

11)  If properly connected, the screen on the left is 
displayed. Click the  OK  button. 

 
 If not properly connected, the following 

screen is displayed. Check the connection 
and conduct the communication test again. 

 

  

 

 

12)  Click the  OK  button. 

 

13)  The Read from PLC dialog box is displayed. 
Click the  Close  button. 
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(2)  Delete the program name "MAIN" from the project data. 

 
 

(3)  Delete Global Device Comment from the project data. 

 
 

(4)  Delete the device memory "MAIN" from the project data. 

 
 

(5)  Check that there is no error for the CPU to be removed.  In addition, create a 

new project after starting up GX Works2 and use the system monitor to check that 

there is no error for the mounted module. 

 

③　 クリック !(1)　 Click!

 

 

1)  In the LED on the front of the CPU, check 
that the ERR.LED is turned OFF. 

 
2)  If the ERR.LED is turned ON or flashes, click 

the [Diagnostics] → [PLC Diagnostics] menu.

 

  

(To the next page) 

3)  Double-click an error code in [Current Errors].
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(From the previous page) 

 

 

 

 

4)  Check the error details to enter the common 
error information and individual information in 
the checklist. 

 
 As needed, click the  Error JUMP  and  

 Error Help  buttons to enter the error details 
in the checklist.  
Also, ask the user for check. 

 

  

5)  Click the  Close  button to close the PLC 
diagnostics dialog box. 

 

 

 

6)  Click the [Diagnostics] → [System Monitor] 
menu. 

 

  
(To the next page) 

7)  Check that there is no error for the mounted 
module.  
 
If there is no error, the screen on the left is 
displayed. 
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(From the previous page) 

 

 

  

 

8)  If there is any error for the mounted module, 
double-click the erroneous module to check 
the error history of the module detailed 
information and enter in the checklist.  
Also, check with the user.  
 
Click the  Close  button to close the system 
monitor dialog box. 

 

 

(6)  Before setting RUN/STOP/RESET switch of the CPU to be removed to STOP, 

check with the administrator. 
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(7)  After entering the file content of the program memory in the checklist, select all 

programs, parameters (only for PLC/network), device comments, initial device 

values and so on, and check [Also read the remaining reserved capacity for writes 

during RUN]. Then, save the project after reading from the PLC. 

* Please change the intelligent function module parameters (hereafter referred 

to as intelligent parameters) to non-device data because they can be read. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

2)  Set the target memory to [Program 
memory/Device memory]. 

 

 

3)  In the [Program memory] field in the checklist, 
enter file names, whether there is any 
parameter, and so on. 

COMMENT

INIT

Circle either of [Applicable/Not applicable]
D:\Program_memory_read

Parameter Program Program Comment

Intelligent parameter

Device data

Initial device value

[Applicable/Not applicable]

[Applicable/Not applicable]

[Applicable/Not applicable]

Program memory [Save destination: ]

Write all save destinations and file names to frames

 

 

(To the next page) 
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(From the previous page) 

 

 

 

 

4)  From the file selection, select (check) all 
programs, parameters 
(PLC/Network/Remote password/Switch 
setting), device comments (global/local), and 
initial device values. 

 
* Select non-device data. 
 

5)  Click the  button of the program. 
 

 

 

6)  Check [Also read the remaining reserved 
area for online change]. 

 
7)  Click the  Execute  button. 

 

 

8)  If the dialog on the left is displayed, 
double-click and select the model name of 
the actual device mounted on the target 
system. 

 
9)  Click the  OK  button. 

 

 

(To the next page) 

10)  Click the  OK  button. 
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(From the previous page) 

 

 

 

 

11)  A dialog box that asks whether to save 
changes is displayed. Click the  Yes for All  
button. 

 

 

12)  When the read is completed, the dialog box 
on the left is displayed. Click the  OK  
button. 

(14)　 Click!

 

 

(To the next page) 

13)  Close the Read from PLC dialog box. 
 
14)  Click the [Project] → [Save as] menu to name 

the project. 
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(From the previous page) 

 

 

15) Enter the save destination in the [Program memory] field in the QnU(D)(E)(H)CPU Replacement 
Checklist. 

COMMENTMAIN

INIT

Circle either of [Applicable/Not applicable]
D:\Program_mD:\Program_memory_reademory_read

Parameter Program Program Comment

Intelligent parameter

Device data

Initial device value

[Applicable/Not applicable]

[Applicable/Not applicable]

[Applicable/Not applicable]

Program memory [Save destination: D:\Program_memory_read]

Write all save destinations and file names to frames
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(8)  Select device data in the program memory and name a file. (Example: DEVICE) 

Click the "Default" button in "Device data" to select X and Y ( ), as well.  

After reading from PLC, confirm that there is the data and then save the project. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

2)  Set the target memory to [Program 
memory/Device memory] and click the 

 button of the device memory. 
 

 

 

3)  Click the  Default  button. 
 

 

 

4)  The message box on the left is displayed. 
Click the  Yes  button. 

 

 

 

(To the next page) 

5)  Select a device data and name a device data 
name.  
 
Device data name: DEVICE (example) 
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(From the previous page) 

 

 

 

 

6)  Check that all the current devices (except for 
the retentive timer) are selected ( ). 

 
7)  Click the  OK  button to read from PLC. 

 

 

8)  Select the read file. 
 
9)  Confirm that the device data exists. 

(10)　 Click!

 

 

10)  Close the Read from PLC dialog box, and 
then click the [Project] → [Save] menu to 
save the project. 

 

 
11)  Enter the device data name in the [Device data] field in the QnU(D)(E)(H)CPU Replacement 

Checklist. 
 

COMMENT

¥

DEVICE

Circle either of [Applicable/Not applicable]
Write all save destinations and file names to frames

Parameter Program Program Comment

Intelligent parameter

Device data

[Applicable/Not applicable]

[Applicable/Not applicable]

Program memory [Save destination: D:\Program_memory_read ]

MAIN
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(9)  If a file register exists in the standard RAM, enter the file name and file size (in 

bytes) in the checklist, read the entire range into the same project and then save 

it. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

2)  Set the target memory to [Standard RAM].  
 
Check that the file register exists. 

 

 

 

3)  Select a file and click the  button.  
 
Check that the entire range is selected and 
click the  OK  button. 
 

 
 

 

 

(To the next page) 

4)  Check the file size. 
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(From the previous page) 

 

 

5)  Enter the file name and file size in the [Standard RAM] field in the QnU(D)(E)(H)CPU Replacement 
Checklist. 

  

2048MAIN

Standard RAM

File register File size

Note) Use the same project as the program memory.
Before write to PLC, ensure that the destination
and the file name are correct. Writing to the PLC
shall be done to the standard RAM.byte

 

 

 

 

 
 
6)  Click the  Execute  button to read from 

PLC. 

(7)　 Click!

 

7)  After closing the Read from PLC dialog box, 
click the [Project] → [Save] menu to save the 
project. 

 

 

(10) If files exist in the standard RAM, after entering the file contents in the checklist, 

start up new GX Works2, read the files in the same way as reading the program 

memory from PLC, and save it with another project name.  

However, if they are device comments or likewise, and there is no same file as 

that in the program memory, there is no problem in saving in the same project as 

in (7). 

 

(1)　 Click!

 

 

(To the next page) 

1)  Click the [Online] → [Read from PLC] menu. 
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(From the previous page) 

 

 

 

 

2)  Set the target memory to [Standard RAM] 
and check for the file. 

 

3)  Enter the file names and others in the [Standard ROM] field in the QnU(D)(E)(H)CPU Replacement 
Checklist. 

  

   

COMMENTMAIN INIT

Standard ROM [Save destination: ]
Parameter

Intelligent parameter

[Applicable/Not applicable]

[Applicable/Not applicable]

Program

F
ile

na
m

e

Comment Initial device value

 

4)  Use the checklist and others to check whether these files are same as those in the program memory 
(7).  
If no same files as in the program memory exist, save in the same project as in (7) after reading from 
PLC, and then enter the project name in the checklist. 

  

   

COMMENT

D:¥プログラムメモリ読出しStandard ROM [Save destination: ]
Parameter

Intelligent parameter

[Applicable/Not applicable]

[Applicable/Not applicable]

F
ile

na
m

e

Comment
D:\Program_memory_read

 

 

(To the next page) 
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(From the previous page) 

 

 

* If there exist the same files as in the program memory, follow the procedures below 

 

 

 

1)  Start up new GX Works2. 
 
2)  Set the target memory to [Standard ROM] 

and read from PLC in the same way as for 
the program memory. 

(2)　 Click!

 

 

3)  Click the [Project] → [Save as] menu to newly 
save the project. 

 
 

4)  Enter the project name in the checklist. 
  

   

COMMENTMAIN INIT

Standard ROM [Save destination: ]
Parameter

D:\Standard_rom_read

Intelligent parameter

[Applicable/Not applicable]

[Applicable/Not applicable]

Program

F
ile

na
m

e

Comment Initial device value

 
(11) If a memory card is used or if files exist, after entering the file contents in the 

checklist, start up new GX Works2, read the files in the same way as in reading 

the program memory from PLC, and save it with another project name.  

However, if it is a file register or likewise, and there is no same file as that in the 

program memory, it is possible to save them to the same project as in (7). 

 

 

1)  Check if files exist, and if they do, perform the 
same procedure as in (10). 
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(12) From GX Works2, run [Online] → [Program memory batch transfer] and check 

whether the content of the program cache memory matches that of the program 

memory. 

 

*  If the contents do not match, or if the user cannot check due to the CPU version, a 

message "Do you transfer...?" will  appear. Then, click the  Yes  button to 

perform the batch transfer. 

 

 

 

1)  Click the [Online] → [Program Memory Batch 
Download] menu. 

 

 

If it matches 
 

 

If it does not match 

2)  Check whether the content of the program 
cache memory matches that of the program 
memory and, if it does, click the  OK  
button.  
 
Otherwise, click the  Yes  button so that the 
content of the program cache memory will 
match that of the program memory. 

 
 

 

(To the next page) 
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(From the previous page) 

 

 

 

(13) When replacing the QnUCPU module, use the "CPU module replacement" 

function to back up the module to a memory card. 

 

 

 

1)  Click the [Online] → [PLC Module Change] 
→ [Create Backup Data] menu. 

 

2)  In "Data for backup", select data to be backed 
up from "Program memory", "Standard RAM" 
or "Standard ROM".  
 
* "Default backup data" is selected by default. 
It cannot be changed. 

 
3)  Click the  Execute  button.  

The data backup starts. 
 

 

4)  When the backup is normally completed, the 
[Status] screen changes as in the image on 
the left. 
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12.1.3 Replacement 

(1) In the checklist, enter the SERIAL number and MAC address (only for the CPU 

board with Ethernet enabled) on the side of, or under the face plate of, the CPU to 

be mounted. 

Module to be mounted 
SERIAL No. 
(production information) 
100921102685014-B 
 
MAC ADD. 
08007045BB00 

 
MAC address

SERIAL No. Write the confirmed SERIAL and 
MAC address to the check sheet.

 

(2) Set the RUN/STOP/RESET switch of the CPU to be mounted to "STOP". Also, 

mount the battery connector at the bottom of the module. 

 

Set to STOP. 
Mount the 
connector. 

 

(3) Before powering OFF the programmable controller, check with the administrator. 

 

(4) Remove the target CPU from the base and, in the checklist, enter the SERIAL 

number and MAC address (only for the CPU board with Ethernet enabled) on the 

side or under the face plate. 

 

(5) If an identification seal is put, move it to the CPU to be mounted. 

 

(6) If a memory card is mounted on the removed CPU, move it on the CPU to be 

mounted. 

 

(7) Mount the target CPU on the base in the mounting panel and, if it is to be fixed 

with screws, tighten the screws. 

 

(8) Confirm again that the RUN/STOP/RESET switch of the mounted CPU is set to 

"STOP". 

 

(9) Before powering ON the programmable controller, check with the administrator. 

 

* An error may be displayed on the CPU, but please continue with the task. 
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12.1.4 Data Restoration 

(1)  Check the product information of the corresponding module in the GX Works2 

system monitor, and enter in the check sheet. 

 

 

1)  Click the [Diagnostics] → [System monitor] 
menu to display the system monitor dialog 
box. 

 
2)  Click the  Product Information List  button. 

 

3)  The product information list dialog box is 
displayed. Check the product information 
(serial number, etc.) of the corresponding 
module. 

 

 
4)  Enter the product information in the [Product information of the CPU (replacement)] field in the 

QnU(D)(E)(H)CPU Replacement Checklist. 
face plate of the CPU to be mounted, to the right column.

9 Set the RUN/STOP /RESE T switch of the CPU to be moun t to "STOP ". Also, connect the battery conne ctor at the bottom the modu le.

10 Have the customer turn OFF the power sup ply of the programmable controller.

11
Remove the target CPU from the base, and write the SERIAL number and MAC address (only for the CPU board with Ethernet

enabled), which are on the side or under the face plate, to the right column.

12 If the customer's identification label is attached, move it to the CPU to be mounted.

13 If a memory card is mounted on the removed CPU, move it on the CPU to be mounted.

14 Mount the target CPU on the base in the mounting panel and, if it is to be fixed with screws , tighten the screws .

15 Confirm agai n that the RUN/STOP/RESET switch of the mounted CPU is set to "STOP".

R
e

p
la

ce
m

e
n

t

16 Have the customer turn ON the power supply of the programmable controller.

Produc t in form ation o f the

CPU (module to be moun ted )

Error description
before replacement

1306200 00000000 -B

 

 
 

5)  Close the product information list dialog box and the system monitor dialog box. 
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(2)  Format the program memory/device memory, standard RAM, and standard ROM 

to be used for the PLC memory.  

At this point, check whether it is necessary to allocate the system area and, if it is, 

configure the settings.  

However, because this area is set only when formatting, if you are not sure, there 

is no problem leaving it as the default. 

 

 

 

1)  Click the [Online] → [PLC Memory Operation] 
→ [Format PLC Memory] menu. 

 

 

2)  Since the Format the PLC memory dialog 
box is displayed, set the target memory to 
either "Program memory" or "Device 
memory". 

 

 

 

3)  Select the format. 
 
*  Set the system area if it is necessary to 

allocate the area. 
 

 If it is not necessary, select "Do not create a 
user setting system area (only the required 
field)". 

 
4)  Click the  Execute  button. 

 

 
(To the next page) 

5)  The message box on the left is displayed. 
Click the  Yes  button.  
 
The program memory or device memory is 
formatted. 
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(From the previous page) 

 

 

 

6)  Format the target memory "standard RAM" or 
"Standard ROM" as with "Program 
memory/Device memory". 

 
7)  Close the Format the PLC memory dialog 

box. 

 

 

(3)  Select "Include latches" and clear the CPU to be mounted from the PLC memory. 

 

 

 

1)  Click the [Online] → [PLC Memory Operation] 
→ [Clear PLC Memory] menu. 

 

 

2)  The Clear the PLC memory dialog box is 
displayed. Select "Include latches". 

 
3)  Click the  Execute  button. 
 

 

4)  The message box on the left is displayed. 
Click the  Yes  button.  
 
The PLC memory is cleared. 

 
5)  Close the Clear the PLC memory dialog box. 
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(4)  To the program memory/device memory in the PLC, write the files saved earlier 

(except the device memory) such as parameters and programs by referring to the 

[Program memory] field in the checklist. 

 

(1)　 Click!

 

 

1)  Click the [Project] → [Open] menu. 
 
2)  Open the project saved in (6) in 12.1.2. 

 
*  Be careful not to open a wrong project. 

(3)　 Click!

 

 

3)  Click the [Online] → [Write to PLC] menu. 
 

 

 

4)  The Write to PLC dialog box is displayed. Set 
the target memory to "Program 
memory/Device memory". 

 
5)  Click the [File selection] tab and select 

programs, parameters and so on (except for 
the device memory) by referring to the 
"Program memory" field in the checklist. 

 
6)  Click the  Execute  button to write to the 

PLC. 
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(5)  To the standard RAM in the PLC, write the files saved earlier referring to the 

[Standard RAM] field in the checklist. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Write to PLC] menu. 

 

 

2)  The Write to PLC dialog box is displayed.  
 
Set the target memory to [Standard RAM]. 

 

 

3)  Check the write range ((The number of bytes 
checked during PLC read ÷ 2) - 1) and click 
the  button for the file register.  
 
Select a file by referring to the [Standard 
RAM] field in the attached checklist. 

 
4)  Click the  OK  button and then click the  

 Execute  button to write to the PLC. 

 

(6)  To the standard ROM in the PLC, write only the stored files by referring to the 

[Standard ROM] field in the checklist.  

Open the project saved in (10) of 12.1.2 and write the stored files to the PLC by 

referring to the [Standard ROM] field in the attached checklist. 
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(7)  For the memory card, verify all the files with those in the PLC by referring to the 

[Memory card] field in the checklist. 

 

(1)

 

 

1)  As in (4), open the project saved in "(11)" in 
12.1.2. 

 
2)  Click the [Online] → [Verify with PLC] menu. 

 

 

3)  The Verify PLC dialog box is displayed.  
 
Set the target memory to [Memory card 
(SRAM), (Flash) or (ATA)]. 

 

 

4)  Refer to the [Memory card] field in the 
checklist and select the same data in the 
verify source and destination. 

 
5)  Click the  Execute  button to verify the data 

in the PLC. 

6)  Confirm that there is no mismatch. 
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(8)  Check with the administrator and set the clock if needed. 

 

(1)　 Click!

 
 

1)  Click the [Online] → [Set Clock] menu. 

 

2)  The Clock setting dialog box is displayed.  
 
Set the year/month/day, time, and day of the 
week. 

 
3)  Click the  Set  button. 

 

(9)  Before powering OFF/ON theprogrammable controller, check with the 

administrator.  

Power OFF the programmable controller once, and then turn ON the power again. 
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(10) Select "Detail" for the device memory and click "Default" in the "Device detailed 

setting". Then,after confirming that S (Step relay) is deselected, write to the PLC 

and verify the data.  

<<* Deselect S in the device setting.>> 

(A verification error may occur for the SM, SD or refresh device.) 

 

(1)　 Click!

 

 

1)  As in (4), open the project saved in (8) of 
12.1.2. 

 
2)  Click the [Online] → [Write to PLC] menu. 

 

 

3)  The Write to PLC dialog box is displayed.  
 
Set the target memory to [Program 
memory/Device memory]. 

 
4)  Use the file selection to select files for the 

device memory. 
 
* Be careful not to select wrong file names. 

 

5)  Click the  button. 

 

 

6)  Click the  Default  button. 

 

 

7)  The message box on the left is displayed. 
Click the  Yes  button. 

 

 

(To the next page) 

8)  Check that the step relay (S) is deselected 
( ). 

 
9)  Click the  Execute  button to write to the 

PLC. 
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(From the previous page) 

 

 

(10)　 Click!

 

 

10)  As in (7), click the [Online] → [Verify PLC] 
menu. 

 

11)  The Verify PLC dialog box is displayed.  
 
Set the target memory to [Program 
memory/Device memory]. 

 
12)  Select a file by referring to the [Device data] 

field in the attached checklist. 
 

13)  Click the  Execute  button to verify the data 
in the PLC. 

 

 14)  Confirm that the device data matches. 
 
* The SM, SD and device used for link refresh 

may be mismatched. 
 

(11) If SFC is used for the program, reset the CPU. 

→  If there is data being processed, malfunction may occur because SFC starts 

up from the initial step. 

→  If there is necessary data outside the latch range, select only that device and 

write it to the PLC. 

 

A different icon appears.

 

1)  Check if an SFC program is used. 
 
2)  If an SFC program is used, reset the CPU. 

 
(a)  Push down the RUN/STOP/RESET switch on 

the front of the CPU towards the RESET side 
for one second or more. 

(b)  Remove the hand from the switch after 
ERR.LED flashes and then turns off. 

 
(To the next page) 
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(12) When using the "CPU module replacement" function to restore data, follow the 

procedure below: 

 

 

 

1)  Click the [Online] → [CPU Module Change] 
→ [Restore] menu. 

 

 

2)  Click the  Execute  button.  
The data restoration starts. 

3)  Once the restoration is normally completed, 
the [Status] screen is displayed as in the 
image on the left. 
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12.1.5 Operation Check 

(1)  Check that there is no error for the CPU. Also, check that there is no error for the 

module mounted on the system monitor. 

 

(1)　 Click!

 

 

1)  Click the [Diagnostics] → [PLC Diagnostics] 
menu. 

 

 

2)  Click the  Clear History  button. 
 
 

 

3)  The message box on the left is displayed. 
Click the  Yes  button. 

 
4)  Confirm that the error history has 

disappeared and then close the PLC 
diagnostics dialog box. 

 

(2)  Before setting RUN/STOP/RESET switch of the CPU to RUN, check with the 

administrator. 

*  The user should have checked the start-up procedure of the system. (Some 

applications may require to reset again → RUN.) 

 

(3)  Check that there is no error for the CPU. If any faults are found in the replacement, 

return the removed CPU to the original place. 

 In the LED on the front of the CPU, check that there is no error for the CPU. 
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Appendix 1 Online Program Change 

 
This section describes the operation to change programs or data (Online Program 

Change) when the programmable controller CPU is in the RUN status. 

 

There are two types of Online Program Changes: online change of a program in unit of 

ladder block and the one in unit of files. 

When performing online program change, have a good understanding of the following 

and the descriptions in Appendix 1.3 and operate carefully. 
 

WARNING ● When data change, program change, or status control is performed from a 
personal computer to a running programmable controller, configure an 
interlock circuit outside the programmable controller system to ensure that 
the entire system will always operate safely.  
Furthermore, for the online operations performed from a personal 
computer to a programmable controller CPU, predetermine the system’s 
corrective actions in case of a communication error caused by poor cable 
connection, etc. 

 

CAUTION ● When performing online operations (program change while a 
programmable controller CPU is running, forced input/output operation, 
operating status changes such as RUN-STOP, and remote control 
operation) for the running programmable controller CPU from a personal 
computer, read the manual carefully and ensure sufficient safety before 
operation.  
When changing a program while a programmable controller CPU is RUN 
(online program change), a problem such as program corruption may 
occur depending on operating conditions. Fully understand the 
precautions described in this section before use. 
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Appendix 1.1 Online Program Change in Unit of Ladder Blocks 

 
[Purpose of setting] 

To change a part of a program when the programmable controller CPU is in the RUN 

status. 
 

[Operating procedure] 

Check that the program matches the one on the programmable controller CPU using 

the Verify with PLC function in advance. 

If the part to be written does not match with the program on the programmable 

controller CPU, online program change cannot be performed. 

 

1. Change or modify the program. 

2. Select [Conversion] → [Conversion (Online Program Change)] ( Shift  ＋  F4 ) 

to execute online change. * 

 
 
*: With the following setting, online program change can be executed by selecting 

[Conversion] (or pressing  F4 ). This setting is useful if programs are always 

changed by online change.  

<Setting> 

Select the [Tool] → [Option] → [Program Common] tab screen, and select 

"Execute online change after conversion" in the online program change setting. 

 

[Description] 

Online program change can be performed when the mode is Write Mode or Monitor 

(Write Mode). 

When the programmable controller CPU is in the STEP-RUN status, online program 

change is not allowed. 

An attempt to execute online program change will display the following dialog box. 

Carefully read the displayed message and execute online change. 

 

 

Click the  Yes  button to write the changed program to the programmable controller CPU. 
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POINT  

 When performing Online program change to a programmable controller CPU 
for the first time, or an error occurs during Online program change, check the 
programs with the Verify with PLC function. 

 When the number of steps exceeds the writable range for online change as 
NOP instructions exist 
When the number of steps exceeds the writable range for online change as 
NOP instructions exist after a ladder block, select "Do not shift the program 
forward" before executing online change. For setting to move programs 
forward, refer to the GX Works2 Operating Manual.  
When changing the step 0 (LD X1) of the following program to LD X3, if "Shift 
the program forward" is selected, online program change cannot be performed. 

Ladder mode List mode 

0

X1

M0

601

X2

M10

 

0 LD X1 
1 OUT MO 
2 NOP 
3 NOP 

 
600 NOP 
601 LD X2 
602 OUT M10 

When programs are shifted forward 
Online program change cannot be performed because steps 0 to 600 are the
target. 

When programs are not shifted forward 
Online program change can be performed because steps 0 to 1 are the target. 
 

 For precautions for and restrictions on label programs, refer to the GX Works2 
Operating Manual. 
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Appendix 1.2 Online Program Change in Unit of Files 

 
[Purpose of setting] 

To execute batch writing of programs and data in unit of files when the programmable 

controller CPU is in the RUN status. 
 

[Operating procedure] 

[Online] － [Write to PLC] 
 

[Description] 

Data such as sequence programs and device comments can be written with online 

program change. 

The data that can be written with Online program change differs depending on the 

write target memory. 

For details, refer to the following manual. 

 QCPU User's Manual (Function Explanation, Program Fundamentals) 

 

An attempt to execute online program change in unit of files will display the following 

dialog box. 

Read and understand precautions shown as messages and execute online change. 

 

 

 
Click the  Yes  button to write the data specified on the Write to PLC screen to the 

programmable controller CPU. 

 

POINT  

 When the capacity of the programmable controller CPU is not enough, switch 
the programmable controller CPU to STOP status, delete unnecessary 
programs written in it, and then write the program using the Write to PLC 
function. 

 After online change of a SFC program is executed in unit of files, the CPU 
module the program is initialized and starts up. 
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Appendix1.3 Precautions for Online Program Change 

Precautions for online change are described below. 

 

(1) Precautions for using rise, fall, or SCJ instruction 
 

1) Fall instruction 

Even if the execution condition for a fall instruction in an online changed 

ladder *1 is not satisfied (in continuity state), the fall instruction is executed.  

For fall instructions, refer to the programming manual of each series. The 

following are examples of the instructions. 
 

Fall instruction: PLF, LDF, ANDF, ORF, MEF, FCALLP, EFCALLP, and XCALL 

ON/OFF status of contact 
(Conductive status at online 

change) 
Rise instruction Fall instruction 

OFF Not executed Executed 
ON Not executed Not executed 

*1:  When a new ladder block is inserted without changing existing 

programs, the added program is written together with the next ladder 

block to the programmable controller CPU. (If the next ladder block 

does not exist, the previous ladder block is written together.)  
Thus online program change may not be completed at a time 

depending on the number of program steps of the added program and 

the previous or next one. In this case, reduce the number of steps 

written at a time and perform online program change in several times. 

*2:  The execution of fall instruction can be disabled from Online Program 

Change setting, which is displayed by selecting "Tool option". 

<Example> 

Programs added by pasting
and inserting a row

Programs on the left is also
written to the programmable
controller

 
 

2)  Rise instruction 

When writing is completed, even if the execution condition for a start-up 

execution instruction (PLS instruction / P instruction) is ON, the start-up 

execution instruction is not executed. 

When the execution condition turns OFF → ON again, the start-up 

execution instruction is executed. 
 

3)  SCJ instruction 

When writing is completed, if the execution condition for SCJ instruction is 

ON, the instruction executes a jump to the specified pointer without waiting 

for 1 scan. 
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POINT  

When online program change to a QCPU (Q mode) or QnACPU module is 
completed, even if the execution condition for a fall instruction is not OFF, the fall 
instruction is executed. This phenomenon can be avoided using EGF instruction. 
For details, refer to version "I" or later of the following manual. 
 QCPU (Q mode) / QnACPU Programming Manual (Common Instructions). 

How to confirm the manual version: Check the revision history of the manual. 
 

SH(name) -080021-I
Print date * Manual number Revision

Manual version

June 2004

 
 

 

(2)  Precautions for Q/AnA series 

Precautions for online change are described below. 

 

Item Description 
Online program change to 
another station 

 Online program change to another station is possible via MELSECNET (II, 
/10, H) or Ethernet. 

During boot operation 
Online program 
change to the built-in 
RAM (QnA series) 

 When performing online change to the built-in RAM during a boot operation, 
after the status is switched to STOP, write the changed program to the IC 
memory card. 

 

Online program 
change in the backup 
mode (redundant 
CPU) 

 Online change during boot operation in the backup mode is performed on the 
program memory and transfer source drive of both systems (connective 
system and target system).  
(The transfer source drive can be a memory card (RAM or ROM) or standard 
ROM.) 

Deletion of a 
corresponding device from 
a program 

 When the corresponding device no more exists in the program due to 
deletion in an OUT instruction or device number change, the output status is 
retained.  
Select [Debug] → [Forced input output registration/cancellation] and forcibly 
turn OFF coil outputs unnecessary in control. 

Number of steps can be 
written in online program 
change 

When the number of program steps after editing (addition / deletion) is within 
512, the program can be written. 
However, if a new program is added by pasting or inserting a row without 
changing existing programs, the maximum number of steps cannot be written at 
a time. 
In this case, reduce the number of steps written at a time and perform online 
program change in several times. 
In addition, be careful of modifications as follows. 
When step 2 of the program is modified and step 540 is added, online program 
change cannot be performed because steps 2 to 540 are the target to be 
written at a time. 
In this case, perform online program change for each modification. 

Online program change 
while low-speed execution 
type programs are running

If low-speed execution type programs are running, online change starts when 
the execution of all the programs is completed. During online change, the 
execution of low-speed execution type programs is suspended. 
However, if "PRG TIME OVER(5010)" keeps occurring while a low-speed 
execution type program is executed, online program change cannot be 
performed. 
In this case, set the programmable controller CPU to STOP, and increase the 
constant scan time and low-speed program execution time in the PLC 
Parameter setting, then execute online program change again. 
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Item Description 

Reserved area for online change 
For Q series  If the currently set number of secured steps is exceeded during online 

program change, the following dialog box is displayed. Set a new number of 
reserved steps. 

 When the number of secured steps is set to 0 on the dialog box below, only 
sequence programs which exceed the secured range will be written. 

 When performing online change to a sequence program protected by a 
password, the Input Disable Password dialog box is displayed.  
Disable the password before executing online program change.  
Online change cannot be executed without disabling the password. 

 The number of secured steps newly set on the following dialog box is not 
displayed on the <<Program>> tab of the Write to PLC screen. 

 

 
 
When connecting to a Basic model QCPU function version A, steps for online 
change are automatically secured and the above dialog box is not displayed. 

 

Redundant CPU When re-securing steps for online program change in the backup mode, the 
maximum number of steps is based on either the capacity of the control system 
or that of the standby system, whichever is smaller. 
Example)  When the empty capacity of control system is 100 steps and the 

empty capacity of standby system is 50 steps 
The maximum number of steps which can be reserved for online 
program change again is 50. 

For system configured with a redundant CPU 
Backup mode Online change is performed on both systems (connective system and target 

system). 
However, if the target system fails (communication cannot be established with 
the target system), online program change is not performed on either of the 
systems. 

 

Separate 
mode/debug mode 

Online change is only performed on the programmable controller CPU specified 
in the redundant CPU setting field on the Transfer Setup screen. 
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Appendix 1.4 Actions to Be Taken When Online Change Is Not Properly Completed 

 
[Description] 

The following error message may be displayed during online program change because 

of timeout of the check time. Follow the message to take actions. 

 

(1) If the following dialog box is displayed, the program on GX Works2 is not 

converted but the program on the programmable controller CPU may be 

changed.  

In this case, convert the program on GX Works2 and verify it against the 

program on the programmable controller CPU to confirm that these programs 

match.  

If the programs do not match, write the program to the programmable controller 

CPU using the Write to PLC function to match them. 

 

 
 

(2) The following dialog box may be displayed if the time check time set in Transfer 

Setup is short.  

Select [Online] - [Transfer Setup] and set a longer time check time on the screen.  

During online program change, time check is carried out at intervals of 90 

seconds even if the time check time set on the Transfer Setup screen is less 

than 90 seconds. Set a time check time longer than 90 seconds. 
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Appendix 2 Index Modification 

Appendix 2.1 Index Modification Overview 

(1) Index modification is an indirect setting using an index register.  

When index modification used in a sequence program, the device to be used is 

indicated by the directly specified device number plus the content of the index 

register. For example, when D2Z2 is specified and the content of Z2 is 3, the 

target device is D(2 + 3) = D5. 

 

(2) Only Universal model QCPUs allow modification with 32-bit values as well as 

16-bit values. 

 

Appendix 2.2 16-bit Index Modification 

(1) Modifying with 16-bit values 

Each index register can be set to a value between -32768 to 32767.  

The following is an example of index modification. 

Store data
"D10Z0 = D {10 + (-1)} = D9"
to D0.

Store -1 to Z0.

Index modification
 

(2) Devices to which index modification can be made 

With the exception of the restrictions noted below, index modification can be 

made to devices used with contacts, coils, basic instructions, and application 

instructions. 

 

(a) Devices to which index modification cannot be made 

 
Device Description 

K, H 32-bit constant 
E Floating-point data 
$ Character string data 

.  Bit-specified word device 
FX, FY, FD Function device 
P Pointers used as labels 
I Interrupt pointers used as labels 
Z Index register 
S Step relay 
TR SFC transition device *1 
BL SFC block device *1 

 

*1:  SFC transition device and SFC block device are devices for SFC.  

For how to use, refer to the following manual.  

 QCPU (Q mode) / QnACPU Programming Manual (SFC) 
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(b) Devices to which index modification is not allowed 

 

Device Description Application example 

T  Only Z0 and Z1 can be used for 
timer contacts and coils  

C  Only Z0 and Z1 can be used for 
counter contacts and coils 

 

 

REMARKS 

There is no restriction on index register numbers used for the current values of 

timers and counters. 

Timer setting value

Timer current value

Counter setting value

Counter current value

 

 

(3) The following are examples of index modifications and actual process devices.  

(When Z0 = 20, Z1 = -5) 

 
Ladder example Actual process device 

 

Description

Converts K20 to hexadecimal

 

 
Hexadecimal

Description
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Appendix 2.3 32-bit Index Modification (Universal Model QCPU Only) 

For 32-bit index modification, the following two options are available as 

specification methods of index registers. 

 Specifying the range of index registers used for 32-bit index modification. 

 Specifying 32-bit index modification using "ZZ". 

 

POINT  

32-bit index modification using "ZZ" is allowed only for the CPU modules 
described below. 
 QnU(D)(H)CPU whose the first five digits of the serial number are "10042" or 

later. 
 QnUDE(H)CPU 

 

(1) Specifying the range of index registers used for 32-bit index modification 

 

(a) Devices to which index modification is not allowed 

Each index register can be set to a value between -2147483648 to 

2147483647.  

The following is an example of index modification. 

Stores 40000 to Z0.

Stores data "ZR10Z0 =
ZR{10 + 40000} =
ZR40010" to D0.

Index modification
 

(b) Specification method 

For modification with a 32-bit value, specify the start number of the index 

registers to be used in the Device setting of the PLC Parameter setting of GX 

Works2. 

 
 

POINT  

When the start number of the index registers to be used is changed in the Device 
setting of the PLC Parameter setting, do not change the parameter only or do not 
write only the parameter into the programmable controller. Be sure to write the 
parameter into the programmable controller together with the program.  
Forcibly writing the parameter causes CAN'T EXE.PRG. error (Error code: 2500). 
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(c) Devices to which index modification can be made 

Index modification can be made only to devices described below. 
 

Device Description 

ZR 
File register in the serial number access
method 

D Extended data register 
W Extended link register 

 

(d) Range of usable index registers 

The following table shows the range of usable index registers for 32-bit index 

modification.  

For 32-bit index modification, the specified index register (Zn) and the next 

index register (Zn+1) are used. Be sure not to overlap index registers to be 

used. 
 

Set value Index registers to be used Set value Index registers to be used 
Z0 Z0, Z1 Z10 Z10, Z11 
Z1 Z1, Z2 Z11 Z10, Z11 
Z2 Z2, Z3 Z12 Z12, Z13 
Z3 Z3, Z4 Z13 Z13, Z14 
Z4 Z4, Z5 Z14 Z14, Z15 
Z5 Z5, Z6 Z15 Z15, Z16 
Z6 Z6, Z7 Z16 Z16, Z17 
Z7 Z7, Z8 Z17 Z17, Z18 
Z8 Z8, Z9 Z18 Z18, Z19 
Z9 Z9, Z10 Z19 Cannot be used. 

 

(e) The following are examples of index modifications and actual process 

devices.  

(When Z0 (32 bits) = 100000, Z2 (16 bits) = -20) 
 

Ladder example Actual process device 

 

Description

 

(2) Specifying 32-bit index modification using "ZZ" 
 

(a) By using "ZZ" like "ZR0ZZ4", 32-bit index modification can be specified with a 

desired index register.  

The following is an example of 32-bit index modification using "ZZ". 

100000 to Z4 and Z5

Modifies ZR with 32 bits (Z4 and Z5).
It shows ZR (0 + 100000) → ZR100000.
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(b) Specification method 

To enable 32-bit index modification using "ZZ", set "Use ZZ" in "Indexing 

Setting for ZR Device" in the PLC Parameter setting of GX Works2. 

 
 

(c) Devices to which index modification can be made 

Index modification can be made only to devices described below. 
 

Device Description 

ZR 
File register in the serial number access
method 

D Extended data register 
W Extended link register 

 

(d) Range of usable index registers 

The following table shows the range of usable index registers for 32-bit index 

modification using "ZZ".  

For 32-bit index modification using "ZZ", specify in a format of ZRmZZn.  

Specifying in the format of ZRmZZn modifies the device number ZRm with a 

32-bit value in Zn and Zn+1. 
 

"ZZ" 
specification*1 Index registers to be used 

"ZZ" 
specification*1 Index registers to be used 

ZZ0 Z0, Z1 ZZ10 Z10, Z11 
ZZ1 Z1, Z2 ZZ11 Z10, Z11 
ZZ2 Z2, Z3 ZZ12 Z12, Z13 
ZZ3 Z3, Z4 ZZ13 Z13, Z14 
ZZ4 Z4, Z5 ZZ14 Z14, Z15 
ZZ5 Z5, Z6 ZZ15 Z15, Z16 
ZZ6 Z6, Z7 ZZ16 Z16, Z17 
ZZ7 Z7, Z8 ZZ17 Z17, Z18 
ZZ8 Z8, Z9 ZZ18 Z18, Z19 
ZZ9 Z9, Z10 ZZ19 Cannot be used. 

 

*1:  indicates the target device name (ZR, D, or W) to be modified. 
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(e) The following are examples of 32-bit index modifications with "ZZ" and actual 

process devices.  

(When Z0 (32 bits) = 100000, Z2 (16 bits) = -20) 

 
Ladder example Actual process device 

 

Description

 

(f) Functions which allow modification with "ZZ" 

The following list shows functions of GX Works2 which allow 32-bit index 

modification using "ZZ". 

 
No. Function name and description 
1 Device specification in program instruction 
2 Entry data monitor 
3 Device test 
4 Executional conditioned device test 
5 Monitor condition setting 

6 
Sampling trace 
(Trace point (device specification), Trace target device) 

 

POINT  

ZZn cannot be used alone as a device like "DMOV K100000 ZZ0". When setting 
a value in an index register for 32-bit index modification using "ZZ", set it in Zn (Z0 
to Z19).  
ZZn alone cannot be input to each function. 

 

For details, refer to QCPU User's Manual (Function Explanation, Program 

Fundamentals) and QCPU Programming Manual (Common Instructions). 
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Appendix 2.4 Index Modification to Extended Data Registers (D) or Extended Link Registers (W) 

(Universal Model QCPU) 

Like index modification to data registers (D) and link registers (W) which are 

internal user devices, index modification to extended data registers (D) or 

extended link registers (W) is allowed in device specification. 

User program

Index modification inside
an internal user device

Index modification inside
an extended data register

D device image

Internal
user device

Extended
data register

 

(a) Index modification where the device number crosses over the boundary 

between the internal user device and the extended data register (D) or 

extended link register (W) 

The specification of index modification where the device number crosses 

over the boundary between the internal user device and the extended data 

register (D) or extended link register (W) cannot be made. If device range 

check is enabled for index modification, an error occurs.  

(Error code: 4101) 

User program

Index modification inside
an internal user device D device image

Internal
user device

Extended
data register

Index modification crossing over
the boundary between the internal
user device and the extended data
register is not allowed.
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(b) Index modification where the device number crosses over the boundary 

among the file register (ZR), extended data register (D), and extended link 

register (W) 

Index modification where the device number crosses over the boundary 

among the file register (ZR), extended data register (D), and extended link 

register (W) will not cause an error.  

However, if the result of index modification to a file register (ZR), extended 

data register (D), or extended link register (W) changes the file register range, 

an error occurs. (Error code: 4101) 

User program

An error is not detected in index
modification crossing over the
boundary between the file register
and the extended data register (D).

An error is not detected in index
modification crossing over the
boundary between the extended
data register (D) and extended link
register (W).

An error is detected if the result of
index modification exceeds the
range of the file register file.

File register file

File register
(8 K points)

Extended data
register (D)
(8 K points)

Extended link
register (W)
(8 K points)
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Appendix 2.5 Other Index Modifications 

(1) Bit data 

Index modification to a device number with digit specification is allowed.  

However, index modification to a digit specification is not allowed. 

Acceptable because it is index
modification to a device number
If Z2 = 3, it will be X (0 + 3) = X3.

Not acceptable because it is index
modification to a digit specification

 

(2) For an intelligent function module device *1, index modification to both the start I/O 

number of intelligent function module and the buffer memory address is allowed. 

If Z1 = 2 and Z2 = 8, it will be
U(10 + 2)\G(0 + 8) = U12\G8.  

(3) For a link direct device *1, index modification to both the network number and the 

device number is allowed. 

If Z1 = 2 and Z2 = 8, it will be
J(1 + 2)\K4X(0 + 8) = J3\K4X8.

 

*1:  For intelligent function module devices and link direct devices, refer to the 

following manuals.  

 QCPU User's Manual (Function Explanation, Program Fundamentals) 

 QnACPU Programming Manual (Fundamentals) 

 

(4) For a cyclic transmission area device *1, index modification to both the start I/O 

number of CPU module and the CPU shared memory address is allowed. 

If Z1 = 2 and Z2 = 8, it will be
U3E(0 + 2)\G(0 + 8) = U3E2\G8.

 

*2:  For cyclic transmission area devices, refer to the following manual.  

 QCPU User's Manual (Function Explanation, Program Fundamentals) 
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(5) 32-bit index modification to extended data registers (D) or extended link registers 

(W) 

(Universal model QCPU) 

For index modification to extended data registers (D) or extended link registers 

(W), the following 2 options are available as specification methods of index 

registers as in the case of index modification to file registers (ZR).  

 Specifying the range of index registers used for 32-bit index modification.  

 Specifying 32-bit index modification using "ZZ". 

 

 

Appendix 2.6 Precautions 

(1) Index modification between FOR to NEXT instructions 

Pulse output is possible between FOR to NEXT instructions by using an edge 

relay (V).  

However, pulse output using the PLS/PLF/pulse conversion (P) instruction is 

not allowed. 

 

[When an edge relay is used] 
(M0Z1 provides normal pulse output.) 

 [When no edge relay is used] 
(M0Z1 does not provide normal pulse 

output.) 

 

REMARKS 

The ON/OFF information of X0Z1 is stored in the edge relay V0Z1.  

For example, the ON/OFF information of X0 is stored in V0, and that of X1 in V1. 
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(2) Index modification in CALL instruction 

Pulse output is possible in CALL instruction by using an edge relay (V). 

However, pulse output using the PLS/PLF/pulse conversion (P) instruction is 

not allowed. 

 
[When an edge relay is used] 

(M0Z1 provides normal pulse output.) 
[When no edge relay is used] 

(M0Z1 does not provide normal pulse output.) 

(3) Device range check in index modification 

 

(a) Other than Universal model QCPU 

Device range check is not carried out for index modification.  

Thus if the result of an index modification is out of the device range specified 

by the user, no error occurs and the data is written in another device. 

(However, if the result of an index modification is out of the range of user 

devices and the data is written in a system device, an error occurs.  

(Error code: 1103)) 

Carefully create programs with index modifications. 

 

(b) Universal model QCPU 

Device range check is carried out for index modification.  

In addition, device range check can be disabled in the PLC Parameter setting 

of GX Works2. 

 

(4) Changing the index modification range from 16 bits to 32 bits or from 32 bits to 16 

bits 

When changing the index modification range from 16 bits to 32 bits or from 32 bits 

to 16 bits, review index modifications in the program. 

For 32-bit index modification, the specified index register (Zn) and the next index 

register (Zn+1) are used. Be sure not to overlap index registers to be used. 
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Appendix 3 Questions and Answers regarding Personal Computer 

This section describes basic knowledge regarding personal computer as questions 
and answers. Use the information as necessary. 
 
Q1.  What happens if the resolution of the display is less than 800 × 600? 
 
A1.  "Icons", which should be displayed at the top end of the screen, may not be 

displayed and operations using the "icons" are not possible.  
The screen is designed to display all "icons" in the resolution specified in the 
manual. 

 
 
 
Q2.  What is operating environment? 
 
A2.  It means the combination of hardware configuration and basic software which can 

make full use of GX Works2. Models of personal computers of which operations 
are confirmed by Mitsubishi are described in "Models of personal computers of 
which operations are confirmed" (PLC-D-375) of Mitsubishi Electric FA Global 
Website.  
[Programmable controller (Q, QnA, A)] → [Product Details] → [Models of personal 
computers of which operations are confirmed] 
http://www.nagoya.melco.co.jp/details/plc/confirm/index_j.htm 
(Basically, the product operates in the operating environment described in this 
manual.) 

 
 
 
Q3.  What kind of phenomenon occurs when the CPU is Pentium R  133MHz or lower? 
 
A3.  When the CPU is Pentium R 133MHz or lower, as the processing speed is slow 

and it takes a long time to display a screen after an operation, which interferes 
with smooth operations. 
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Appendix 4 Questions and Answers regarding GX Works2 

This section describes questions and answers to solve problems in using GX Works2. 
 
Q1. During editing of a ladder diagram, each ladder is sometimes enclosed in a white 

frame depending on the type of the video card (card which for stores characters, 
figures, and pictures to be displayed as data). How can I remove the frame? 

 
A1.  Change setting as follows on the "Control panel" of 

Windows R 2000/Windows R XP/Windows R Vista R /Windows R 7. 
<Operating procedure> 
(1) Open the "Control panel". 
 ↓ 
(2) Open "System". 
 ↓ 
(3) Open the "Performance" tab. 
 ↓ 
(4) Press the "Graphics" button. 
 ↓ 
(5) Set the "Hardware acceleration" setting to the next to "None" (second mark). 

 
 
Q2. What should I do if error messages "Can not allocate Share memory" and 

"Initialization failed" are displayed at the start-up of GX Works2? 
 
A2.  Restart GX Works2. Alternatively, restart 

Windows R 2000/Windows R XP/Windows R Vista R /Windows R 7/Windows R 8 and 
then start GX Works2. 

 
 
Q3. Why does it take a long time since Setup.exe is started until the dialog box is 

displayed? 
 
A3.  It may take a long time if a resident program such as antivirus software is running. 
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Q4. Are there any matters to keep in mind if commercially available antivirus software 

application is installed in the personal computer? 
 
A4.  1)  When antivirus software is started 

(1) As the initialization process of the software at start-up takes some time, 
other applications launched from the "Startup" folder may not run properly.  
In addition, the computer may not accept operations for a while after the 
antivirus software is contained in the system tray because of the 
initialization process.  
These phenomena vary depending on specifications of the use 
environment (CPU, memory, etc.).  
It has been confirmed that they are likely to occur when the CPU is 
Pentium R  100 MHz or lower. 

 
(2) If the antivirus software is running on Windows R  Me, be sure to close the 

antivirus software before installation of the product.  
If the installation of GX Works2 is started with the antivirus software in the 
"real-time" monitoring mode, the following dialog box is displayed after 2 
to 3 seconds. 

 

_delis
エラーが発生しました。このまま続けるには，「無視」を
クリックして作業中のデータを新しいファイルに保存してください。「閉じる」を
クリックすると，このプログラムは終了します。

閉じる(C) 無視(I)

 

Close the error dialog box, uninstall the product, and then reinstall the 
product. 

 
2)  Effects on the system 

When the antivirus software is running, the software places burden on the 
system as it inspects files.  
Thus, depending on the use environment, every operation, such as start-up of 
an application, may take a long time.  
These phenomena vary depending on specifications of the use environment 
(CPU, memory, etc.).  
It has been confirmed that they are likely to occur when the CPU is Pentium R  
100 MHz or lower. 
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3)  Effects on applications 

If an application does not start up or run properly after installation of the 
antivirus software or has a problem of the same sort, follow the steps below to 
check the operation. 
(1) Uninstall the antivirus software, restart the system, and check how the 

application runs again. If the problem still occurs, it is considered not to be 
caused by the influence of the antivirus software.  
Contact the technical support of the application. 

(2) If the application properly runs after the uninstallation of the antivirus 
software, install the software again and switch the software to custom 
monitoring mode. In addition, remove or place checkmarks in checkboxes 
for specifying file extension and monitoring function setting.  
 
If the system does not start up properly even after taking steps (1) and (2), 
reinstall Windows R  
95/Windows R 98/Windows R Me/WindowsNT R Workstation4.0/Windows R

2000 Professional and the application. 
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Appendix 5 Warranty 
 

Please confirm the following product warranty details before using this product. 
 

1. Gratis warranty period and gratis warranty range 
If any failure found to be the responsibility of Mitsubishi occurs during use of the product within the gratis warranty period, 
the product shall be repaired at no cost via the sales representative or Mitsubishi Service Company. 
However, if repairs require traveling overseas from a domestic location or traveling to a remote island or an equivalent 
remote location, expenses to send an engineer will be solely at the customer's discretion. 
[Gratis warranty period] 

The gratis warranty period of the product shall be for 36 months after the date of purchase or delivery to a designated 
place. 
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be 6 months, and the 
longest gratis warranty term after manufacturing shall be eighteen 42 months. The gratis warranty period of repair parts 
shall not exceed the gratis warranty term before repairs. 

[Gratis warranty range] 
(1)  The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., which 

follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels on the 
product. 

(2)  Even within the gratis warranty term, repairs shall be charged for in the following cases. 
1)  Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure 

caused by the user's hardware or software design. 
2)  Failure caused by unapproved modifications, etc., to the product by the user. 
3)  When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if 

functions or structures, judged as necessary in the legal safety measures the user's device is subject to or as 
necessary by industry standards, had been provided. 

4)  Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the 
instruction manual had been correctly serviced or replaced. 

5)  Failure caused by external irresistible forces such as fires or abnormal voltages, and failure caused by force 
majeure such as earthquakes, lightning, wind and water damage. 

6)  Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi. 
7)  Any other failure found not to be the responsibility of Mitsubishi or that admitted not to be so by the user. 

 

2. Onerous repair period after discontinuation of production 
(1) Mitsubishi shall accept onerous product repairs for 7 years after production of the product is discontinued. 

Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc. 
(2)  Product supply (including spare parts) is not available after production is discontinued. 

 

3. Overseas service 
Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA 
Center may differ. 

 

4. Exclusion of loss in opportunity and secondary loss from warranty liability 
Regardless of the gratis warranty period, Mitsubishi shall not be liable for compensation of damages caused by any cause 
found not to be the responsibility of Mitsubishi, loss in opportunity, lost profits incurred to the user by failures of Mitsubishi 
products, special damages and secondary damages whether foreseeable or not, compensation for accidents, and 
compensation for damages to products other than Mitsubishi products and other tasks. 

 

5. Changes in product specifications 
The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice. 

 

6. Conditions of use for the product 
(1)  Mitsubishi MELSEC programmable controller shall be used in conditions where any problem, fault or failure occurring 

in the product, if any, shall not lead to any major or serious accident and where the backup and fail-safe functions are 
systematically provided outside of the product for the case of any problem, fault or failure occurring in the product. 

(2)  The programmable controller has been designed and manufactured for the purpose of being used in general 
industries. Thus Mitsubishi does not authorize the use of the product in Nuclear Power Plants and any other power 
plants operated by Power companies, and/or any other cases in which the public could be affected if any problem or 
fault occurs in the product or the use of the product in railway companies, national security or defense organizations, 
and/or any other cases in which establishment of a special quality assurance system is required. 
Notwithstanding the above, Mitsubishi may authorize use of the product in one or more of these applications, provided 
that the usage of the product is limited only for the specific applications agreed to by Mitsubishi and provided further 
that the user agrees that no special quality assurance is required. 
In addition, if the user is considering the use of the product for aircraft or aerospace, medical applications, train 
equipment, transport equipment, incineration and fuel devices, manned transportation, equipment for recreation and 
amusement, and safety devices, and/or other applications where there is a significant risk of injury to the public or 
property and especially high reliability is required for safety and control systems, the user shall contact the Mitsubishi 
representative to exchange necessary specification documents.
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Appendix 6 Programmable Controller Fault Investigation Report 

 
/        /        (Month/Day/Year)

Programmable controller fault report / investigation request 
Be sure to attach the document to the product to be sent. 

No. Item Description No. Item Description 

1 Model  

2 
Product number / 
Version 

 

3 Number of modules  

13
Handling of 
the product 

(1)  Return after repair 
(2)  No need to return 
(3)  Return after 

investigation without 
repair 

Company 
name 

Enter the proper name (of the report's 
recipient). 

4 

C
us

to
m

er
 

na
m

e 

Person in 
charge  

14

Address to 
return the 
product after 
repair / 
investigation

(Company name) 
 
(Address) 

 
 

Company 
name 

 
15

Date of 
occurrence 

      /      /        
(Month/Day/Year)

5 

P
la
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f 
oc
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r-

 
re
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e 

Person in 
charge  16

Date of 
installation 

      /      /        
(Month/Day/Year)

Company 
name 

 
17

Operation 
period 

 
6 

P
re

pa
r

ed
 b

y 

Person in 
charge  

7 
Contact for 
inquiries 

(1) 4 (2) 5 (3) 6 
18

Ambient 
temperature

(1) Normal (2) High (3) Low
(4) Others (    )°C 

8 Report 
(1)  Attached report  
(2)  Repair slip required  
(3)  Not necessary 

19
Memory in 
use 

(1) RAM (2) ROM 

9 Request number 
 

20
System 
configuration

 

10 
Construction 
number 

 

11 Arrival number  

 

12 Branch in charge  Sales area code   Appendix (1) Yes  (2) No 

 

No. Item Description 

 
 
 
 
 
 
 

21 Fault description 

 Appendix (1) Yes  (2) No 

22 
Usage conditions of  
surrounding devices 

(SV/MC/INV) 

23 Stage of occurrence (1) Installation and adjustment (2) In operation  (3) Others (  ) 

24 
Timing of 
occurrence 

(1) During energization (2) During power-on (3) During operation 
(4) At program change (5) Random (6) Others (  ) 

25 
Frequency of 
occurrence 

(1) Always (2) Only once (3) In each operation 
(4) (  ) times each month week day cycle (5) Others (  ) 

26 Process for recovery 
(1) Pressing RESET switch (2) Power OFF/ON (3) Restarting the system 
(4) Rewriting program (5) Rewriting parameters (6) Module replacement 
(7) Repair of wiring (8) Reinstallation of module (9) Others (  ) 
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Items to be checked on CPU 
No. Item Description 
27 Error message (code) (time) (     ) (   /   /   ,   :   :   )
28 Detailed error information  
29 Other error histories 

 
 
Saving of error histories 

 
 
 
Check:  (File name:        .csv) 

30 LED lighting status MODE : ON (Color:     ) Flash OFF 
RUN : ON Flash OFF 
ERR. : ON Flash OFF 
USER : ON Flash OFF 
BAT. : ON Flash OFF 
BOOT : ON Flash OFF 

31 Connection to peripheral (personal 
computer) 

RS232 : Possible Not possible 
USB : Possible Not possible 

32 Backups of programs, parameters, 
device memories, and others Check:  

33 Saving of system information Check:  (File name:        .csv) 

Other information 
 

 

 
 



 

Appendix - 27 

 
Appendix 7 QCPU Replacement Checklist 

Appendix 7.1 Qn(H)CPU Replacement Checklist (One Document for Each Machine) 

Work No. Item Check 

1 Write the date, operator, panel name, and CPU model name to the right column.  

2 Write the switch setting of the CPU to be removed and whether there is a memory card to the right column.  

P
re

pa
ra

tio
n 

3 Attach a panel name label to the surface of the CPU to be removed. 

 

4 Connect GX Developer to the CPU to be removed, and set the PLC type and transfer setup to "PLC Side/F: CPU Module".  

5 

Check that there is no error for the CPU to be removed. In addition, create a new project after starting up GX Developer and use 

the system monitor to check that there is no error for the mounted module. 

If some error occurred, write the error code and the error step to the right column and contact the user. 

 

6 Have the user set the RUN/STOP switch of the CPU to remove to "STOP".  

(1) Read all programs in the CPU program memory, parameters (PLC/network), and device comments from PLC, and save the 

project. Write the project name and file contents to the next page. 

 

(2) If the intelligent parameter is used, read it from PLC after saving the project above, and save the project again.  

(3) Select device data and initial device value in the CPU and assign it a file name. (Example: DEVICE; Write to the next page)  

Click the [Default] button in [Device data]. (Scroll the screen to ensure that all devices are selected) After reading from PLC, 

confirm that there is the data and then save the project. 

 

(4) If a file register or a local device exists in the CPU standard RAM, write the file name to the next page, read the entire range 

into the same project and then save it. 

 

(5) If the file exists in the CPU standard ROM, start up a project newly, as above, read the files, and save it using another project 

name. Write the project name and file contents to the next page. 

 

D
at

a 
ba

ck
up

 

7 

(6) If a memory card is used, read the files and save them using another project as above. However, when an SRAM card and a 

file register or local device are used, if the same file name is not used, it is possible to save them to the same project as in (1). 

Write the file contents to the next page. 

 

8 Write the SERIAL number, which is on the side of the module to be mounted, to the right column.  

9 
Set the RUN/STOP switch of the CPU to be mounted to STOP, and set other switches as described. Mount the Q6BAT 

connector. 

 

10 Have the user turn OFF the power supply of the programmable controller.  

11 Remove the target CPU from the base, and write the SERIAL number on the side to the right column.  

12 If the user's identification label is attached to it, move the label to the CPU to be mounted.  

13 If a memory card is mounted on the removed CPU, move it on the CPU to be mounted.  

14 Mount the target CPU on the base in the mounting panel and, if it is to be fixed with screws, tighten the screws.  

15 Confirm that the key switch of the mounted CPU is set to "STOP" and that other switch settings are as in the check sheet.  

R
ep

la
ce

m
en

t 

16 Have the user turn ON the power supply of the programmable controller.  

17 Check the product information of the relevant module in GX Developer system monitor, and write it to the right column.  

(1) Format the program memory/device memory, and standard RAM to be used for the PLC memory. At this point, consult the 

user whether it is necessary to reserve the system area, and if it is, configure the setting. However, because this area is only set 

when it is formatted, if the user is not sure, do not configure it. [   ] K steps 

 

(2) Select [Include latches] and clear the CPU to be mounted from the PLC memory.  

(3) Change reserved steps for online program change. Ask the user the capacity of the reserved steps for online program change 

in advance. Reserved step: [   ] steps 

 

(4) To the PLC's program memory/device memory, write the files saved earlier (except the device memory) such as parameters 

and programs to the PLC, by referring to the next page. 

 

(5) To the PLC's standard RAM, write the files saved earlier such as a file register and a local device to the PLC, by referring to the 

next page. 

 

(6) To the PLC's standard ROM, start up the saved project, refer to the next page, and write only the stored files to the PLC (flash 

ROM). 

 

(7) To the memory card, verify all the files against those in the PLC by referring to the next page.  

18 

(8) Consult the user and, if needed, set the clock.  

19 Reset the CPU.  

20 

To program memory/device memory, click the [Default] button in the [Device data], write PLC's device memory (except "S" (step 

relay)) to the CPU and verify the PLC. <<* Unset "S" in the device setting.>> 

The SM, SD or link device may have a verify error. 

 

D
at
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21 

If SFC is used for the user's program, consult the user and reset the CPU again. 

→ This is because the existing intermediary data may cause malfunction since SFC starts up from the initial step. 

→ If there is necessary data for the user outside the latch range, select only that device and write it to the PLC. 

 

22 Check that there is no error for the CPU. Also, check that there is no error for the module mounted on the system monitor.  

23 Check the error history and, if no user error exists, clear the error history.  

24 

Have the user set the RUN/STOP switch of the mounted CPU to "RUN". 

* The user should have checked the start-up procedure of the system. (Some applications may require to reset again → 

RUN.) 

 

25 If the relevant CPU is connected to a GOT additionally, power OFF and ON the GOT.  

O
pe

ra
tio

n 
ch

ec
k 

26 
Check that there is no error for the CPU. 

If the user finds the replacement faulty, return the removed CPU to the original place. 

 

Year: Month: Date:

Operator:

Panel name:

CPU model name Q CPU

Settings of switch etc.

Module to be mounted
SERIAL No.
(production information)

Module to remove
SERIAL No.
(production information)

Product information of
the CPU (replacement)

0000000000-

Error description
before replacement

Remarks

M
e

m
o

ry
ca

rd
:A

p
p

lica
b

le
/N

ot
a

p
plica

b
le
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Write all project names and file names to frames
Circle either of [Applicable/Not applicable]

Program memory [Project name: ]

[Applicable/Not applicable]

[Applicable/Not applicable]

Parameter

Intelligent parameter

[Applicable/Not applicable]

[Applicable/Not applicable]

Parameter

Intelligent parameter

Device data F
ile

n
am

e
F

ile
n

am
e

F
ile

n
am

e

Program Device comment Initial device value

Program Device comment Initial device value

Note 1) Before writing to the
PLC, ensure that the
file register, local
device, and name
are correct.

Note 2) A verification error for
some special device
(SM/SD) and link
fresh device (on a
target station) data
may occur during
PLC verification.

Standard RAM

Standard ROM [Project name: ]

Note) Use the same project as the program memory.
Before write to PLC, ensure that the destination and the
file name are correct. Writing to the PLC shall be done to
the standard RAM.

File register Local device

Memory card [Project name: ]
Memory card name
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Appendix 7.2 QnU(D)(E)(H)CPU Replacement Checklist (One ocument for Each Machine) 

Work No. Item Check 

1 Write the date, operator, panel name, and CPU model name to the right column.  

2 Write the switch setting of the CPU to be removed and whether there is a memory card to the right column.  

P
re

pa
ra

tio
n 

3 Attach a panel name label to the surface of the CPU to be removed. 

 

(1) Start new GX Works2, connect it to the CPU to be removed, select the PLC series (QCPU (Q mode)), and configure the 

transfer setup to "Programmable Controller Side I/F: CPU Module". * PLC direct connection 

 

(2) Delete the program "MAIN" from the project data.  

(3) Delete global device comments from the project data.  

4 

(4) Delete the device memory "MAIN" from the project data.  

5 
Check that there is no error for the CPU to be removed, and use the system monitor to check that there is no error for the 

mounted module. If some error occurred, write the error code and the error step to the right column and consult the customer. 

 

6 Have the customer set the RUN/STOP/RESET switch of the CPU to remove to "STOP".  

(1) Write file contents in the program memory to the next page. Select all of the program range, parameters (PLC/Network/Remote 

password/Switch setting/Intelligent function module parameters), global device comment, and initial device values. Select [Also read 

the remaining reserved step capacity for online program change] in the program "details" to read from PLC. Finally, save the project (in 

a single file format). (If the "Select read module model name" dialog appears after the "Execution" of the read from PLC, select the 

implemented model.) Write the save destination to the next page. * Read data other than device data. 

 

(2) Select device data (device memory) in the program memory. Select the device memory "details", and click "Default" on the 

"Device data detailed setting". (Scroll the screen to ensure that all available devices are selected) Assign a file name for a device 

data name. (Example: DEVICE; Write to the next page) 

After the read from PLC, confirm that there is the data and then save the project. 

 

(3) If a file register exists in the standard RAM, write the file name and file size (in bytes) to the next page, read the entire range 

into the identical project and then save it. (Select "details" to select the entire range.) 

 

(4) If files exist in the standard ROM, write the file content to the next page, start up new GX Works2, read the files in a similar way 

to the above 4-(1) and its following steps, and save them using another project name. However, if it is device comments or 

likewise, and there is no similar file to the program memory, the user can save them to the same project as in (1). 

 

(5) If a memory card is used or files exist, write the file content to the next page, start up new GX Works2, read the files in a similar 

way to the above 4-(1) and its following steps, and then save it using another project name. However, if it is a file register or 

likewise, and there is no similar file to the program memory, the user can save them to the same project as in (1). 

 

D
at

a 
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7 

(6) From GX Works2, run [Online] → [Program memory batch transfer] and check whether the content of the program cache 

memory matches that of the program memory. 

* If it does not, or if the user cannot check the whether or not it does depending on the CPU version, a message "Do you 

transfer...?" may appear. Then, click the "Yes" button to perform the batch transfer so that they will match. 

 

8 
Write the SERIAL number and MAC address (only for the CPU board with Ethernet enabled), which are on the side or under the 

face plate of the CPU to be mounted, to the right column. 

 

9 
Set the RUN/STOP/RESET switch of the CPU to be mounted to "STOP". Also, connect the battery connector at the bottom of the 

module. 

 

10 Have the customer turn OFF the power supply of the programmable controller.  

11 
Remove the target CPU from the base, and write the SERIAL number and MAC address (only for the CPU board with Ethernet 

enabled), which are on the side or under the face plate, to the right column. 

 

12 If the customer's identification label is attached, move it to the CPU to be mounted.  

13 If a memory card is mounted on the removed CPU, move it on the CPU to be mounted.  

14 Mount the target CPU on the base in the mounting panel and, if it is to be fixed with screws, tighten the screws.  

15 Confirm again that the RUN/STOP/RESET switch of the mounted CPU is set to "STOP".  

R
ep
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16 Have the customer turn ON the power supply of the programmable controller.  

17 Check the product information of the mounted CPU in GX Works2 system monitor, and write it to the right column.  

(1) Format the program memory, standard RAM, and standard ROM to be used for the PLC memory. At this point, consult the 

user whether it is necessary to reserve the system area, and if it is, configure the setting. However, because this area is only set 

when it is formatted, if the customer is not sure, leave it as the default. [   ] K steps 

 

(2) Select "Include latches" and clear the CPU to be mounted from the PLC memory.  

(3) To the PLC's program memory/device memory, write the files saved earlier (except the device memory) such as parameters 

and programs to the PLC, by referring to the next page. 

 

(4) To the PLC's standard RAM, write the files stored before by referring to the next page.  

(5) To the PLC's standard ROM, write only the stored files by referring to the next page.  

(6) To the memory card, verify all the files against those in the PLC by referring to the next page.  

18 

(7) Consult the customer and, if needed, set the clock.  

19 Have the customer turn OFF/ON the power supply of the programmable controller.  

20 

To the PLC's program memory/device memory, select the device memory "Details", and click "Default" on the "Device data 

detailed setting". Confirm that "S" (Step relay) is deselected, write to the PLC, and verify it. 

<<* Unset "S" in the device setting.>> 

The SM, SD or link fresh device may have a verify error. 
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21 

If SFC is used for the user's program, consult the customer and reset the CPU again. 

→ This is because the existing intermediary data may cause malfunction since SFC starts up from the initial step. 

→ If there is necessary data for the user outside the latch range, select only that device and write it to the PLC. 

 

22 Check that there is no error for the CPU and use the system monitor to check that there is no error for the mounted module.  

23 Check the error history and, if no customer error exists, clear the error history.  

24 
Have the customer set the RUN/STOP/RESET switch of the mounted CPU to "RUN". 

* The user should have checked the start-up procedure of the system. (Some applications may require to reset again → RUN.) 

 

O
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25 Check that there is no error for the CPU. If the user finds the replacement faulty, return the removed CPU to the original place.  

Year: Month: Date:

Operator:

Panel name:

CPU model name Q CPU

Settings of switch etc.

Module to be mounted
SERIAL No.
(production information)

Module to remove
SERIAL No.
(production information)

Product information of the
CPU (module to be mounted)

Error description
before replacement

Remarks

M
em

ory
card:A

pplicable/N
otapplicable
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Write all project names and file names to frames
Circle either of [Applicable/Not applicable]

Parameter

[Applicable/Not applicable]

Intelligent parameter

[Applicable/Not applicable]

Device data

Initial device value
[Applicable/Not applicable]

Program Program Comment

Program memory [Project name: ]

File register File size

byte

Standard RAM

Parameter

[Applicable/Not applicable]

Intelligent parameter
[Applicable/Not applicable]

Memory card name

Memory card [Save destination: ]

Standard ROM [Save destination: ]

Note) Use the same project as the program memory.
Before write to PLC, ensure that the destination
and the file name are correct. Writing to the PLC
shall be done to the standard RAM.

 



 

Appendix - 31 

 
Appendix 8 Reference Material for Cart Conveying System Training Machine 

 
The following describes how to check problems and how to take corrective actions in the practical training in 
cart conveying system (Section 6.8). 

 
<Fault example 1> 

The cart does not move forward. (No.9 terminal of I/O signal disconnection 
terminal block is OFF) 
(1) Checking the normal operation → Press the start-up switch. 
(2) Assuming the failure → Turn OFF the No.9 terminal. 
(3) Producing faulty operation → Press the start-up switch. (It will not operate 

properly.) 
(4) Investigating the cause of faulty operation → Find the cause of the faulty 

operation by ladder monitor. 
(5) Restoring the normal condition → Turn ON the No.9 terminal. 

 
<Fault example 2> 

The cart does not stop at the position of inspection sensor (No.7 terminal of 
I/O signal disconnection terminal block is OFF) 
(1) Checking the normal operation → Press the start-up switch. 
(2) Assuming the failure → Turn OFF the No.7 terminal. 
(3) Producing faulty operation → Press the start-up switch. (It will not operate 

properly.) 
(4) Investigating the cause of faulty operation → Find the cause of the faulty 

operation by ladder monitor. 
(5) Restoring the normal condition → Turn ON the No.7 terminal. 

 
<Fault example 3> 

The cart does not move backward. 
(1) Checking the normal operation → Press the start-up switch. 
(2) Assuming the failure → Turn ON X3. 
(3) Producing faulty operation → Press the start-up switch. (It will not operate 

properly.) 
(4) Investigating the cause of faulty operation → Find the cause of the faulty 

operation by ladder monitor. 
(5) Restoring the normal condition → Turn OFF X3. 

 
<Fault example 4> 

The cart does not stop at the workpiece set position. 
(1) Checking the normal operation → Press the start-up switch. 
(2) Assuming the failure → Turn ON X2. 
(3) Producing faulty operation → Press the start-up switch. (It will not operate 

properly.) 
(4) Investigating the cause of faulty operation → Find the cause of the faulty 

operation by ladder monitor. 
(5) Restoring the normal condition → Turn OFF X2. 
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Appendix 9 Buffer Memory Access Instruction (Abstract from MELSEC-Q/L Programming Manual (Common 

Instructions)) 

Appendix 9.1 Reading One-word or Two-word Data from an Intelligent Function Module (FROM(P), DPRO(P)) 

n3

n3P

n1

n1

n2

n2

D

D

FROM, DFRO

FROMP, DFROP

Command

Command

means FROM/DFRO.

 

n1: Start I/O number 
*1

 of the intelligent function module (BIN 16 bits) 

n2: Start address of the buffer memory in which data to be read is stored (BIN 16 bits) 

D : Start number of the devices where the read data will be stored (BIN 16/32 bits) 

n3: Number of data blocks to be read (BIN 16 bits) 

 
Internal device J\ Setting 

data Bit Word 
R, ZR 

Bit Word 
U\G Zn Constants 

K, H 
Others 

U 
n1    
n2   － 

D   － － 
n3   － 

*1: Specify the first three digits of the start I/O number in four-digit hexadecimal notation. 

 

(1) Function 

 

(a) FROM 

Reads the data in n3 words from the buffer memory address specified by n2 

of the intelligent function module specified by n1 and stores it in the device 

specified by D  and later. 

CPU module
Intelligent function module
buffer memory

n3 words n3 points

Device specified by D

 

 

(b) DFRO 

Reads the data in (n3 × 2) words from the buffer memory address specified 

by n2 of the intelligent function module specified by n1 and stores it in the 

device specified by D  and later. 

CPU module
Intelligent function module
buffer memory

(n3×2) words
(n3×2) points

Device specified by D

 

 



 

Appendix - 33 

 

POINT  

Data read from intelligent function modules is also possible with the use of an 
intelligent function module device. 
For intelligent function module devices, refer to the user's manual (Function 
Explanation, Program Fundamentals) of the CPU module to be used. 

 

(2) Error 

In the following cases, an operation error occurs, the error flag (SM0) turns on and 

an error code is stored in SD0. 

 

Error 
code 

Error description 
Q00J/
Q00/
Q01

QnH QnPH QnPRH QnU LCPU

1402 
An error is detected in the intelligent function module at the 
instruction execution. 

      

1412 
Cannot communicate with the intelligent function module at the 
instruction execution. 

      

2110 
The I/O number specified by n1 does not indicate an intelligent 
function module. 

      

4101 
The range of n3 points (2 × n3 points for DFRO) from the device 
specified by D  exceeds the specified device range. 
The address specified by n2 is outside the buffer memory range.

      
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(3) Program example 

 

(a) The following program reads CH1 digital output value of the Q68ADV at I/O 

numbers 040 to 04F to D0 when X0 is turned on. (reads data by 1 word from 

the buffer memory address 11) 

[Ladder mode] [List mode]

Step Instruction Device

 

(a) The following program reads the current feed value of axis 1 of the QD75P4 

at I/O numbers 040 to 05F to D0 and D1 when X0 is turned on. (reads data 

by two word from the buffer memory address 800) 

[Ladder mode] [List mode]

Step Instruction Device

 

 

REMARKS 

1. Specify the first three digits of the start I/O number in four-digit hexadecimal 

notation as n1. 

Built-in
I/O

Power
supply

Power
supply

Start I/O number of
I/O assignment setting

Start I/O number of
I/O assignment setting

Specify K4 and H4 for read start I/O number.

Specify K6 and H6 for read start I/O number.

CPU module

Built-in
CC-Link

 

2. QCPU and LCPU offer automatic interlock of FROM and DFRO instructions. 
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Appendix 9.2 Writing One-word or Two-word Data to an Intelligent Function Module (TO(P), DTO(P)) 

n3

n3P

n1

n1

n2

n2

TO, DTO

TOP, DTOP

S

S

Command

Command

means TO/DTO.

 

n1: Start I/O number 
*1

 of the intelligent function module (BIN 16 bits) 

n2: Start address of the area where data is written (BIN 16 bits) 

S : Start number of the data to be written or the devices in which the data is stored (BIN 16/32 bits) 

n3: Number of data blocks to be written (BIN 16 bits) 

 
Internal device J\ Setting 

data Bit Word 
R, ZR

Bit Word 
U\G Zn Constants

K, H 
Others

U 
n1     
n2    － 

S   －  － 
n3    － 

*1: Specify the first three digits of the start I/O number in four-digit hexadecimal notation. 

 

(1) Function 

 

(a) TO 

Writes the data stored in n3 points from the device specified by S  to the 

buffer memory address specified by n2 and later of the intelligent function 

module specified by n1. 

n3 words

CPU module

Intelligent function module
buffer memory

n3 points

Device specified by S

 

When a constant is designated to S , writes the same data (value designated 

to S ) to the area of n3 words starting from the specified buffer memory. (A 

value between -32768 and 32767 or 0H and FFFFH can be designated to S .) 

CPU module

Intelligent function module
buffer memory

n3 words
(Write the same data)

(When 5 is specified for S)

 

 



 

Appendix - 36 

 

(b) DTO 

Writes the data stored in (n3 × 2) points from the device specified by S  to 

the buffer memory address specified by n2 and later of the intelligent function 

module specified by n1. 

Intelligent function module
buffer memory

(n3×2)
words

(n3×2) points

CPU module
Device specified by S

 

When a constant is designated to S , writes the same data (value designated 

to S ) to the area of (n3 × 2) words starting from the specified buffer memory. 

(A value between -2147483648 and 2147483647 or 0H and FFFFFFFFH can 

be designated to S .) 

Intelligent function module
buffer memory

(n3×2) words
(Write the same data)

CPU module

(When 70000 is specified for S )

 

 

POINT  

Data write to intelligent function modules is also possible with the use of an 
intelligent function module device. 
For intelligent function module devices, refer to the user's manual (Function 
Explanation, Program Fundamentals) of the CPU module to be used. 

 

(2) Error 

In the following cases, an operation error occurs, the error flag (SM0) turns on and 

an error code is stored in SD0. 

 

Error 
code 

Error description 
Q00J/
Q00/
Q01

QnH QnPH QnPRH QnU LCPU

1402 
An error is detected in the intelligent function module at the 
instruction execution. 

      

1412 
Cannot communicate with the intelligent function module at the 
instruction execution. 

      

2110 
The I/O number specified by n1 does not indicate an intelligent 
function module. 

      

4101 
The range of n3 points (2 × n3 points for DTO) of data from the 
device specified by S  exceeds the specified device range. 
The address specified by n2 is outside the buffer memory range. 

      
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(3) Program example 

 

(a) The following program sets the CH1 and CH2 of the Q68ADV at I/O numbers 

040 to 04F to "A/D conversion disabled" when X0 is turned on. (writes "3" to 

the buffer memory address 0.) 

[Ladder mode] [List mode]

Step Instruction Device

 

(b) The following program sets the positioning address/movement amount of axis 

1 of the QD75P4 at I/O numbers 040 to 05F to 0 when X0 is turned on. 

(writes 0 to the buffer memory addresses 2006 and 2007.) 

[Ladder mode] [List mode]

Step Instruction Device

 

 

REMARKS 

1. Specify the first three digits of the start I/O number in four-digit hexadecimal 

notation as n1. 

Power
supply

Power
supply

Start I/O number of
I/O assignment setting

Start I/O number of
I/O assignment setting

Specify K4 and H4 for read start I/O number.

Specify K6 and H6 for read start I/O number.

CPU module

Built-in
CC-Link

Built-in
I/O

 

2. QCPU and LCPU offer automatic interlock of TO and DTO instructions. 
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Appendix 10: High Performance Model QCPU Replacement Procedure 

Use Qn(H)CPU Replacement Checklist described in Appendix 7.1 together. 

 

POINT  

This QCPU replacement procedure describes a referential procedure for a scenario 
where the following application programs are installed. 
<Application programs> 
 All of the program memory, standard RAM, standard ROM and memory cards 

are used 
 Intelligent parameters (set via GX Configurator) are used. 
 An SFC program is used 

 

Appendix 10.1 Preparation 

(1) Enter the date, operator, panel name, and CPU model name in QnU(H)CPU 

Replacement Checklist. 

 

(2) In the checklist, enter the switch setting of the CPU to be removed and whether 

there is a memory card. 

Settings of switch etc.

Check the switch

M
em

ory
card:A

pplicable/N
otapplicable

Check the memory card

 

(3)  For identification, attach a panel name label on the surface of the CPU to be 

removed, as needed. 
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Appendix 10.2 Data Backup 

(1)  Connect GX Works2 to the CPU to be removed, and set the PLC type and 

transfer setup to "Programmable Controller Side I/F: CPU Module". 

 

(3)　Click!

 

 

1)  Connect the CPU with a personal computer 
using an RS-232C or USB cable. 

 
2)  Start up GX Works2. 
 
3)  Click the [Online] → [Read from PLC] menu. 

 

 

4)  Set the PLC series to [QCPU(Q Mode)] and 
click the  OK  button. 

 

 

 

5)  Select PC side I/F. 
  

 

 

(To the next page) 

6)  Select the cable used for connection and 
click the  OK  button.  
*  In this case, we use USB connection as 

an example for description. 
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(From the previous page) 

 

 

 

 

7)  Set PLC side I/F to the PLC Module. 
 
8)  Click the  Connection Test  button. 

 
 

 

 

9)  If properly connected, the screen on the left is 
displayed. Click the  OK  button. 

 
 If not properly connected, the following 

screen is displayed. Check the connection 
and conduct the communication test again. 

 

 

 

 

10)  Click the  OK  button. 

 

11)  The Read from PLC dialog box is displayed. 
Click the  Close  button. 
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(2)  Check that there is no error for the CPU to be removed. In addition, create a new 

project after starting up GX Works2 and use the system monitor to check that 

there is no error for the mounted module. 

 

③　クリック!(1)　 Click!

 

 

1)  Click the [Diagnostics] → [PLC Diagnostics] 
menu. 

 

 

2)  Check for errors.  
 
If there is no error, the screen on the left is 
displayed. 

 

 

 

3)  If there is any error, click the 
 Error JUMP  and  Error Help  buttons to 
enter the error details in the check sheet.  
Also, check with the user.  
 
Click the  Close  button to close the PLC 
diagnostics dialog box. 

  

③　クリック!(4)　 Click!

 

 

(To the next page) 

4)  Click the [Diagnostics] → [System Monitor] 
menu. 
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(From the previous page) 

 

 

 

5)  Check that there is no error for the mounted 
module.  
 
If there is no error, the screen on the left is 
displayed. 

 
 If there is any error for the mounted module, 

check with the user.  
 
Click the  Close  button to close the system 
monitor dialog box. 

 

 

 

(3)  Set the RUN/STOP switch of the CPU to be removed to "STOP". 

 

 

(4)  Choose all the programs, parameters (only for PLC/network), and device 

comments, select [Also read the remaining reserved capacity for online program 

change] in the program tab, read from PLC, and enter the project name and file 

contents in the checklist. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

(To the next page) 

2)  Set the target memory to [Program 
memory/Device memory]. 
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(From the previous page) 

 

 

 

 

3)  From file selection, click "Parameter + 
Program". 

 
* Even if the intelligent parameter exists, 

do not select it. 
 

4)  Click the  button of the program. 

 

 

5)  Select [Also read the remaining reserved step 
capacity for online program change]. 

 
6)  Click the  OK  button. 

 

 

7)  After the display returns to the Read from 
PLC dialog box, click the  Execute  button. 

 
8)  The message box is displayed. Click the  

 Yes for All  button. 

 

 

(To the next page) 

9)  When the read is completed, the dialog box 
on the left is displayed. Click the  OK  
button. 
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(From the previous page) 

 

 

 

 

10)  Close the Read from PLC dialog box. 
 
 From the project data list, double-click 

"Program settings" → "No execution type" → 
"(program name)".  
 
The read program is displayed. 

 

(11)　 Click!

 

 

11)  After reading from PLC, click the [Project] → 
[Save as] menu to name the project. 

 
 * Be careful not to forget the save location. 

 

12)  In the "Program memory" field in the 
Qn(H)CPU Replacement Checklist, enter the 
project name and file contents (files read).  
 
Also, enter whether or not there is a 
parameter. 

 

Write all project names and file names to frames
Circle either of [Applicable/Not applicable]

Program memory [Project name: ]

[Applicable/Not applicable]

[Applicable/Not applicable]

Parameter

Intelligent parameter

Program Device comment Initial device value
Enter
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(5)  If the intelligent parameter is used, save the project, read from PLC, and save the 

project again. 

 

 

 

1)  Confirm that the intelligent parameter is used.

 

 

2)  Select the intelligent parameter. 
 
3)  Click the  Execute  button. 
 

(4)　 Click!

 

 

4)  Close the Read from PLC dialog box, and 
then click the [Project] → [Save] menu to 
save the project. 

 

 
5)  Enter whether the intelligent parameter is selected in [Intelligent parameter] field in Qn(H)CPU 

Replacement Checklist. 

Write all project names and file names to frames
Circle either of [Applicable/Not applicable]

Program memory [Project name: ]

[Applicable/Not applicable]

[Applicable/Not applicable]

Parameter

Intelligent parameter

Program Device comment Initial device value

Enter  
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(6)  Select a device data and initial device value in the CPU and name a file.  

Click the [Default] button in the [Device data] tab. (Scroll down to confirm that all 

the devices (including X/Y) are selected.) 

After reading from PLC, confirm that there is the data and then save the project. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

2)  Set the target memory to [Program 
memory/Device memory]. 

 

 

 

3)  Select device data and an initial device value 
(if any). 

 
4)  Press the  button for the device 

memory. 
 

 

 

(To the next page) 

5)  Click the  Default  button. 
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(From the previous page) 

 

 

 

 

6)  The message box on the left is displayed. 
Click the  Yes  button. 

 

 

 

7)  Check that all the devices (except the 
retentive timer) are selected ( ). 

 
8)  Name a device data name. 

 
Example of device data name: DEVICE 
 

6)  Click the  Execute  button to read from 
PLC. 

 

 

10)  Select the read file. 
 
11)  Confirm that the device data exists. 

(11)　 Click!

 

 

(To the next page) 

12)  Close the Read from PLC dialog box, and 
then click the [Project] → [Save] menu to 
save the project. 
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(From the previous page) 

 

 

 
13)  Enter the device data name and initial device value name in [Device data] and [Program memory] 

fields in Qn(H)CPU Replacement Checklist. 
  

Write all project names and file names to frames
Circle either of [Applicable/Not applicable]

Program memory [Project name: ]

[Applicable/Not applicable]

[Applicable/Not applicable]

Parameter

Intelligent parameter

Program Device comment Initial device value

Device data

Note 1) Before writing to the
PLC th t th

F
ile

n
am

Enter

 

 

 

(7)  If a file register exists in the CPU standard RAM, enter the file name and file size 

(in bytes) in the checklist, read the entire range into the identical project and then 

save it. 

 

(1)　Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

(To the next page) 

2)  Set the target memory to [Standard RAM].  
 
Check that the file register exists. 
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(From the previous page) 

 

 

 

 

3)  Select a file and check that the entire range is 
selected. 

 

4)  Enter the file name and file size in the [Standard RAM] field in Qn(H)CPU Replacement Checklist. 
  

Note) Use the same project as the program memory.
Before write to PLC, ensure that the destination
and the file name are correct. Writing to the PLC
shall be done to the standard RAM.

Enter

y g
PLC verification.

Parameter Program Device comment Initial device value
Standard ROM [Project name: ]

byte
File sizeFile register

Standard RAM

 

 

 

 

 
 
5) Click the  Execute  button to read from PLC. 

(6)　 Click!

 

6)  Close the Read from PLC dialog box, and 
then click the [Project] → [Save] menu to 
save the project. 
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(8)  If the file exists in the CPU standard RAM, start up a project newly, as above, read 

the files, and save it as another project. 

 

(1)　 Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

2)  Set the target memory to [Standard RAM] 
and check for the file. 

 

 

* If the file exists, the tasks are as follows: 

 

(1)　Click!

 

 

1)  Click the [Project] → [New] menu. 

 

 

(To the next page) 

2)  Set the PLC series and PLC type and click 
the  OK  button. 
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(From the previous page) 

 

 

 

 

3)  The message box on the left is displayed. 
Click the  No  button. 

 

 

 

4)  A new project starts up. 
 
5)  Click the [Online] → [Read from PLC] menu 

and set the target memory to [Standard 
ROM]. 

 

 

 

6)  From the file selection, select all of the 
program, parameters (PLC/Network/Remote 
password/Switch setting), and global device 
comments and click the  button for the 
program. 

 
* Even if the intelligent parameter exists, do 

not select it. 

 

 

(To the next page) 

7)  Select [Also read the remaining reserved step 
capacity for online program change] to read 
from PLC. 
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(From the previous page) 

 

 

(8)　 Click!

 

 

8)  After reading from PLC, click the [Project] → 
[Save as] menu to name the project. 

9)  In the [Standard ROM] field in the Qn(H)CPU Replacement Checklist, enter the project name, file 
names and whether one or more parameters exist. 

  

記入

Standard ROM [Project name: ]
Parameter

[Applicable/Not applicable]

Intelligent parameter
[Applicable/Not applicable]

Program Device comment Initial device value Enter

 

10)  If the intelligent parameter exists, select "Online" → "Read from PLC" and set the target memory to
[Standard ROM]. 

 

 

 

11)  Select the intelligent parameter and read 
from PLC. 

(12)　 Click!

 

12)  Close the Read from PLC dialog box, and 
then click the [Project] → [Save] menu to 
save the project. 

 

 
13)  Enter whether the intelligent parameter is selected in [Intelligent parameter] field in Qn(H)CPU 

Replacement Checklist. 

記入

Standard ROM [Project name: ]
Parameter

[Applicable/Not applicable]

Intelligent parameter
[Applicable/Not applicable]

Program Device comment Initial device value

Enter
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(9)  If you use a memory card, read the files and save them as another project as 

above.  

However, when an SRAM card and a file register or local device are used, if the 

same file name is not used, it is possible to save them to the same project as in 

(4).  

Enter the file content in the checklist. 

 

(1) Click!

 

 

1)  Click the [Online] → [Read from PLC] menu. 

 

 

2)  Set the target memory to [Memory card 
(SRAM), (Flash) or (ATA)]. 

 

 
3)  Enter the file names in [Memory card] field in Qn(H)CPU Replacement Checklist. 

  

記入

Memory card [Project name: ]
Memory card name

Q2MEM- Enter

 

 
4)  Check if the file names are the same as those in (4). 

  

Parameter

Intelligent parameter
[Applicable/Not applicable]

Program Device comment Initial device value
[Applicable/Not applicable]

Memory card [Project name: ]

Memory card name

Q2MEM-

Program memory [Project name: ]

Check whether they are the same

MAIN

MAIN

 

 

(To the next page) 
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(From the previous page) 

 

 

(5)　Click !

 

 

5)  Click the [Project] → [New] menu. 

 

 

6)  Set the PLC series and PLC type and click 
the  OK  button. 

 

(8)　Click!

 

 

7)  A new project starts up. 
 
8)  Click the [Online] → [Read from PLC] menu. 

 

9)  Set the target memory to [Memory card 
(SRAM), (Flash) or (ATA)]. 

 

 

(To the next page) 
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(From the previous page) 

 

 

 

 

10)  Read the files. 
 

*  If a file register exists, check that the 
entire range is selected. 

 
 
 
 
11)  If "The parameters and device memory..." 

screen is displayed, click the  OK  button. 
 

 

 

12)  Read only the file register. 
 
13)  Close the Read from PLC dialog box. 

(14)　Click!

 

 

14)  After reading from PLC, click the [Project] → 
[Save as] menu to newly save the project. 

 
15)  Enter the project name in the [Memory card] field in Qn(H)CPU Replacement Checklist. 

Enter

F
il

Memory card [P ]:emantcejor

Memory card name
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Appendix 10.3 Replacement 

(1)  Enter the SERIAL number on the side or front (N/A in some cases) of the module 

to be mounted in the checklist. 

 

 

 

(2)  Set the RUN/STOP switch of the CPU to be mounted to "STOP", and set other 

switches in the same way as for the removed CPU. Also mount the battery 

connector. 

  

(3)  Turn OFF the power supply of the programmable controller. 

 

(4)  Remove the target CPU from the base and enter the SERIAL number on the side 

or front in the checklist. 

 

(5)  If an identification label is put, move it to the CPU to be mounted. 

 

(6)  If a memory card is mounted on the removed CPU, move it on the CPU to be 

mounted. 

 

(7)  Mount the target CPU on the base in the mounting panel and, if it is to be fixed 

with screws, tighten the screws. 

 

(8)  Confirm that the RUN/STOP/RESET switch of the mounted CPU to "STOP" and 

that other switch settings are as in the check sheet. 

 

(9)  Turn ON the power supply of the programmable controller. 

 

*  An error may be displayed for the CPU, but please continue with the task. 
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Appendix 10.4 Data Restoration 

(1)  Check the product information of the corresponding module in the GX Works2 

system monitor, and enter in the check sheet. 

 

 

 

1)  Click the [Diagnostics] → [System monitor] 
menu to display the system monitor dialog 
box. 

 
2)  Click the  Product Information List  button. 

 

 

3)  The product information list dialog box is 
displayed. Check the product information 
(serial number, etc.) of the corresponding 
module. 

 

 
4)  Enter the product information in the [Product information of the CPU (replacement)] field in Qn(H)CPU 

Replacement Checklist. 
face plate of the CPU to be mounted, to the right column.

9 Set theRUN/STOP/RESET switch of the CPUto mount to "STOP". Also, connect the battery connector at the bottomthe module.

10 Have the customer turn OFF the power supplyof the programmable controller.

11
Remove the target CPU from the base, and write the SERIAL number and MAC address (only for the CPU board with Ethernet

enabled), which are on the side or under the face plate, to the right column.

12 If the customer's identification label is attached, move it to the CPU to be mounted.

13 If a memory card is mounted on the removed CPU, move it on the CPU to be mounted.

14 Mount the target CPU on the base in the mounting panel and, if it is to be fixed with screws, tighten the screws.

15 Confirm again that the RUN/STOP/RESET switch of the mounted CPU is set to "STOP".

R
ep

la
ce

m
en

t

16 Have the customer turn ON the power supply of the programmable controller.

17 Check the product information of the mounted CPU in GX Works2 system monitor, and write it to the right column.

(1) Format the program memory, standard RAM, and standard ROM to be used for the PLC memory. At this point, consult the

user whether it is necessary to reserve the system area, and if it is, configure the setting. However, because this area is only set

when it is formatted, if the customer is not sure, leave it as the default. [ ] K steps

(2) Select "Include latches" and clear the CPU to be mountedfrom the PLC memory.

(3) To the PLC's program memory/device memory, write the files saved earlier (except the device memory) such as parameters
18

Product information of the
CPU (module to be mounted)

Error description
before rep lacement

 

Enter 

 
 

5)  Close the product information list dialog box and the system monitor dialog box. 
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(2)  Format the program memory/device memory, and standard RAM to be used for 

the PLC memory.  

At this point, check whether it is necessary to allocate the system area and, if it is, 

configure the settings.  

However, because this area is set only when formatting, if you are not sure, there 

is no need to configure it. 

 

 

 

1)  Click the [Online] → [PLC Memory Operation] 
→ [Format PLC Memory] menu. 

 

 

2)  The Format the PLC memory dialog box is 
displayed. Set the target memory to 
"Program memory". 

 

 

 

3)  Select the format. 
 
*  Set the system area if it is necessary to 

allocate the area. 
 
4)  Click the  Execute  button. 

 

 
(To the next page) 

5) The message box on the left is displayed. Click 
the  Yes  button.  
 
The program memory or device memory is 
formatted. 
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(From the previous page) 

 

 

 

6)  Set the target memory to [Standard RAM], 
and format it likewise. 

 
7)  Close the Format the PLC memory dialog 

box. 

 

 

(3)  Select "Include latches" and clear the CPU to be mounted from the PLC memory. 

 

 

 

1)  Click the [Online] → [PLC Memory Operation] 
→ [Clear PLC Memory] menu. 

 

 

2)  The Clear the PLC memory dialog box is 
displayed. Select "Include latches". 

 
3)  Click the  Execute  button. 
 

 

4)  The message box on the left is displayed. 
Click the  Yes  button.  
 
The PLC memory is cleared. 

 
5)  Close the Clear the PLC memory dialog box. 
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(4)  To the program memory/device memory of the PLC, write the files saved earlier 

(except for the device memory) such as parameters and programs by referring to 

the checklist. 

 

(1)　Click!

 

 

1)  Click the [Project] → [Open] menu. 
 
2)  Open the project saved in (4) to (7) items in 

Appendix 10.2. 
 

*  Be careful not to open a wrong project. 

(3)　Click!

 

 

3)  Click the [Online] → [Write to PLC] menu. 
 

(5) Select!

(4) Select!

(6) Click!

 

 

4)  The Write to PLC dialog box is displayed. Set 
the target memory to "Program 
memory/Device memory". 

 
5)  Click the [File selection] tab and select 

programs, parameters and so on (except for 
the device memory) by referring to the 
"Program memory" field in the checklist. 

 
6)  Click the  Execute  button to write to PLC. 

  

 

*  If there is no device comment, the message 
box on the left is displayed. Click the  OK  
button.  
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(5)  To the PLC's standard RAM, write the files saved earlier such as a file register 

(check the capacity: write range ((The number of bytes checked during PLC read 

÷ 2) - 1) by referring to the [Standard RAM] field in the checklist. 

 

(1)　Click!

 

 

1)  Click the [Online] → [Write to PLC] menu. 

 

 

2)  The Write to PLC dialog box is displayed.  
 
Set the target memory to [Standard RAM]. 

 

 

3)  Check the write range ((The number of bytes 
checked during PLC read ÷ 2) - 1) and click 
the   button for the file register.  
 
Select a file by referring to the [Standard 
RAM] field in the attached checklist. 

 
*  Be careful not to select a wrong file. 
 
4)  Click the  OK  button and then click the  

 Execute  button to write to PLC. 
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(6)  For the standard ROM, start up the project to which data was saved, refer to the 

[Standard ROM] field in the checklist and write only the stored files to PLC. 

 

(1)　Click!

 

 

1)  As in (4), open the project saved in (8) of 
Appendix 10.1.2. 

 
2)  Click the [Online] → [Write to PLC] menu. 

 

3)  The Online data operation (Write) screen is 
displayed.  
 
Set the target memory to [Standard ROM]. 

 
4)  Refer to the [Standard ROM] field in the 

attached checklist and write the stored files to 
PLC. 

 

5)  The message box on the left is displayed. 
Click the  Yes  button. 
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(7)  For the memory card, verify all the files with those in the PLC by referring to the 

[Memory card] field in the checklist. 

 

(1)　Click!

 

 

1)  As in (4), open the project saved in (9) of 
Appendix 10.2. 

 
2)  Click the [Online] → [Verify with PLC] menu. 

 

 

3)  The Online data operation (Verify) screen is 
displayed.  
 
Set the target memory to [Memory card 
(SRAM), (Flash) or (ATA)]. 

 

 

4)  Refer to the [Memory card] field in the 
checklist and select the same data in the 
verify source and destination. 

 
*  If a file register exists, check that the entire 

range is selected. 
 
5)  Click the  Execute  button to verify the data 

in the PLC. 

 

6)  Confirm that there is no mismatch. 
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(8)  If needed, set the clock. 

 

(1)　Click!

 
 

1)  Click the [Online] → [Set Clock] menu. 

 

2)  The Clock setting dialog box is displayed.  
 
Set the year/month/day, time, and day of the 
week. 

 
3)  Click the  Set  button. 

 

(9)  Reset the CPU.  

Push down the switch to the reset position, and then return it to the original central 

position.  

* An error may be displayed for the CPU, but please continue with the task. 
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(10) To program memory/device memory, write the device memory (except "S" (step 

relay)) to the CPU in the PLC after clicking the [Default] button in the [Device data] 

tab and verify the data. <<* Unset "S" in the device setting.>> 

(A verification error may occur for the SM, SD or refresh device .) 

 

(1)　Click!

 

 

1)  As in (4), open the project saved in (6) of 
Appendix 10.2. 

 
2)  Click the [Online] → [Write to PLC] menu. 

(4) Select!

(5) Click!

(3) Set!

 

 

3)  The Write to PLC dialog box is displayed.  
 
Set the target memory to [Program 
memory/Device memory]. 

 
4)  Use the file selection to select the read 

device data and initial device value. 
 
*  Be careful not to select wrong device data. 
 
5)  Click the  button. 

 

 

6)  Check that the step relay (S) is deselected 
( ). 

 
7)  Click the  Default  button. 

 

 
(To the next page) 

8)  The message box on the left is displayed. 
Click the  Yes  button. 
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(From the previous page) 

 

 

 

 

9)  Click the  OK  button to write to PLC. 

(10) Click!

 

 

10)  As in (7), click the [Online] → [Verify with 
PLC] menu. 

 

 

 

11)  The Verify PLC dialog box is displayed.  
 
Set the target memory to [Program 
memory/Device memory]. 

 
12)  Refer to the [2) Device data] field in the 

attached checklist and select the same data 
in the verify source and destination. 

 
*  Be careful not to select a wrong device data. 
 
13)  Click the  Execute  button to verify the data 

in the PLC. 
 

 

14)  Confirm that the device matches. 
 
*  The SM, SD or refresh device may be 

mismatched. 
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(11) If SFC is used for the program, please check and reset the CPU again. 

 

A different icon appears.

 

1)  Check if SFC is used. 
 
2)  If SFC is used, check and reset the CPU 

again. 
 
*  If an error is displayed for the CPU, reset it. 
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Appendix 10.5 Operation Check 

(1)  Check that there is no error for the CPU. Also, check that there is no error for the 

module mounted on the system monitor. 

 

(1)　Click!

 

 

1)  Click the [Diagnostics] → [PLC Diagnostics] 
menu. 

 

 

2)  The PLC diagnostics dialog box is displayed. 
Check for an error. (The screen on the left is 
displayed when there is no error.) 

 
 

 

3)  If there is any error, click the  
 Error JUMP  and  Error Help  buttons to 
check the error. 
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(2)  Check the error history and, if no current error exists, clear the error history. 

 

(1)　Click!

 

 

1)  Click the [Diagnostics] → [PLC Diagnostics] 
menu. 

 

 

2)  The PLC diagnostics dialog box is displayed. 
Click the  Clear History  button. 

 
 

 

 

3)  The message box on the left is displayed. 
Click the  Yes  button. 

 

4)  Confirm that the error history has been 
deleted and then close the dialog box. 

 

(3)  Set the RUN/STOP switch of the mounted CPU to RUN. 

 

(4)  If the corresponding CPU is connected to the GOT, turn ON → OFF the power 

supply to the GOT. 
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(5)  Check that there is no error for the CPU. If any faults are found in the replacement, 

return the removed CPU to the original place. 

 

(a)  As in 1) to 3) in (2) of Appendix 10.2, check that there is no error. 

 

(b) If any faults are found in the replacement (including errors), return the 

removed CPU to the original place. 
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